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CHAPTER 1 Introduction

Product overview

Welcome to NetSimplicity’s Meeting Room Manager (MRM), the easiest-to-use, most
customizable room and resource scheduling application in the market. MRM can be easily
tailored to your organization’s specific operational approach to meeting room
management. It allows users connected to your network to quickly view and change
information about existing meetings and easily reserve new meetings.

MRM allows users to create and manage meeting reservations using a DHTML-enabled
web browser such as Microsoft Internet Explorer (versions 6.0 or 7.0) or Mozilla Firefox
(versions 1.5, 2.0 or 3.0).

Once installed on a server meeting the system requirements, internal and external users
can manage reservations using a web browser or , for the Enterprise verion only, Microsoft
Outlook. 

Documentation overview

This Administrators Guide has been created for MRM users who administrate their
organization’s MRM database. Additional documentation available for this version of
Meeting Room Manager is as follows:

• MRM 7 Installation Guide

• MRM 7 Administrators Guide

• MRM 7 User Guide
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• MRM 7 Release Notes

• MRM 7 Fixed Issues List

• NetSimplicity Knowledge Base

Each of these documents is available on the NetSimplicity Support Site. Log in at: 

http://www.netsimplicity.com/support

MRM editions overview

There are two versions of MRM 7 available; Enterprise and Pro. The major differences
between the two are described in the table below.

Understanding users tasks

To help you understand how MRM was designed to work, this manual has been written
with five common user types in mind. These five types are based on a sample
organization’s structure. Each section in this manual displays the name tiles of
corresponding user types. This indicates which sections of the manual apply to which
users.

Feature Pro Enterprise

MRM Outlook Scheduling NO YES

MRM Services Management Optional YES

Active Directory Synchronization NO YES

Wait List YES YES

LCD Panels Optional Optional

Polyvision Room Wizard Support Optional Optional
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Because MRM is easily customized, your organization may choose to combine some of
these roles and give them to one user or split up some of these roles between multiple
individuals. 

Here are the five user types assigned to fictional staff in an organization with its head
office in New York and an office in Seattle.

Kate, Global MRM Administrator, New York

Kate is responsible for high level management and configuration of the
database. She is responsible to set up MRM for users and change settings
in the future as necessary. These setup tasks include:

• activating purchased modules

• creating security groups

• assigning users to their respective security groups

• setting database options

• adding locations

• customizing the forms, images, and labels in the interface

• setting up the Services Management module for use

Luke, Local MRM Administrator, Seattle

Luke is responsible for local management of the database and reservations.
These local management tasks include:

• creating local resources in the database

• confirming meetings that have been requested or otherwise require a 
confirmation

• reporting usage data to local management
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Juliette, Local Service Administrator, Seattle

Juliette is responsible to manage services locally by using the Manage
Services form. The local services management tasks include:

• setting up local service items, their availability, and their pricing

• confirming and refusing order requests

This role is dependent upon the Services Management module being enabled. 

Charlie, User, Seattle

Charlie is responsible for scheduling reservations and placing service
requests as required. 

Though users are granted permissions to create reservations, Kate as global
administrator may choose to require that each booking placed by a user is
confirmed by an administrator like Luke.

Users like Charlie often do not have permission to view or change other
user’s reservations. In circumstances where it would be useful, Charlie may
be assigned as a delegate for other users’ reservations. When acting on the
organizer’s behalf, Charlie is granted the permissions of the meeting’s
organizer.

Bob, Requesting User, Seattle

Bob is responsible for requesting meetings as required through the
Meeting Request form. He cannot choose the room in which the meeting
will be held.

Because Bob is not a user who accesses the MRM interface, the only section
of this manual that applies to him is the “Request a meeting” on page 238.
Sections of this manual which apply to all user types do not apply to
requesting users.
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There are two typical cases where the
Meeting Request form would be
used. The first is referred to as a
centralized process. A few
administrators control the database
and anyone who wishes to make a
reservation must place a request and
have it confirmed and assigned to a
resource by an administrator.

The second process is called a de-
centralized process. Most staff use
the MRM user interface to schedule
self-service bookings. The Meeting
Request form is used only for guests
who require the use of resources. For
example, a consultant may need to
host a meeting or use a room as an
office for a short period. To save
administrators the time of creating
usernames for these short term
guests and to provide an extra
element of security, these guests can
only request meetings.
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System requirements

Server requirements (In House Installations Only)

On the server:

Minimum

• Pentium III or better processor 

• 300 MB of available hard-drive space

• 512 MB of RAM 

• Microsoft Windows 2003 Server

• Microsoft IIS 5.0 or 6.0

• Microsoft.NET Framework 2.0

• Microsoft Data Access Components (MDAC) 2.8 or above

• Microsoft SQL Server 2000 or 2005 (Workgroup or higher-level editions are 
recommended. MRM will operate with Desktop and Express editions.)

Recommended 

• 2 GB of RAM

• 128 MB of additional RAM for every 20 concurrent licenses

• Dual processors operating at 3 GHz (Intel Xeon)

On each workstation:

• Web browser, one of:

• Microsoft Internet Explorer 6.0 or 7.0 

• Mozilla Firefox 1.5, 2.0 or 3.0

• Recommended resolution of 1024 x 768

• Email features (optional): Microsoft Outlook 2003 or 2007 is recommended but 
other MAPI-compliant email clients can be used.
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Installation and activation

Installation and product activation instructions for MRM are available in the MRM 7
Installation Guide which can be downloaded from the NetSimplicity Support Site located
at: http://www.netsimplicity.com/support

SQL Server 2005 configuration

Perform this configuration if you are using Microsoft SQL 2005. If it is not done, MRM
emails may not be sent out.

To configure SQL Server 2005:

1. Select Start>Microsoft SQL Server 2005>Configuration Tools>SQL Server 
Surface Area Configuration.

2. Click on Surface Area Configuration For Features.

3. From the list, select OLE Automation.

4. Check Enable OLE Automation.

5. Click OK.

Setup wizard

The setup wizard is part of the installation process and determines some of the database
configuration settings. They are:

• Virtual directory name and location

• SQL Server username and password for MRM to use to access the SQL database.

• Web server authentication: MRM authentication or Microsoft Windows 
authentication

To change these settings, run the setup wizard by selecting Start>All

Programs>Meeting Room Manager 7>Setup Wizard. 
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For details on the steps through the setup wizard, refer to the MRM 7 Installation Guide
which can be downloaded from the NetSimplicity Support Site at: http://
www.netsimplicity.com/support

Running MRM in a web browser

1. Launch your web browser.

2. In the address line of your browser, type the name of your web server followed by the 
virtual directory name. 

For example: http://webserver1/MRM7/

3. Depending upon your user settings, you may be asked for a username and password 
in order to log into the MRM database. For details, see “Logging in” on page 74.

If you are the administrator logging into your database for the first time, use the 
username Admin with no password. Ensure that you set up the security settings 
before making your database live to users as shown in“Security” on page 49.

The first time MRM is run with a new database, you are prompted to add a 
resource each time the grid loads until at least one resource has been added. 
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4. MRM appears showing the reservation grid on the right-hand side.

The convention for instructions in this manual is:

• Select Admin>Security Groups 

1. Where you first click on the Admin icon on the top row of the MRM screen. The 
Adminstration screen appears. 

2. Then click on the Security Groups icon on the Adminstration screen to make the 
Security Groups screen appear.
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Preparing the database for users

To prepare your database for your users, take the following steps according to the details
in the corresponding chapters of this manual:

1. Configure MRM’s database options

See  “Configuring MRM’s Options” on page 15  for details.

The SMTP server must be configured before users are granted access to 
your database. See “Configuring the SMTP email server” on page 32 for details.

2. Set Security Definitions

See  “Security” on page 49 for details.

3. Customize the Database (optional)

See  “Customizations” on page 85 for details.

4. Create Locations and Resources

See “Locations” on page 107 and  “Implementing Resources and 
Requirements” on page 119 for details.

5. Create Services Item(s) (optional)

See  “Services Management Module” on page 135 for details.

User licenses

MRM controls the number of users that can be logged into your database based on the
number of concurrent licenses that have been purchased.

A concurrent user license is in use once a user logs in. When a user clicks the Log Out
button or the IIS server times out the user’s session, the concurrent license is released for
use by another user. To change the IIS server’s session time out settings, see “Shortening
the session timeout” on page 12.

Users see the “No Concurrent User Licenses Available” message when all licenses are in
use. This can be avoided if everyone uses their own username to log in and everyone logs
out when finished using MRM
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If your users are seeing this message frequently, you may choose to purchase additional
licenses. For pricing information or to place an order, please contact the sales center at
1.866.248.0480. 

For an example of license usage, an organization with 200 staff members, each with their
own username, may have purchased 20 concurrent user licenses. In this case, only 20
usernames can be logged into the database at the same time.

To check the frequency at which users are being locked out, use the Locked Out Users
Report. See “Locked out users report” on page 11.

Releasing concurrent licenses

A concurrent user license is in use once a user logs in. On clicking the Log Out button or
the IIS server timing out the user’s session, the concurrent user license is released for
other users.

If a user does not click Log Out, MRM waits for the IIS session to time out. MRM
administrators with the Change Permissions permission enabled can disconnect users in
order to release the license without waiting for the IIS session to time out.

To release a concurrent license:

1. Logged in as a user with administrative permissions, select Admin>Users. 

The list of users opens.

2. Click Active Users located at the bottom of the list.

The Active Users screen appears. It displays a list of currently active users and the 
number of concurrent licenses enabled.

3. To the right of the username you wish to disconnect, click Disconnect and click OK.

Locked out users report

MRM lets global administrators like Kate view a report on how many users are being
locked out because all concurrent licenses are in use. It displays the username, time, and
date of each lockout. It can be filtered to show the lockouts for one user is particular, one
date in particular, or a combination of the two.
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To see the locked out users report:

1. Select Admin>Users to open the list of users.

2. Click Locked Out Users located at the bottom of the list.

The report’s dialog box opens. 

3. To filter the report, select the following:

• Username: Select a username in order to view the number of times this user has 
been locked out of MRM. To see all users, select All Users from the menu.

• Date: Enter a date or click on the calendar to select a date to view which users were 
locked out of MRM. To view all dates, leave this field blank.

4. Click Update Selected.

The report details are displayed in the lower portion of the screen.

5. Click OK. 

Shortening the session timeout

The default timeout setting for MRM login is 20 minutes. To shorten it, go into MRM’s
web.config file in the MRM installation folder and edit it. By default, this folder is located
at “C:/Program Files/Meeting Room Manager 7.”

To reduce the session’s time out setting:

1. Open the web.config text file in a text editor like Notepad.

2. In the file, look for the statement:

<forms loginUrl="default.aspx" name=".ASPXMRM" protection="All"/>

3. At the end of this statement, add: timeout="X". 

Where X is the timeout in minutes and is any number between 0 and 19.

For example to set the timeout to 10 minutes, this line would be:

<forms loginUrl="default.aspx" name=".ASPXMRM" protection="All"  timeout="10" /> 
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Lengthening the timeout is a more complex procedure. Go to NetSimplicity’s support
portal or support site and in the MRM Knowledge Base Articles, look up article: INFO
10082 Adjusting the MRM timeout.
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CHAPTER 2 Configuring MRM’s Options

Customizing MRM’s settings

MRM has many customizable settings that allows you to configure it to match how your
organization operates. You can:

• Set your organization’s default operating hours and the spacing between items in 
the reservation grid as shown in “Setting the default business hours” on page 17. 

• Control the font color and what color different types of reservations appear as on 
the reservation grid as shown in “Color-coding reservations” on page 18.

• Edit MRM emails as shown in “Email messages customizations” on page 21.

• Set what types of reservations need to be confirmed as shown in “Confirming 
reservations” on page 25.

• Set how far ahead of time users can book reservations as shown in “Set recurring 
reservation length” on page 26.

• Edit what information is displayed on the reservation grid as shown in “” on page 28.

• Set security options as shown in “Setting the timeout, priority rights and other 
settings” on page 30.

• Set up the email server as shown in “Configuring the SMTP email server” on 
page 32.

• Activate, edit and delete the save rules as shown in“Save rules” on page 35 .
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• Export MRM data so it can be displayed on an LCD panel as shown in “Automating 
the text data extraction script” on page 42,“Automating the XML data extraction 
script” on page 43 and   “Text and XML data export formatting” on page 45.

The master adminstrator should perform these configurations before releasing MRM
to the users since they affect all users.

Accessing MRM’s options

The Project Options page controls MRM’s setup options. They are usually set by the global
administrator as they affect all MRM users.

Access them by selecting Admin>Options. The Project Options screen appears, opened
to the Schedule tab.

The following sections describe the functions controlled by each of these tabs.
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Setting the default business hours

The Schedule tab controls your organization’s default operating hours, the time interval
between each item on the reservation grid and allows preparation and clean-up time to
be set as part of a reservation.

Business Hours

This setting controls the global default operating hours setting for your organization. The
operating hours for each location is set in the Location Detail form.

The Business Hours Start Time and End Time fields are when your organization opens
and closes. Only the reservations which are scheduled to take place within business hours
are displayed in the Day and Time Line views of the reservation grid. Reservations can still
be scheduled outside of business hours, but they are not visible on the grid in the Day
and Time Line views.

Default Interval

The default time interval is the number of minutes between each interval in the
reservation grid, such as five, fifteen, or thirty minutes.

Setup/Cleanup Time

Time may be scheduled outside of the reservation to allow for preparation of the meeting
room and cleanup after the meeting is finished. This time is added beyond the meeting’s
scheduled start and end times and has a default value of zero minutes.

Enter values for the default setup and cleanup times. To hide this option completely in
the Reservation form, enter -1 as the default time.
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Color-coding reservations 

The Colors tab lets you color-code different types of reservations for ease of identification
as well as setting the font color seen on the reservation grid.

Creating Reservation Types

Before assigning colors to each reservation type, define the different types of reservations
used by your organization.
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To define reservation types: 

1. Click the Reserve icon.

The Reservation Details screen appears.

2. Click the General tab

3. Click the down arrow next to the reservation type field. 

The list of defined reservation types opens.

4. Click Add. 

The Value List Entry window opens.

5. Enter the new reservation type name and description and click OK.

6. Repeat steps 3 to 5 until all required reservation types have been added.

Cell Color

The colors used to display different types of reservations on the grid are selected with this
procedure.

1. Select Admin>Options>Colors.

2. Click Add. 

A blank entry appears in the Cell Color panel.

3. Click the pull-down icon next to the new entry.

The list of defined reservation types opens. Select the appropriate reservation type.

4. To assign colors to the new entry, click the white space beneath the Confirmed or Not 
Conf. columns.
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5. The Color Picker window appears. Select the desired color. 

To assign a color that is not included in the Color Picker, enter the html code for 
the desired color in the text field below the color palette and click OK. For example, 
248752 is a shade of green, while 808080 is a shade of gray.

A different shade of the same color is recommended for confirmed and 
unconfirmed meetings of the same type.

To delete color assignments, check the box next to the assignment you wish to
delete, and click Delete.

Font Colors

To add a new font color:

1. Click Add.

2. Enter the new color’s name.

3. To the left of the new color, click on the white space.

The Color Picker window opens.

4. Select the required color.

Color assignments can be deleted by checking the box next to the assignment you
wish to delete, and clicking Delete.
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Email messages customizations

The Email Messages tab lets you edit the different types of MRM emails.

Reservation related email messages

Fifteen email notifications can be sent through MRM. Ten of these pertain to reservations
while five pertain to service orders.

MRM prompts users to send email notifications at the appropriate time. Then if the user
agrees to send the message, MRM generates the appropriate email based on its template.
Once the email is generated, the user can just send the email as-is or modify it first.
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The Email Messages tab contains the reservation based email templates which can be
adjusted to suit your organization. Services order email templates can also be adjusted in
the corresponding service’s administrative form. See “Service Order Email Messages” on
page 158 for more details.

Each email template contains the intended recipient, the subject, the body, and the
message prompt that the end user sees.

The following is the list of reservation related email messages:

• Notification Email: When a user saves a meeting with requirements, the user is 
prompted to send this email. It is intended be sent to the head of the department to 
which the selected requirements belong.

• Meeting Change Email: When a user saves changes to a meeting with attendees or 
requirements, the user editing the meeting is prompted to send this email to all 
attendees and department heads that were initially notified of the meeting.

• Cancellation Email: When a user cancels a meeting with attendees or 
requirements, the user cancelling the meeting is prompted to send this email to all 
attendees and department heads that were initially notified of the meeting. 

• Confirmation Email: This email is sent by the user responsible for confirming 
meetings. It is sent from the Meeting Confirmation form.

• Outlook Invitation: This invitation can be sent by users who wish to send an 
Outlook Invitation to attendees who use Outlook as their mail client. This invitation 
can be sent by clicking the Invitation icon in the Attendees tab of the Reservation 
form.

• Email Invitation: This email can be sent by users as an alternative to the Outlook 
Invitation. This email can be sent by clicking the Email icon in the Attendees tab of 
the Reservation form.

• Override Admin Notification: When a user with priority rights saves a reservation 
that overrides an existing reservation, he is prompted to send this notification to the 
local administrator, like Luke.

• Override End User Notification: When a user with priority rights saves a 
reservation that overrides an existing reservation, he is prompted to send this 
notification to the user who created the reservation he just overrode.
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• Wait List Assigned Notification: When a desired space becomes available, and a 
wait list entry is automatically pushed into the space, Meeting Room Manager 
automatically sends this notification to the user who created the wait list entry. 

• Wait List Status Email: When an administrator is viewing the wait list, he has the 
option to send an email to any wait list entry’s creator to let her know the current 
status of her wait list entry. This email can only be sent manually by clicking the 
email icon next to an entry on the wait list.

Modifying email message templates

The Options Email Messages tab contains the templates for each of the reservation
related notifications. The following descriptions are for the fields used on the Email
Messages Tab to edit these templates.

• Email Pull-Down Menu: This allows you to select which email notification or 
invitation that you are editing such as Confirmation Email or Outlook Invitation.

• The Field Reference Field: This allows you to insert data that is specific to each 
meeting. For example, selecting <General/Meeting Title> displays the meeting title 
for whichever meeting the email is about. These references can be used in any of 
the customizable fields within the Email Messages tab by clicking Insert.

• The To Field: This allows you to select whom the notification is sent to. You can 
select from All Departments, Departments of Selected Items, or Never Send an 
Email. The All Departments and Departments of Selected Items options pull the 
email addresses that were assigned to each tab using the from designer. 

In addition to or as an alternative to the All Departments and Departments of 
Selected Items options, specific email addresses can also be entered. The Never 
Send an Email option only sets the default to not send this particular notification.

• The CC Field: This allows you to type in an email address that all notifications of this 
kind are to be sent to. For example, if one person is in charge of confirming 
reservations, his or her email address can be entered in this area.

• The Subject Field: This displays the notification’s subject. It is recommended to use 
the <General/Meeting Title> reference field in the subject.
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• The Body Field: The Body field represents the body of the message that is sent out. 
It should be generic for all types of meetings. Anything specific to a particular 
meeting should be represented by a field reference. Keep in mind that all 
notifications can be customized at the time they are sent.

• The Message Field: This field represents the prompt that is displayed to the user 
reserving the meeting. It is meant to ask the user if they wish to send notification. 
This field is only available for the Notification Email, the Cancellation Email, and the 
Meeting Change Email. It can be changed if you wish to customize this prompt 
according to your organization’s specific needs.
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Confirming reservations

The Confirmation tab lets you set what types of meetings need to be confirmed by a local
administrator.

For more information see “Confirmations” on page 243.

Confirm

• Confirm Meetings with Requirements: Only meetings with requirements selected 
require confirmation and display in the Confirmation form until confirmed. This is 
the default setting.

• No Confirmations: No meetings require confirmation. In this case, you will  not be 
able to address meeting requests.
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• Confirm All Meetings: Every meeting that is saved requires confirmation and 
displays in the Confirmation form until confirmed.

• Confirm Paste: The Confirm Paste feature can be turned on or off. When on, users 
who paste a copied meeting onto the grid are asked to confirm the placement.

Set recurring reservation length

The Schedule Limit tab sets limits on the length of recurring reservations and how far into
the future your users can book a reservation.

• Maximum Recurrence Length: This field sets the maximum number of months in 
the future that occurrences can be booked from the date of the first occurrence in 
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the series. The default setting is unlimited. You can select a number from the value 
list or enter your own number into the field.

• Future Booking Window: This field sets the maximum number of months in 
advance that reservations can be made. The default setting is unlimited. Either enter 
the number of months in advance that any user can book up to, such as 6 months, 
or select a date from the calendar which any user can book up to, such as December 
31st, 2009.
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Setting the reservation grid information

The Grid View tab lets you choose and edit what information is displayed on the
reservation grid.

• View: This drop-down list selects what view is edited. For descriptions of the day, 
week, month, time line views, see “Reservation Grid” on page 163. 

Outlook view is for organizations using the Enterprise version of MRM along with 
the MRM plug-in for Microsoft Outlook. See “The MRM Plug-In for Microsoft 
Outlook” on page 197 for more information.

• Visible: Checking this box makes the view visible to users.
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• Refresh Rate: This field controls how oftern the grid is refreshed. The default is 300 
seconds, or five minutes.

• Field Reference: This drop-down list lets you choose what information is 
automatically displayed in the meeting’s listing. For example, choosing <Meeting 
Room> shows the room booked for the meeting. 

Multiple listings can be displayed in a grid and your choices are shown in the 
content field. This is most useful with the week and month views, but it can be used 
for the day view.

• Content: This field shows the information that will be displayed in the grid for each 
reservation. To add additonal information, select a listing from the Field Reference 
drop-down list and click Insert.

• Cell Width: This field determines the default width for each column in this view.

• Cell Height: This field determines the default height for each block of time in this 
view.
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Setting the timeout, priority rights and other settings

The Others tab lets you set the timeout, priority rights, the use of Active Directory and
delegates and turns on the wait list.

• Timeout Link: This field allows you to specify the page that users are redirected to 
when their MRM session is inactive long enough to time out. The default page 
contains a link which allows the user to log back into MRM.

The default inactive time out is 20 minutes and depends upon your web.config file 
setting. For details on how to adjust the session time out time, see “Shortening the 
session timeout” on page 12. 

• Enable Delegate Access: This field allows you to enable the delegate feature.
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When this checkbox is enabled, reservations can be delegated to a user who may 
act on the behalf of the reservation’s organizer. When acting as a delegate, this user 
is granted the permissions of the meeting’s organizer.

Users can be assigned as delegates to individual reservations as required. If many 
reservations are involved, you may assign a user as a delegate to other users. This 
automatically makes the user a delegate for the organizer’s reservations during the 
designated time period. Because delegate settings in the Reservation form 
supercede all other settings, it is possible to remove the delegate from a specific 
reservation as required.

To add a delegate to your username, see “Editing your user profile” on page 74. 

To add a delegate to a specific reservation, see “Delegating a Reservation” on 
page 185.

Administrators like Kate may add a delegate to a username. See  “Usernames” on 
page 67.

• Enable Priority Rights:  This field allows you to enable the priority rights feature 
set. For information on how to implement this, see “Implementing priority rights” 
on page 77.

When this checkbox is enabled, the waiting list checkbox is automatically enabled.

• Enable Waiting List: This field allows you to enable the wait list feature set. It is 
automatically enabled if the priority rights checkbox is enabled. See “Wait List” on 
page 247 for more details.

• Enable Active Directory: If you are using MRM Enterprise Edition, this field allows 
you to enable the integration of Windows authentication security in MRM with your 
existing Microsoft Active Directory Services security. See  “Implementing Active 
Directory” on page 49 for details.

• Allow Unmapped Users to Access MRM: When you check the Enable Active 
Directory field, the Allow Unmapped Users to Access MRM field is automatically 
enabled.

This field allows users who belong to an unmapped Active Directory security group 
to log in to Meeting Room Manager as a member of the Default group. This saves 
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the MRM administrator, like Kate, the time of mapping every group by allowing her 
to only map those which require more advanced security settings.

When you uncheck this field, users who belong to an unmapped Active Directory 
security group are denied access to Meeting Room Manager.

This field is grayed out and cannot be checked if the Enable Active Directory field is 
unchecked.

• Allow to Load All Locations:  When disabled, this field prevents the All Locations 
display filter from loading in the reservation grid. Instead of loading all locations’ 
reservations at once, users can choose to load a specific location’s reservations in 
the reservation grid. This allows the grid to load faster.

It is recommended that you disable this field if you have a large database with many 
locations, resources, or reservations. It is also recommended that you disable the 
Allow to Load Parent Locations field on this tab to further improve the loading 
speed of the reservation grid.

This field is enabled by default.

• Allow to Load Parent Locations: When disabled, this field prevents users from 
viewing all of the reservations which belong to a parent location at once in the 
reservation grid. Users can instead display the reservations at one lowest level 
location, or sublocation, at once therefore allowing the grid to load faster.

It is recommended that you disable this field if you have a large database with many 
locations, resources, or reservations. It is also recommended that you disable the 
Allow to Load All Locations field on this tab to further improve the loading speed of 
the reservation grid.

This field is enabled by default.

Configuring the SMTP email server

MRM can automatically send out emails to notify users and administrators. To do this, the
SMTP service must be correctly configured and running on the web server or your mail
server.
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To configure the SMTP service, open your reservation database with Microsoft SQL Server
Enterprise Manager. Then open the Options table and add the following records if they
are not already present:

• In the Setting field, enter ReplyAddress and in the Value field, enter the actual email 
address of the MRM administrator (e.g. ‘mrmadmin@company.com’).

• In the Setting field, enter SMTPServer, and in the Value field, enter localhost. 

If you plan to use a different mail server than the web server, enter the DNS name or 
IP address of the mail server in the Value field instead of localhost. 

DNS names typically look similar to this example: smtp.mail.net

After the eamail server is configured, emails automatically sent by MRM will be sent to the
appropriate users and attendees. 

Examples of emails automatically sent by MRM are the wait list resolution email which
notifies the owner of a wait list entry when the entry has been scheduled as a reservation,
and the override notification email which notifies the administrator and meeting owner
when a reservation has been overridden by a user with priority rights.

If the SMTP service is not correctly configured, automatically sent emails appear to
be sent by Meeting Room Manager but remain on the email queue of the SMTP server.

In order for emails to be sent correctly, attendee and user email addresses must be
SMTP addresses, not X.400 addresses.

Sending emails from the web server

MRM provides global administrators with the option to send the notification, invitation or
confirmation emails directly from the web server instead of the default method of using
the email client application installed on the user's workstation.

To send emails, set the following options in the MRM  database:

• The CDONTS object must be installed on the web server during IIS installation.
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• The SMTP service must be correctly configured and running on the web server. If 
you do not want to use the web server as a mail server, you can point to your mail 
server instead. In this case there is no need for CDONTS or SMTP.

To enable the corresponding options within the MRM database:

1. Open your reservation database with Microsoft SQL Server Enterprise Manager. 

2. In the Options table add one of the following records if they are not already present:

• In the Setting field, enter SetEmail

• In the Value field, enter EmailFromServer.

• In the Setting field, enter ReplyAddress 

• In the Value field, enter the actual email address of the MRM administrator (e.g. 
‘mrmadmin@company.com’).

• In the Setting field, enter SMTPServer 

• In the Value field, enter localhost.

• If you plan to use a different mail server than the web server, enter the DNS name or 
IP address of the mail server in the Value field instead of localhost. 

• DNS names typically look similar to this example: smtp.mail.net

With any of these options set, all emails originate from the web server and appear to
come from the set reply address regardless of the user who actually entered or edited the
reservation.

When MRM prompts a user to send a notification email, the user has the option to
select Yes to have the email sent from the server or No to abort the sending of the email.

If the SMTP service is not correctly configured, emails appear to be sent by Meeting
Room Manager but remain on the email queue of the SMTP server.

In order for emails to be sent correctly, attendee and user email addresses must be
SMTP addresses, not X.400 addresses.
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Outlook API and MRM emails

If all of your MRM users use Outlook as their email client, you can use Outlook’s API
setting.

To change your Meeting Room Manager database’s setting from Non-Outlook API

to Outlook API:

1. In your reservation database, open the Options table and navigate to the SETEMAIL 
setting.

2. Change the value for the SETEMAIL setting to OutlookAPI.

The default value for the SETEMAIL setting is NONOutlookAPI.

Viewing the audit log

MRM keeps an audit log to maintain an record of what reservations have been added,
modified, or deleted, and by which user.

To view these records, open the reservation database’s Audit Log table. This table
displays the action taken, date of the action, user name, record ID, record type, record
title, meeting start, meeting end, and room ID. 

Save rules

Save rules are conditions which check a reservation’s data before it is saved. In many
cases, a save rule’s purpose is to prevent a reservation from saving if it doesn’t meet the
rule’s requirements.

There are three types of save rules:

• Mandatory: This type of save rule prevents a reservation from saving if it doesn’t 
meet the rule’s requirements. It displays a message to the user who is attempting to 
save the reservation, explaining what needs to be changed before the reservation 
can be saved. When the user clicks OK in the message prompt, he is returned to the 
Reservation form to adjust the details before re-attempting to save.
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An example of a mandatory save rule is one that requires at least thirty minutes of 
preparation time when a projector is booked.

• Prompt: This type of save rule presents a message to the user saving the 
reservation. This message provides two options to the user: Cancel and OK. Clicking 
Cancel returns the user to the Reservation form so he can adjust the reservation as 
suggested in the message. Clicking OK saves the reservation despite the message.

An example of a prompt save rule is one that notifies the user that the reservation 
uses less than 50% of the room’s capacity for attendees.

• Warning: This type of save rule simply gives the user a message before saving the 
reservation. It is used as an information notice only.

An example of a warning save rule is one that reminds the user saving the 
reservation that since she ordered a projector but no laptop, she should bring her 
own laptop to connect to the projector for the meeting.

The following save rules are provided with MRM but are inactive by default:

• Meeting Occurs in the Past: This save rule is a prompt which notifies a user if he 
has attempted to schedule a reservation in the past. He may choose to proceed or 
to go back and adjust the time and/or date of his reservation.

• Match Tab Fields: This save rule is a mandatory type rule which checks for a match 
between a resource item and a reservation item on matching tabs. This rule does 
not apply to information held in services management tabs. Details for setting up 
your database to make use of this save rule are described in  “Preparing 
requirements’ availability” on page 119.

• Inventory Check: This save rule is a mandatory type rule which checks that selected 
requirements are available to be reserved, according to the inventory information in 
the database.  This rule does not apply to requirements held in services 
management tabs. Details for setting up your database to make use of this save rule 
are described in “Implementing inventory tracking” on page 121.

• Invitation Check: This save rule is a prompt which asks if the user would like to 
send an email invitation to attendees. The user can click Yes to send the invitation or 
No to save the reservation without sending an email invitation to attendees.

All save rules can be made active or inactive as required.
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To create your own Save Rules, knowledge of SQL statements is required.

Opening a save rules form

1. Click the Admin icon.

2. Click the Save Rules icon.

3. The Save Rules form opens, displaying the list of existing rules.

Adding a save rule

1. Click Add on the Save Rules form. 

2. In the Rule Details form, enter a name for the save rule in the Rule Name field.

Example 1: Projector Requires 30 Minutes Prep

Example 2: Fifty Percent Room Capacity

Example 3: Laptop for Digital Projector

3. Fill in the Rule Description field. 

Example 1: Requires at least 30 minutes of prep time when a digital projector is 
booked.

Example 2: Notifies when less than 50% of a room’s capacity is used.

Example 3: Reminds user to bring a laptop for the digital projector

4. Enter your SQL statement into the Rule Query field. 

Example 1: IF=DateDiff(“n”, “<ACTUAL START DATE> <ACTUAL START TIME>”, 
“<MEETING START DATE> <MEETING START TIME>”) < 30  AND “<Equipment/Digital 
Projector>” =True

Example 2: SQL="SELECT Room_ID FROM Rooms WHERE Room_ID IN (<ROOM ID>) 
AND (<General/#Attending>/[General/Capacity]) < 0.5"

Example 3: IF= “<Equipment/Digital Projector>” =True AND “<Equipment/
Laptop>”=False
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5. Enter the message in the Rule Message field. This is the message that the user is 
presented with.

Example 1: “You have booked a digital projector for your reservation. Please add at 
least thirty minutes of preparation time to your reservation.”

Example 2: “You are only using 50% of this room’s capacity. Click OK to proceed or 
Cancel to return to your reservation and select a smaller room.”

Example 3: “You have booked a digital projector, but no laptop for your reservation. 
Please remember to bring your own laptop to the meeting in order to use the digital 
projector.”

When your save rule is triggered, if the reservation meets the rule’s criteria, the 
message will be displayed. If the reservation does not meet the rule’s criteria, the 
message will not be displayed.

6. Select either mandatory, prompt, or warning to set the rule’s classification.

For a description of each type, refer to the beginning of this section.

Example 1: Mandatory

Example 2: Prompt

Example 3: Warning

7. In the Rule Applies To field, select one of the choices in the pull-down menu:

• All: Select this option if the rule applies to both the web client and the MRM plug-in 
for Microsoft Outlook. This option is selected by default.

• Web Only: Select this option if

• no one in your organization uses the MRM plug-in for Microsoft Outlook, or if

• the rule only applies to users of the web client, or if

• the rule refers to fields which are not available in the MRM Reservation form in 
Outlook.
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• Outlook Only: Select this option if the rule only applies to users of the MRM plug-in 
for Microsoft Outlook.

If you chose Outlook Only or All,  ensure that all fields referenced in the save rule 
are available in the MRM Reservation form in Outlook or errors will occur. It is 
recommended that you attempt to invoke the save rule from Outlook to ensure that it 
is compatible.

8. Click OK.

Editing a save rule

1. In the Save Rules form, select an existing rule by clicking on its title.

2. The rule’s Rule Details form opens.

3. Make changes as needed.

Some fields in the default save rules cannot be changed.

4. Click OK to save changes and close the form.

Enabling or disabling a save rule

1. In the Save Rules form, look under the Active column to view a save rule’s current 
status. 

2. Click on the rule whose status you wish to change. This opens the rule’s detail form.

3. Enable the rule by checking the Active checkbox or disable it by removing the check 
mark.

4. Click OK to save your changes.
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Deleting a save rule

1. In the Save Rules form, click the checkbox to the left of each save rule you wish to 
delete.

Default save rules cannot be deleted. If you do not wish to use them, you can 
disable them as described in the Enabling or disabling a save rule section.

2. Click Delete.

3. Click Yes to confirm deletion.

4. The list displays the remaining save rules.

MRM Window service admin

The MRM Window Service Admin automates email reminders and Active Directory
Services security integration. 

Setup and configuration

The MRM Window Service Admin setup takes place during the installation of Meeting
Room Manager. The Setup Wizard asks for database connection details and the username
and password of the Windows user who has permissions to this service.

For more information regarding the Setup Wizard, refer to the MRM 7 Installation Guide,
available by download from the NetSimplicity Support Site at: http://
www.netsimplicity.com/support

Setup log on information

If you wish to use Active Directory Services integration, you need to setup log on
information for the MRM Window Service Admin. To setup the log on information:

1. Select Start>Control Panel>Administrative Tools>Services.

2. Right-click MRM and select Properties.

3. Select the Log On tab.
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4. Select This Account and enter a domain username and password which has 
administrative permissions on your network. 

Use the following username format: domain\username

Example: Acme\Kate

5. Click OK.

See “Implementing Active Directory” on page 49 for more information about setting up
Active Directory Services integration for use.

Setting up the database connection

To alter your database connection details after the initial setup:

1. Open the service by selecting Start>All Programs>Meeting Room Manager 

7>MRM Window Service Admin>Database Connection tab.

2. Make your database connection changes.

3. Click Test Connection to test your changes.

4. Once you are satisfied with your changes, click the Save button to save them.

Stopping or starting the service

To stop or start this service:

1. Open the service by selecting Start>All Programs>Meeting Room Manager 

7>MRM Window Service Admin>Database Connection tab.

2. Click Stop or Start.

3. The status indicator displays the service’s current status as either Running or Stopped.

It is recommended that if you wish to not use any of the auto-email reminders that
you disable each of the triggers rather than stop this service. See “Automated Email
Reminders” on page 101 for details.

It is recommended that if you do not wish to use Active Directory Services security
integration that you turn the feature off in the database options rather than stop this
service. See “Setting the timeout, priority rights and other settings” on page 30 for details.
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Automating the text data extraction script

MRM can integrate with external systems which reference a regularly updated text file to
display meeting room usage and other event information on display panels. 

The text file provided by MRM contains daily event data for the current 24 hours, from 12
am this morning to 12 am tonight. The file presents data in a standardized format and can
be set to update at the frequency your organization prefers.

In order to make use of this integration, you must first activate the trigger that extracts
the necessary data into the standardized text file.

To activate the data extraction trigger:

1. Select Start>All Programs>Meeting Room Manager 7>MRM Window Service 

Admin.

2. On the Database Connection tab, enter the database connection information 
ensuring that you use a username which has administrative permissions to the SQL 
server, particularly the ‘enable xp_cmdshell’ permission.

3. Select the Triggers tab and double-click the trigger called Data_Extraction_Script.

4. In the Trigger Detail form, click inside the Trigger Statement box.

5. Provide the path and name for the text file using the following format:

spExportTextFile @TextFilePathAndFileName ='c:\Temp\CustomizedText.txt'

Replace ‘c:\Temp\CustomizedText.txt’ with the filename and path that you wish to 
save the text file to each time it is generated. Ensure that you keep the single quotes.

6. In the Schedule field, select the frequency that you wish the trigger to run at. This is 
the frequency that the text file will be refreshed.

The typical rate is once every 10 minutes, but you may wish to make it more or 
less frequent depending upon your organization’s requirements.

7. In the Status field, select Active to make the trigger active.

8. Click Save Trigger to save your changes and activate the trigger. It will now run at the 
interval you have specified and be saved to the file and path you specified.
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The stored procedure which is referenced by the trigger, spExportTextFile, can be
opened in SQL Enterprise Manager and used as a data extraction template, allowing MRM
to integrate with external systems according to their requirements. 

Modifications of this nature should only be performed by qualified individuals and
cannot be supported by NetSimplicity.

Automating the XML data extraction script

MRM can integrate with external systems which reference a regularly updated XML file to
display meeting room usage and other event information on display panels. 

The text file provided by MRM contains daily event data for the current 24 hours, from 12
am this morning to 12 am tonight. The file presents data in a standardized format and can
be set to update at the frequency your organization prefers.

In order to make use of this integration, you must first activate the trigger that extracts
the necessary data into the standardized text file.

To activate the data extraction trigger:

1. Select Start>All Programs>Meeting Room Manager7>MRM Window Service 

Admin.

2. On the Database Connection tab, enter the database connection information 
ensuring that you use a username which has administrative permissions to the SQL 
server, particularly the ‘enable xp_cmdshell’ permission.

3. Select the Triggers tab and click Add a New Trigger.

4. In the Trigger Detail form, enter ExportXMLData as the name for the new trigger.

5. Click inside the Trigger Statement box and provide the path and name for the text file 
using the following format:

ExportXMLData @TextFilePathAndFileName ='c:\ExportXMLDataFile.XML'

Replace ‘c:\ExportXMLDataFile.XML’ with the filename and path that you wish to save 
the text file to each time it is generated. Ensure that you keep the single quotes.
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6. In the Schedule field, select the frequency that you wish the trigger to run at. This is 
the frequency that the text file will be refreshed.

The typical rate is once every 10 minutes, but you may wish to make it more or 
less frequent depending upon your organization’s requirements.

7. In the Status field, select Active to make the trigger active.

8. Click Save Trigger to save your changes and activate the trigger. It will now run at the 
interval you have specified and be saved to the file and path you specified.

The stored procedure which is referenced by the trigger, ExportXMLData, can be
opened in SQL Enterprise Manager and used as a data extraction template, allowing MRM
to integrate with external systems according to their requirements. 

Modifications of this nature should only be performed by qualified individuals and
cannot be supported by NetSimplicity.

Custom triggers

If you are familiar with SQL queries, you can create customized triggers to run on your
MRM installation.

To create or modify a custom trigger:

1. Select Start>All Programs>Meeting Room Manager7>MRM Window Service 

Admin>Triggers tab.

2. Click the Add New Trigger button to create a new trigger, or double-click the name 
of the trigger you wish to modify.

3. In the Trigger Detail form, enter or adjust the name of the trigger.

4. In the Schedule frame of the form, set the schedule for the trigger to run. Choose 
from:

• Once at <time>: This schedule forces the trigger to run every day at the specified 
time.

• Occurs every <#> minute(s): This schedule forces the trigger to run at a specified 
minute interval such as every one minute.
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5. In the Trigger Statement field, enter the SQL query for this trigger.

6. If your trigger sends an email, you can create the email template in the Email 
Information frame of the form. If it does not send an email, skip to step 9.

• Compose the subject and body of the email by clicking in the appropriate field and 
entering field references and your own customized text.

• The Insert Field pull-down menu contains the field references which can be used to 
compose the subject and body of the email. The available field references are based 
on the tables which are pulled in the trigger statement.

• To use a field reference, place your cursor where you wish the field reference to be 
added, then select the field reference from the pull-down menu, and then click 
Insert.

7. Enter each recipient’s email address into the To field. Separate each email address 
with a semicolon (;).

8. Once you have finished setting up the email information and trigger statement, send 
a test email by entering an email address you have access to in the Send Test Email 

To field, then clicking the Test Email button.

• If the test email is sent successfully, a prompt indicates this. You can visit the inbox 
of the email address you sent the test to in order to view the test email.

• If there is no data in the database which can be used to test this email reminder, the 
prompt indicates this.

9. Once you are satisfied with the trigger you have created, ensure that it is active by 
selecting Active in the Status section of the form.

10.Click Save Trigger to save your changes and activate the trigger. It will now run at the 
interval you have specified and send notification emails as you have specified.

Text and XML data export formatting

This section describes how MRM exports XML and text data so that an administrator can
use it for tasks such as displaying it on an LCD screen.
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The administrator doing this procedure must have a working knowledge of SQL
Server.

Setting up MRM to export data:

MRM can export data in either text or XML format. To set up MRM to do this, follow the
directions given in either the:

• “Automating the text data extraction script” on page 42.

• “Automating the XML data extraction script” on page 43.

In these sections, you will learn how to trigger MRM to send out the file and set how
frequently it is sent out.

MRM exports data as shown below

MRM Data Data Type Text 

Export 

Column

XML Export Tag

[General/Meeting Title] Text 1 <Eventname>

[Meeting Start] DateTime 2 <Starttime>

[Meeting End] DateTime 3 <Endtime>

[Notes] Text 4 Not supported in MRM

[RoomName] Text 5 <Roomname>

[DateCreated] DateTime 6 <Createdate>

[DateModified] DateTime 7 Not supported in MRM

[Groupevent] Text 8 <Groupevent>

[ReservationID] Number 9 Not supported in MRM
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XML export data example

Below is a sample MRM XML export:

<?xml version="1.0" encoding="ISO-8859-1"?>   

<Events>   

<Event>   

<CustomerID> 0 </CustomerID>   

<Eventname> 

<![CDATA[Ex: GJC Demo 3D X-Ray]]> 

</Eventname>   

<Starttime>04-23-2008 09:00:00</Starttime> 

<Endtime>04-23-2008 17:00:00</Endtime> 

<Roomname> 

<![CDATA[Experience]]> 

</Roomname>   

<Createddate>04-11-2008 17:42:07</Createddate> 

<Groupevent>0</Groupevent> 

</Event>   

</Events> 

Text export data example

Below is a sample MRM text export:

Challenge Theatre 08000830 05102006051020069025                                        

Publishing Lab 08000830   05102006051020069026                                                                                                                         

Instructional Centre 09000930 Staff Meeting 05102006051020069019   

Text is exported in tab-delimited format. Contact NetSimplicity’s technical support
department if you wish to change how the text data is exported.
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CHAPTER 3 Security

Security overview

MRM security uses a group-based permissions setup. The global administrator defines
security groups which each have their own unique permissions. Users are then assigned
to these security groups. Permissions can be everything from who can view another user’s
meetings to who can modify the Reservation form using the form designer. 

In MRM Enterprise Edition, setting up security in MRM can be made easier by integrating
your existing Windows Active Directory user groups and names. See "Implementing
Active Directory" on page 49 for details.

Users are required to log in using their assigned username each time they access your
reservation database unless Windows authentication is in place. See "Windows
authentication" on page 55 for details.

MRM Web supports the use of SAML (Security Assertian Markup Language)
authentication. The MRM plug-in for Microsoft Outlook does not support SAML. See
"SAML authentication" on page 56 for details.

Implementing Active Directory

Microsoft Windows Active Directory (AD) services can be integrated with MRM’s
Enterprise Edition to provide a faster way to manage security in MRM, especially for large
corporations. Implementing AD in MRM requires SQL Server 2000 or 2005. The use of AD
in MRM is optional, depending on your organization’s security practices.
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Implementing AD in MRM is a four step process:

• Step One: Enabling AD in MRM.

• Step Two: Configuring the MRM log-in information.

• Step Three: Mapping MRM security groups to AD security groups.

• Step Four: Prioritzing AD groups.

Step One: Enable AD in MRM

1. Select Admin> Options. 

The Project Options screen appears.

2. Click the Others tab.

3. In the Active Directory section, check the Enable Active Directory checkbox and click 
OK.

Step Two: Configuring MRM log on information

1. Select Start>All Programs>Meeting Room Manager7>MRM Window Service 

Admin. 

The MRM Windows Service Admin screen appears.
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2. Click the Database Connection tab.

3. In the Database Connection section, fill out the fields as needed and click Save.

Step Three: Mapping MRM security groups to AD security groups

To allow users not belonging to mapped groups to access MRM:

1. Select Admin>Options. 

The Project Options screen appears.

2. Click the Others tab.

3. Check the Allow unmapped members to access MRM checkbox in the Active 
Directory section of the Project Options form and click OK. 
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These unmapped members are now granted permissions according to the Default 
MRM security group. It acts like a guest account and has limited access rights.

To map an MRM security group to its corresponding AD security group:

Each MRM security group can be mapped to only one AD security group. If the AD user
group contains nested groups, the MRM security group is mapped to them as well. MRM
security groups can be mapped to AD security groups on multiple domains.

1. Select Admin>Security Groups.

The Security Settings-Groups screen appears. 

2. Select the Active Directory Mapping tab.

3. Select the security group you wish to map to an AD user group.

4. Enter the domain, username, and password needed to connect to your domain with 
administrative permissions, then click Login.

5. In the Domain Name section, check one of the following and click Check Name to 
validate the name:

• Type Group Name.

 This is case sensitive.

• Select group name.
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If the name is valid you see: The Active Directory group name is validated. 

If the name is invalid you see: Invalid Active Directory group name.

6. Click the Save button to map your selection.

• If the mapping is correct, the Security Settings - Groups screen appears.

• If the group is already mapped to another MRM security group, you see: This 

Active Directory group name is already mapped to another MRM user group.

7. Follow steps 5 and 6 until all MRM security groups are mapped to AD user groups.

Step Four: Prioritizing AD security groups

While Windows users can be assigned to more than one AD security group, MRM users
can only be assigned to one MRM security group. This step prioritizes the AD security
groups so MRM knows which permissions to apply to a user who belongs to multiple AD
groups.

For example, an MRM user is assigned to the following AD domains:

• Users

• Administrator

• Seattle office

You would want to make the administrator domain the top priority, followed by the
Seattle office and lastly users.
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To prioritize AD security groups:

1. Select Start>All Programs>Meeting Room Manager 7>MRM Window Service 

Admin. 

The MRM Windows Service Admin screen appears.

2. Click the AD Synchronization tab.

In the Set User Group Priority field, the list of mapped AD security groups is shown. 
Only AD user groups that are mapped to an MRM security group are displayed.

3. Highlight a group by clicking on it, then move it into the desired position by clicking 
Up or Down.

The group at the top of the list has highest priority while the group at the bottom has 
the least.
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4. Repeat step 3 until all of the groups are in the desired order.

5. Click Save Setting.

AD has now been integrated with MRM.

Windows authentication

Why Windows authentication?

Windows authentication lets each MRM user automatically log in based on their network
username. This provides the following benefits:

• Improved security

• Less administration

• Centralized security management (domain user manager)

Enable Windows Authentication

This feature can only be turned on through the setup wizard. Refer to the Installation
Guide, available on the NetSimplicity Support Site available at: http://
www.netsimplicity.com/support

Connect Using Windows Authentication

When Windows Authentication is in place, there are four factors which are considered
before a user is granted or denied access to MRM:

• Does the user already exist in the MRM database?

• Is Active Directory integration enabled?

• Is the Active Directory option "Allow Unmapped Groups to Access MRM" 

enabled?

• Does the user belong to an Active Directory user group that is mapped to an 

MRM security group?
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As a result of these four factors, there are five possible scenarios for a user who attempts
to access MRM:

• If the user already exists in the MRM database, he is logged into MRM according to his 
existing permissions.

• If the user does not exist in the MRM database and Active Directory is disabled, his 
username is created in the MRM Default security group and he is logged in with the 
corresponding permissions.

• If the user does not exist in the MRM database, Active Directory is enabled, and the 
user belongs to an Active Directory group which is mapped, his username is created 
as a member of the mapped MRM security group. He is then logged in with the 
corresponding permissions.

• If the user does not exist in the MRM database, Active Directory is enabled, the user 
belongs to an Active Directory group which is not mapped, and the "Allow Unmapped 
Groups to Access MRM" option is enabled, his username is created as a member of the 
MRM Default security group. He is then logged in with the corresponding 
permissions.

• If the user does not exist in the MRM database, Active Directory is enabled, the user 
belongs to an Active Directory group which is not mapped, and the "Allow Unmapped 
Groups to Access MRM" option is disabled, the user is denied access to MRM.

 To log into MRM using Windows authentication, users must be connected to the
network to which the MRM server belongs. If a user is not logged into this network, when
he attempts to connect to MRM he will receive a Windows prompt to enter his Windows

username and password.

Before an Active Directory user can be recognized by MRM, the user must have
logged into the network domain at least once since the username was created in Active
Directory Services.

SAML authentication

Introduction

MRM Web supports Single Sign-On (SSO) using SAML (Security Assertion Markup
Language) authentication. This is a security feature designed for web browser-based



MRM 7  |  Admin Guide

                                                                                          57

applications. MRM Web can be used as a service provider in Identity provider (IdP)
initiated SSO. The MRM plug-in for Microsoft Outlook does not support SAML.

Enabling Single Sign-On using SAML

Before activating SSO, place the certificate file (.cir) given to you by the identity
provider on a place on the network where you can access it.

To activate SSO:

1. Select Admin>Options>Others.

The Project Options screen appears.

2. In the Single Sign-On using SAML section:

• Check the Enable Single Sign-On checkbox.

• In the Upload certificate field, browse to the security certificate.

3. Click OK.

The Assertion Consumer Service is located at MRM7/SAML/Assertion.aspx. The IdP has to
point to this file.

The following information is sent to MRM Web from the IdP:

• User name.
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• Security certificate.

The following ULR’s should be used in MRM Web call:

• <server name>/MRM7/SAML/Assertion.aspx (the assertion consumer service).

• <server name>/MRM7/Target page (where to go once successful 

authentication occurs).

The users table in the MRM database should be populated with the usernames

corresponding to the names of the actual users who will be using it. Passwords should be
empty.

The IdP should pass usernames to MRM. The message should be signed by a secret key
stored in the .pfx file which matches the .cir file loaded in MRM.

Assigning general permissions

The following is the list of the permissions categorized as general permissions. See
"Creating and editing security groups" on page 62 for instructions on how to change
these permissions for a security group. 

• Address Form Design: This allows a user to customize the layout, tabs, and 

fields in the Address Book form and the Attendee Detail form. This permission 

should only be assigned to administrators.

• Reservation Form Design: This allows a user to customize the layout of the 

Reservation form and Reservation Search form. Both this permission and the 

Change Options permission must be enabled in order to allow design of the 

Request Meeting form. This permission should only be assigned to 

administrators.

• Resource Details Form Design: This allows a user to customize the layout of the 

Resource Details form and the Resource Search form. This permission should 

only be assigned to administrators.

• Change Option: This allows a user to change options that affect all users such 

as project options, save rules, customizations to the labels and images of the 

interface, and resource types. Both this permission and the Reservation Form 
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Design permission must be enabled in order to allow design of the Request 

Meeting form. This permission should only be assigned to administrators.

• Print Reports: This allows a user to preview and print the reports that come 

with MRM. Users that do not have this permission enabled can only print and 

preview the customizable day/week/month view report from the printer icon 

at the top right of the main screen. This permission is normally assigned to all 

users but may be disabled for guests or read-only users.

• Modify Value Lists: This allows a user to add, edit, or delete items in any value 

list. Value lists can be assigned to any text field on the Reservation Form or the 

Room Detail Form by simply enabling the value list field property. This 

permission should only be assigned to administrators.

• Change Permissions: This allows a user to adjust security settings, such as 

adding, editing, and deleting security groups and usernames. This permission 

should only be assigned to administrators.

• Manage Locations: This allows a user to add, edit or delete locations. This 

should only be assigned to administrators.

• View Hidden Tabs: Each tab contains a property that may be modified to hide 

the tab from view. This permission allows a user to view these tabs. This should 

only be assigned to administrators.

• Modify Locked Tabs: Each tab contains a property that may be modified using 

the Form Designer to lock the tab. By locking the tab, no modifications can be 

made to the tab by users assigned to security groups without this permission. 

This permission allows a user to modify these tabs. This should only be 

assigned to administrators.

• Manage Filters: The ability to add, edit or delete resource filters can be granted 

to users. This should only be assigned to administrators. Recall that any user 

can use the custom filter on a per-use basis.

• Order <Service Name>: This controls the ability to order services from the 

Reservation form. It is named for the service it corresponds to. For example, 

Enable Catering corresponds to the Catering service, while Enable Equipment 

corresponds to the Equipment service. This permission should be assigned to 

all users who need to book corresponding services for their meetings. For 

more information about services, see the  "Services Management Module" on 

page 135.
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Assigning location permissions

The following is the list of the permissions categorized as location permissions. See
"Creating and editing security groups" on page 62 for instructions on how to change
these permissions for a security group. 

• Visible Location: Determines if the user can see the location.

• View Others Meetings: Determines if the user can view meeting details at the 

location.

• Add/Edit Meetings: Determines if the user can add or edit meetings at the 

location.

• Delete Meetings: Determines if the user can delete meetings at the location.

People using the MRM Plug-In for Microsoft Outlook should be given this 

permission. Those without it who use the plug-in to delete meetings will have 
bookings removed from their calendar, but not from the MRM database. Also see 
"Deleting an MRM Reservation in Outlook" on page 228.

• Confirm Meetings: Determines if the user can confirm meetings at the location. 

If checked, it also allows the user to view information about private meetings. 

For more details see "Setting viewing permission for private meetings" on 

page 165.

• Change Others Meetings: Determines if the user can change the meetings 

reserved by others at the location. If checked, also allows the user to view and 

change private meetings. For more details see "Setting viewing permission for 

private meetings" on page 165.

• Manage Rooms: Determines if the user can manage rooms at the location.

• Manage <Service Name>: Determines if the user can manage services. It is 

named for the service it corresponds to. For example, Manage Catering 

corresponds to the Catering service, while Manage Equipment corresponds to 

the Equipment service. This permission should only be provided to each 

service administrator according to the location and service she administrates. 

For more information about services management, see  "Services 

Management Module" on page 135.
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• Priority Rights: Determines if the user can push reservations created by users 

without this permission to the wait list.
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Creating and editing security groups

Security in MRM uses a group-based permissions setup. Security groups are created, each
containing a unique permissions set. Users are then created and assigned to these
security groups which can also be referred to as user groups.

Adding a security group and assign permissions

To create a new security group and assign permissions to it:

1. Select Admin>Security Groups. 

The Security Settings-Groups screen appears.
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2. Click Add User Group.

The General Permission screen appears.

3. In the:

• Group Name field, enter the name and description for the new security group.

• Description field, enter a description for the new security group.

4. To assign permissions, there are two tabs that permissions are categorized into:

• General Permissions: See "Assigning general permissions" on page 58  for 

details.
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• Location Permissions: See "Assigning location permissions" on page 60  for 

details.

To enable a permission, check the corresponding checkbox, or to disable a 
permission, uncheck the corresponding checkbox. 

For faster permissions assignment, use the All and None buttons vertically to 
assign the permission to all locations, horizontally to assign all permissions to one 
location, or at the bottom of the page to enable or disable all permissions.

5. Click Save.

Editing security group permissions

1. Select Admin>Security Groups

 The list of existing security groups appears.
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2. Click the security group name you want to edit.

The General Permission screen appears.

3. To assign permissions there are two tabs that permissions are categorized into:

• General Permissions: See "Assigning general permissions" on page 58.

• Location Permissions: See "Assigning location permissions" on page 60.

To enable a permission, check the corresponding checkbox, or to disable a 
permission, uncheck the corresponding checkbox. 

For faster permissions assignment, use the All and None buttons vertically to 
assign the permission to all locations, horizontally to assign all permissions to one 
location, or at the bottom of the page to enable or disable all permissions.

4. Click Save.
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Reassigning users to a different security group

To reassign users from one security group to another:

1. Select Admin>Security Groups.

The list of existing security groups appears.

2. Click the name of the security group you wish the users to now be assigned to.

3. In the detail form, select the Members tab.
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Usernames

Once security groups have been created, usernames can be created and assigned to the
security group whose permissions are appropriate for the user.

Create or Edit a Username

To create or edit a user:

1. Select Admin>Users.

The Security Settings-Users screen appears.
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2. To:

• Add a new user, click Add User.

• Edit an existing user, to the right of the username, click Edit.

3. Enter the user’s information to each field, specify the security group whose 
permissions apply to this username, and assign delegates if required.

For instructions on assigning delegates, see "Assigning delegates to a username" on 
page 68.

4. Click OK

Assigning delegates to a username

Overview of the delegate feature

In MRM, reservations can be delegated to a user who may act on the behalf of the
reservation’s organizer. When acting as a delegate, this user is granted the permissions of
the meeting’s organizer.

Users can be assigned as delegates to individual reservations as required. If many
reservations are involved, you may assign a user as a delegate to other users. This
automatically makes the user a delegate for the organizer’s reservations during the
designated time period. Because delegate settings in the Reservation form supersede all
other settings, it is possible to remove the delegate from a specific reservation as
required.

The delegate feature’s effect on permissions

When a user is working with reservations for which he has been added as a delegate, he
acts on behalf of the organizer and uses the organizer’s permissions. Typically this grants
him more permissions than he normally has for these reservations.

Overview of managing delegate settings

As the administrator, you may add or remove delegates for a username or change
delegate settings. Since each organizer may adjust his delegate settings when he edits his
user profile, you may choose to leave this setting up to each user or set it up on their
behalf.
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Time frame based delegation

You may wish to assign a delegate to username for a specific time period. The delegate is
given permission to act on the behalf of the organizer for meetings which are scheduled
during the specified time frame.

Permanent delegation

You may wish to assign a delegate to username on a permanent basis. This setting may
be modified at a later date if required, but while it is set, the delegate is given permission
to act on behalf of the organizer for any of his reservations. 

Viewing a username’s delegates

Both the permanent and the time frame based delegate settings are set in the username’s
properties. They can be accessed by an administrator through the username’s User
Details form or by the user himself in the Edit Your User Profile form. This section
addresses only the User Details form.
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To view a username’s delegates:

1. Select Admin>Users.

The Security Settings-Users screen appears.
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2. Click on the username whose settings you wish to view.

The User Details screen appears.

3. In the username’s User Details form, click the Delegates tab.

The list of the username’s delegates is shown.

Modifying a username’s delegate settings

1. Follow the instructions in  the “To view a username’s delegates” section. 

2. Click Add New Delegate.

• If you wish to modify an existing delegate’s settings, skip to step five.

• If you wish to delete a delegate from the username’s list, skip to step six.
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3. In the Delegate User List, navigate to the user you wish to select as this user’s 
delegate.

By default, the Delegate User List displays entries whose first names begin with 
the letter A. To display entries beginning with other letters of the alphabet, use the 
letters across the top of the form. To display all entries, click the All Users tab.

4. Check the box next to the delegate and click Add User.

The delegate is added to the list on the Delegates tab as permanent by default.

5. You may now modify each delegate’s settings:

• If you wish to change a permanent delegate to a time frame based delegate, 

uncheck the Permanent checkbox. Then enter the desired start date into the 

From field and the end date into the To field.

• If you wish to change a time frame based delegate’s status to permanent, 

check the Permanent checkbox.

• If you wish to modify a delegate’s time frame, edit the desired start date in the 

From field and the end date in the To field.

You may enter hours behind a delegate’s start or end date to narrow your time 
frame further.

6. If you wish to remove a username’s delegate, click Remove next to the delegate’s 
name.

7. Click OK.

The users you have specified as delegates for the username have been added as 
delegates to all reservations created by this user for the given time period. If the user 
creates additional reservations during this time period, these delegates will be added 
to their properties as well.
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Deleting a username

1. Select Admin>Users.

The Security Settings-Users screen appears.

2. Check the box beside the user you wish to delete and click Delete.

3. Click OK.

The selected user is deleted.
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Logging in

If Windows authentication is not used, users have to log into the reservation database
they are trying to access. Each username’s permissions depend upon the security group
that the username is assigned to.

When MRM is launched, the Login screen appears, asking for your username and
password. Enter your valid username and password, and click OK to log in.

See  "Running MRM in a web browser" on page 8 for details on how to connect to
your reservation database.

Editing your user profile

You may be prompted to edit your user profile the first time you log into MRM. Later, you
can edit your user profile by clicking the Edit User Profile icon at the top right of the main
screen.

While editing your user profile, you can change your basic information on the General

tab. You can also adjust your delegate settings on the Delegates tab.

General tab

• Username: This is the name you enter on the login page if using MRM 
authentication. If Windows authentication is in use, this field cannot be edited.

• Password: This is the password you enter on the login page if using MRM 

authentication. If Windows authentication is used, this field cannot be edited.

• Full Name: This is your full name.

• Email Address: This is the email address which will receive any email notifications 
sent by MRM.

• Default Location: This setting resets your My Location setting each time you log in. 
You can change your My Location setting without affecting your default location. 
This allows you to temporarily choose a different location as your current location 



MRM 7  |  Admin Guide

                                                                                          75

view if you’re travelling to that office, for example. You would do this to ensure that 
you see meetings in the time they occur at the location you’re travelling to.

For more information on your My Location setting, see "My location" on page 116.

Delegates tab

Overview of the delegate feature

In MRM, reservations can be delegated to a user who may act on the behalf of the
reservation’s organizer. When acting as a delegate, this user is granted the permissions of
the meeting’s organizer.

Users can be assigned as delegates to individual reservations as required. If many
reservations are involved, you may assign a user as a delegate to other users. This
automatically makes the user a delegate for the organizer’s reservations during the
designated time period. Because delegate settings in the Reservation form supersede all
other settings, it is possible to remove the delegate from a specific reservation as
required.

When a user is working with reservations for which he has been added as a delegate, he
acts on behalf of the organizer and uses the organizer’s permissions. Typically this grants
him more permissions than he normally has for these reservations.

You or your administrator may add or remove delegates for your username or change
your delegate settings. When you check your delegate settings, you may find that your
administrator has already assigned delegates for you.

Time frame based delegation

You may wish to assign a delegate to your username for a specific time period. The
delegate is given permission to act on your behalf for meetings which are scheduled
during the specified time frame.

Permanent delegation

You may wish to assign a delegate to your username on a permanent basis. This setting
may be modified at a later date if required, but while it is set, the delegate is given
permission to act on your behalf for any of your reservations. 
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Viewing your delegates

Both the permanent and the time frame based delegate settings are set in each
username’s properties. They can be accessed by your administrator or you may edit them
yourself in the Edit Your User Profile form. This section addresses only the Edit Your User
Profile form.

To view your list of delegates:

1. Click the Edit Your User Profile icon at the top right of the main screen.

2. Click the Delegates tab.

The list of your delegates is shown.

To modify your delegate settings:

1. Follow the instructions in the “Viewing Your Delegates” above. 

2. To add a new delegate, click the Add New Delegate link.

• To modify an existing delegate’s settings, skip to step five.

• To delete a delegate from the username’s list, skip to step six.

3. In the Delegate User List, navigate to the user you wish to select as your delegate.

By default, the Delegate User List displays entries whose first names begin with 
the letter A. To display entries beginning with other letters of the alphabet, use the 
letters across the top of the form. To display all entries, click the All Users tab.

4. Check the box next to the delegate and click Add User.

The delegate is added to the list on the Delegates tab as permanent by default.

5. To modify the delegate’s settings:

• To change a permanent delegate to a time frame based delegate, uncheck the 
Permanent checkbox. Then enter the desired start date into the From field and the 
end date into the To field.

• To change a time frame based delegate’s status to permanent, check the Permanent 
checkbox.

• To modify a delegate’s time frame, edit the desired start date in the From field and 
the end date in the To field.
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You may enter hours behind a delegate’s start or end date to narrow your time 
frame further.

6. To remove a delegate, click Remove next to the delegate’s name.

7. Click OK.

The users you have specified as your delegates have been added as delegates to all 
reservations created by this user for the given time period. If you create additional 
reservations during this time period, these delegates will be added to their properties 
as well.

Logging out

Logging out ends the user session and releases the concurrent user license that you were
using, making it available to other users. If a user closes his web browser without clicking
the Logoff button, the user session will time out after 20 minutes by default. The time out
duration can be changed in the web.config file. See "Shortening the session timeout" on
page 12 for details.

To log out of MRM:

1.  Click Logoff.

The default database Logged Off page opens.

2. To log back in, click on Login.

Implementing priority rights

Priority rights overview

In some organizations there are staff members who may choose the resources they’d like
even if they have already been booked by another employee. In MRM, these staff
members are referred to as priority users. 
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What kinds of staff are priority users? Perhaps they are managers and partners who have
first priority to use the facilities because of their standing in the organization. Or maybe
they are sales people who host client meetings and require rooms that can cater to their
equipment needs. Who you choose to designate as a priority user is up to you, based on
how your organization is structured.

MRM allows administrators to assign priority rights to any security group. Users with
priority rights are granted the option to override existing reservations created by regular
users in order to use the facilities they need. Priority users cannot override another
priority user’s bookings.

The priority rights feature set must be enabled in project options before any of the
features can be used. See "Setting the timeout, priority rights and other settings" on
page 30 for details.

Priority rights by location

Priority rights are controlled according to location. This allows administrators to pick and
choose the rooms that a security group’s users have priority rights to.

If the sales and marketing departments share the facilities of the fourth floor at the New
York office, the administrator may wish to only allow sales and marketing managers to
have priority over their own department’s meeting rooms. In this case, the administrator
would divide the rooms on the fourth floor into two sublocations: sales and marketing.
Then sales managers can be given priority rights only to sales resources and marketing
managers can be given priority rights only to marketing resources.

Terms

The following terms are used to describe the priority rights reservation workflow:

Priority reservations: Priority reservations are reservations scheduled by a user who has
priority rights for the corresponding location. Priority reservations can bump regular
reservations even if they are already confirmed by an administrator. Priority reservations
themselves cannot be bumped, even by users who also have priority rights.

Regular reservations: Regular reservations are reservations that are scheduled by a user
who does not have the priority rights enabled for the corresponding location. They can
be bumped by any user who has priority rights to the corresponding location. When
bumped they are placed in first priority on the wait list. If the reservation which bumped
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the regular reservation is cancelled, the regular reservation is pushed back to its original
booking space.

Priority rights reservation workflow diagram

The following diagram shows the priority rights reservation workflow:
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Explanation:

1. Regular User Books Reservation A

When a user without priority rights permissions creates a reservation in the grid, the 
reservation is identified as a regular reservation. It can be overridden by users with 
priority rights.

2. Regular User Books Reservation B that conflicts with Reservation A

When another user without priority rights desires the space (time and resource) 
already taken, he is free to create a reservation on the wait list. Only if the space 
becomes available will this user’s reservation get the desired space.

3. Priority User Books Reservation C that conflicts with Reservation A

A user with priority rights can take the space even though a regular user has already 
booked it. The regular user’s reservation is bumped to the front of the wait list.

4. Priority User Cancels Reservation C

When the space becomes available, the first in line on the wait list is automatically 
bumped into the desired space.

5. Regular User Cancels Reservation A

When the space becomes available again, the next in line on the wait list is 
automatically bumped into the desired space.

For more information about the wait list, see "Wait List" on page 247.

Assigning priority rights

To assign priority rights to security groups, simply adjust the security group’s permissions
accordingly. See "Creating and editing security groups" on page 62.

Overriding a regular reservation

To override a regular reservation, hover over the regular reservation in the Day view of the
reservation grid and select the Override option. The Reservation form then opens for you
to enter your reservation’s details. When you save, a prompt displays the conflict with the
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regular reservation and gives you the option to override the conflicting regular
reservation(s).

However, if the time and resource settings you’ve chosen for your reservation conflict
with a priority reservation, none of the resources or recurrences involved in the
reservation can be saved. You are prompted of the conflict and brought back to the
Reservation form to make changes.

Reassigning meetings

Meetings can be reassigned to another user to grant this other user permissions to the
reservation. This can be done to meetings individually or to all of one user’s meetings.

When a reservation is created in MRM, the creator's username is assigned to the
reservation in the database. This is different from the Booked By field on the Reservation
form's General tab which can be changed. When a reservation is reassigned, the user who
created the reservation is replaced by the other user. Depending upon each user’s
permissions, this can grant the other user full permissions to a reservation he originally
didn’t have permission to.

Meeting reassignment is permanent and does not allow a user’s meetings to be
given to multiple users. You may wish to simply delegate other users to a username. This
can be done on a per-reservation, per time-frame, or permanent basis. Rather than
assigning the new user as owner of the reservation(s), he is simply given the organizer’s
permissions to work with the reservations this username created.

To add a delegate to your username, see "Editing your user profile" on page 74. 

To add a delegate to a specific reservation, see  "Delegating a Reservation" on page 185.

Administrators like Kate may add a delegate to a username. See "Usernames" on page 67.

Reassigning user meetings

In the event that a new employee whose Modify Others Meetings permission is set to
False takes a previous staff member's place, he is not able to modify the reservations
created by the previous staff member that he is replacing. However, by reassigning the
Created by field from the previous staff member to the new employee, administrators can



Chapter 3  |  Security

82

keep the user's permissions minimal, and yet still allow him to edit the reservations that
he needs access to; in this case, those reservations that the previous staff member
created.

Before you reassign meetings, it is strongly recommended that you create a backup
copy of your reservation database. There is no undo operation for this function. Also ensure
that the new employee's username and permissions have been added to the reservation
database.

To reassign a user’s meetings:

1. Select Admin>Reassign Meeting.

The Reassign Meeting screen appears.

2. In the Meeting Created By drop-down list, select the previous staff member's 
username.

3. In the Re-assign to drop-down list, select the new employee's username.
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4. Click OK.

Reassign one meeting

In the event that a user needs to pass the administration of a reservation to another
person, she can do so using the Reassign Reservation feature. The ownership of the
reservation is moved to the new user who can now modify this meeting as his own, even
with the Modify Others Meetings permission disabled, as he is now considered to be the
meeting’s owner.

 In order to reassign another user’s meeting, you must have the Change Others
Meetings permission. In order to reassign your own meeting, you must have the Add/Edit
Meetings permission.

To reassign a meeting:

1. Log into MRM as the username who is the reservation’s owner.

2. In the day view of the reservation grid, hold the mouse over the reservation you wish 
to reassign. From the menu, select Reassign Reservation.

3. The Reservation Reassignment form opens. It shows the meeting title, the current 
owner as indicated in the Created by field, and the start and end dates and times of 
the meeting.

This detail is provided to allow you to confirm that the reservation you are reassigning 
is the one you mean to reassign.

4. In the Reassign to field, select the user to transfer ownership to.

5. Click OK.

If a priority rights user passes his reservation’s ownership to a user who does not
have priority rights, the reservation is no longer a priority reservation and can be
overridden by a user with priority rights. Similarly, if a user who does not have priority
rights passes her reservation’s ownership to a user who has priority rights, the reservation
is now a priority rights reservation and cannot be overridden.
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CHAPTER 4 Customizations

Customizations Overview

Customization is the best way to ensure that you get the most out of MRM. The MRM form
designer provides the freedom to customize both the user interface and the forms used
for entering data. 

Because customizations affect all users, they are typically made by the global
administrator before releasing MRM to the users. It is important that all other users are
logged out of the database while you are making form design changes. 

Some of the forms that can be customized are:

• Resource Detail form

• Reservation form

• Address Book form

• Attendee Detail form

• Request Meeting form

• Resource Search form

• Reservation Search form.

For example, you can customize the Resource Detail form to ensure that your
specifications are met and customize the Reservation form to include all of the equipment
and services that you offer to your staff for their meetings.

Some customers choose to customize MRM to meet their scheduling needs beyond
meeting rooms. You can customize your reservation database to meet your company’s
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specific reservation needs, such as scheduling golf tournament tee times, company
vehicle bookings, meeting room reservations, and anything else that your organization
needs to schedule. 

Customization also goes beyond form design. You have the freedom to customize the
images on the interface to incorporate your company colors and logo and the ability to
customize each label to allow for different languages to be used. The possibilities are
endless!

Before changing forms

Before making any changes with the form designer read all information pertaining to
form designer before attempting the change.

Users must keep in mind that when making form design changes, permanent changes are
being made in the database. There is no undo function for form design changes.

Changes may affect the standard reports that come with MRM and make them unusable.

It is strongly recommended that no users are logged into or able to log into the
reservation database while form design customizations are being made. If the reservation
database is being accessed by anyone other than the person performing the form design
customizations, corruption to the reservation database may occur.

Customization changes are permanent and cannot be undone. It is recommended that
you make a backup of your database before proceeding with any customization
procedure.

Form Design Toolbox

The following types of fields can be used in a MRM reservation database: text, number,
memo, picture, date, checkbox, label, and link.

• Text: A text field stores alphanumeric characters. Text fields can contain a maximum 
of 100 characters.

• Number: A number field can only contain numeric values. Totals can be generated 
for number fields when they are included in reports.
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• Memo: A memo field can contain more text than a text field can contain.

• Picture: A picture field stores a graphic image. JPEG, GIF, and BMP image formats 
are supported. To add or remove a picture, click the Add or Remove button within 
the form itself once you have completed using the form designer.

• Date: A date field contains a date in the format which matches your workstation’s 
date format. When clicked, a pop-up calendar displays.

• Checkbox: A Checkbox field stores a true or false value.

• Label: A label field only displays the label’s name.

• Link: A link field allows you to display text which, when clicked, directs the user to 
the underlying link.

Adding a tab

Additional tabs can be added at any time. However, it is recommended that form design is
complete before resources are added to the reservation database and the database is
made accessible to users.

To add a new tab to the Reservation form or the Resource Detail form:

1. Click the Form Designer checkbox at the bottom left corner of the form.
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2. The Form Designer Toolbox opens beside the form, displaying the Fields tab.

You are now working in Form Design Mode.

3. Select the Tab tab.

4. In the field above  Add Tab, enter the name of the new tab you wish to create.

Special characters cannot be used in the tab’s name. To add special characters to 
a tab’s name, use the label translation feature. See “Language and Label Translations” 
on page 97 for details.

5. Click Add Tab.
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6. Adjust the tab’s properties as shown in  “Tab properties” on page 89.

Tab properties

Properties can be set for each tab on the Reservation form or the Resource Detail form.

• Tab Name: This is the tab’s name. Once a tab has been created, the name cannot be 
changed except through the label translation feature. See “Language and Label 
Translations” on page 97 for details on changing a label.

• Order: This property defines what order the tabs in the form are displayed in.

• Has Requirements: Requirements are those items listed in tabs such as Equipment 
or Supplies, which are required for a reservation. This property may be set to either 
true or false. If it is set to true, when an item from the tab is selected, the reservation 
is saved as meeting with requirements.

• Hidden: This property may be set to either true or false. If it is set to true, the tab is 
hidden from view. Only users with the View Hidden Tabs permission can view a 
hidden tab.

• Locked: This property may be set to either true or false. If it is set to true, users 
cannot make modifications to the tab. The Modify Locked Tabs permission allows a 
user to modify a locked tab. This permission should only be assigned to 
administrators.

• Lock After Save: This property may be set to either true or false. If it is set to true, 
users cannot make modifications to the tab once the reservation has been saved for 
the first time. The Modify Locked Tabs permission allows a user to modify these tabs. 
This permission should only be assigned to administrators.

• <Location> Email: This property sets the department email by location. It defines 
the email address that receives the notification emails when a required item is 
selected on the current tab.
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Removing a Tab

The best resolution for removing a tab that you no longer wish to have is to hide the tab
from view. To do this, just set the tab’s Hidden property to True. 

If you must delete a tab, be aware that removing a tab also deletes all fields that exist on
the tab. All data stored in a field that is deleted is permanently lost. 

Never delete any of the tabs which come with MRM by default.

It is strongly recommended that no users are logged into or able to log into the
reservation database while form design customizations are being made. If the reservation
database is being accessed by anyone other than the person performing the form design
customizations, corruption to the reservation database may occur.

Adding a Field

Additional fields can be added to the Reservation form or the Resource Detail form at any
time. However, it is recommended that form design is complete before resources are
added to the reservation database and the database is made accessible to users.

It is strongly recommended that no users are logged into or able to log into the
reservation database while form design customizations are being made. If the reservation
database is being accessed by anyone other than the person performing the form design
customizations, corruption to the reservation database may occur.

To add a field to the Reservation form or the Resource Detail form:

1. Click the Form Designer checkbox at the bottom left corner of the form.
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2. In the Form Designer Toolbox , select the Field tab.

You are now working in Form Design Mode. 

3. Select the tab that you wish the new field to belong to.

4. Click the type of field that you wish to add.

5. The new field appears at the top left corner of the form. It can be moved into position 
by using the mouse to drag it into place.

The position of the field’s name can be adjusted independently.
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6. Edit the Name property to name the new field.

By default, the name of the field is the field type plus a number. E.g. TEXT1

Special characters cannot be used in the field’s name. To add special characters to 
a field’s name, use the label translation feature. For more details, refer to the 
“Language and Label Translations” section of this chapter.

7. Adjust the field’s remaining properties, as shown in “Field Properties” on page 92.

Field Properties

Properties can be set for each field on a customizable form.

• Name: This is the name of the field. If this property is grayed out, the name cannot 
be changed.

• Tab: This is the name of the tab that the field is on. Change this to reassign the field 
to another tab.

• Type: This is the type of the field. This property is always read-only. 

• Mandatory: This property may be set as either true or false. If it is set as true, users 
must enter information into this field in order to save the reservation.

• Default: This property displays information automatically within the field. The 
administrator can enter the desired text or choose from the date, time, date and 
time, next invoice number or the name of the user who is making the reservation.

• Value List: This property can either be set as true or false. If true, the field displays 
with a pull-down menu option. Value lists can only be assigned to text, memo and 
number fields. When the Value List property is set to true, items in the value list can 
be selected by clicking on the arrow to the right of the field. Items can be added, 
edited, and deleted from the value list’s pull-down menu when the corresponding 
button is selected. Value lists do not restrict users from entering random data into a 
field.

• Calculation: This property is used to calculate information such as a total of two 
other fields.
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Enclose field names in {} brackets in order to refer to them for adding within the 
Calculation property.

E.g. To calculate the fields value1 + value2 on the Totals tab, the calculation would 
be: {Totals/value1} + {Totals/value2}

• Price: This property allows a dollar value to be assigned to a field. This value 
appears on the invoice tab when the item is selected if the field is on a tab whose 
Has Req value is set to true.

• Alignment: This property defines the alignment of the text in the field. 

Legend: 0 = Left, 1 = Right, 2 = Center

• Tab Index: This property defines the order in which the cursor moves from one field 
to the next when the tab key is pressed.

• Left: This property defines the position of the field based on its space from the left 
of the form.

• Top: This property defines the position of the field based on its space from the top 
of the form.

• Width: This property defines the width of the field.

• Height: This property defines the height of the field.

• Label Left: This property defines the position of the field’s label based on its space 
from the left of the form.

• Label Top: This property defines the position of the field’s label based on its space 
from the top of the form.

• Qty: <Location>: This property determines how many of the resource are available 
for booking at each location. See “Preparing requirements’ availability” on page 119 
for more details.

Removing a Field

The Form Designer utility allows you to delete fields in the Reservation form and Resource
Detail form as needed. However, it is recommended that form design is complete before
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resources are added to the reservation database and the database is made accessible to
users.

Some fields cannot be removed, as they are necessary for the forms to function as
intended. 

It is important to know that when deleting a field, all data stored in that field is
permanently lost. Therefore, it is best to avoid deleting fields, especially once your asset
database has been made accessible to your users. 

It is strongly recommended that the administrator ensures that no users are logged
into or able to log into the asset database while form design customizations are being
made. If the asset database is being accessed by anyone other than the person
performing the form design customizations, corruption to the asset database may occur.

To delete a field:

1. Click the Form Designer checkbox at the bottom left corner of the form.

2. In the Form Designer Toolbox , ensure that the Field tab is selected.

You are now working in Form Design Mode.

3. Scroll to the tab that holds the field you wish to delete.

4. In the Form Designer Toolbox, select the field you wish to delete from the pull-down 
list.

5. Click Delete Field.

6. Click OK.

7. Other fields can now be repositioned by using the mouse to click and drag them into 
place.

Designing Search Forms

Search forms can be customized to reflect your organization’s searching needs. These
forms simply require that you decide which of the fields from the two information bearing
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forms you wish to have available for users to search by and how you want these search
fields arranged.

To design the Reservation Search form or the Resource Search form:

1. Click the icon for the search form you wish to design.

2. Check the Form Designer checkbox at the right of the form.

3. The list of available fields opens. 

Those fields which are already on the form have a check in the box to their left.

4. Check the box next to each of the fields you wish to have available for users to search 
by.

When users click the TAB button on their keyboard, the cursor will move to the 
next field in the order in which they were initially selected to be displayed on the form 
by the person performing form design.

5. When you are ready to display your changes, click Apply Changes.

6. All fields that you selected now display on the search form, while those that were 
unselected have been removed.
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7. Use your mouse to drag the fields and their titles to the position you wish them to be 
in on the form and to resize the fields as required.

Titles can be dragged separately from the field they belong to.

Adding Images to the Interface

MRM’s image translation feature is intended to allow organizations to customize the look
of the interface according to the organization’s corporate identity. The majority of MRM’s
images can be customized.

To customize images:

1. Select Admin.

The Administration screen appears

2. Select Customizations. 

The Customize Interface screen appears.

3. In the Form field, select the form that you want to customize.
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4. Click on the name of the image that you wish to change.

5. In the default field, enter the path and file name of the new image. 

6. The results can be viewed by selecting the Preview button.

7. Select OK to save changes, or Cancel to cancel the changes.

8. Repeat steps 3 to 7 until all the images are changed.

Language and Label Translations

MRM’s label translation feature can be used to customize the MRM user interface. Most
labels in the interface can be customized to modify existing English words and phrases.
The feature can also be used to add languages other than English for use in MRM.

If you simply wish to customize an existing English label, see “Customizing Labels” on
page 99.

If you prefer to use languages other than English, MRM allows you to add languages to
your MRM database and then translate the user interface into the desired languages.
Multiple languages can be used by users of the same database. Read through the
instructions in this section before you begin.
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Adding a Language

Multiple languages can be used in MRM. To make a language other than English available
to your users, first add the language to your MRM database as described below. Then
translate labels for that language as described in “Customizing Labels” on page 99.

Once your language is set up, you can specify it as the default language for your users as
described in “Specifying the Default Language” on page 100. If not all of your users speak
the same language, you may provide users with the appropriate URL to access MRM in
their own languages as described in “Specifying a preferred language” on page 100.

The following instructions describe how to add a new language column to the ResStrings
table in your MRM database.

Familiarity with the SQL Enterprise Manager is helpful for this process, and a full
version of SQL is required.

Customization changes are permanent and cannot be undone. It is recommended
that you make a backup of your database before proceeding with any customization
procedure.

To add a language to your MRM database:

1. In SQL Enterprise Manager, navigate to your database.

2. Double-click on Open Tables to open it.

3. Right-click on ResStrings, then select Design Table.

4. In a blank row, under Column Name, enter your language as it is spelled in English.

Example, if you are adding Romanian, enter Romanian, not Româna.

5. Ensure that the data type is set to ntext, the length is 16, and the Allow Nulls 
property is checked.

6. Save changes and close the table.

7. Close SQL Enterprise Manager.

You have added your language to your MRM database. You may now translate the 
user interface into this language as described in “Customizing Labels” on page 99.
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Customizing Labels

You may customize labels in Meeting Room Manager for English or a language you have
added as described in “Adding a Language” on page 98.

Since the form designer does not allow special characters in field and tab names, you may
use these instructions to add them.

Customization changes are permanent and cannot be undone. It is recommended
that you make a backup of your database before proceeding with any customization
procedure.

To customize  labels:

1. Select the Admin icon.

2. Select the Translations icon.

The Language Translation screen appears.

3. In the Language drop-down list, select the language whose labels you wish to 
customize.

4. In the Form drop-down list, select the form associated with the labels you wish to 
customize.

5. You may edit one label in its detail form or multiple labels directly in the list:
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• Edit One: Select the label you wish to customize by clicking its name in the 
Resource String column. In the Language Detail form that opens, edit the label as 
required. When finished, click OK to save your changes.

• Edit Multiple: Click inside the language column beside the label you wish to 
customize and adjust the label as required. Continue for other labels associated 
with the current form, and then click Update to save your changes.

6. To customize additional labels, repeat steps 4 and 5 as required.

7. Click Close.

Specifying the Default Language

You may specify the default language for your users. If users require multiple languages,
users requiring a different language than the default can specify it in their URL as
described in “Specifying a preferred language” on page 100.

The default language is English unless otherwise specified by an MRM administrator as
described below.

To specify the default language for your database:

1. Click the Admin icon.

2. Click the Translations icon.

The Language Translation screen appears.

3. In the Language menu, select the default language.

Allow the screen to refresh.

4. Click Set Default.

The selected language is now the default language for all users.

Specifying a preferred language

Users can specify their preferred language as a parameter in the URL they use to log in to
MRM. The language they specify must exist in the MRM database and have been
translated by an MRM administrator as described in the subsections above.
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Users preferring to use the default language do not need to specify the language in the
URL.

Specify the preferred language in the URL by adding the language parameter,
language=<language name>, at the end of the URL:

http://<web server>/<virtual directory>/default.aspx?language=<language name>

Replace <web server name> with the name of your web server, <virtual directory name>
with the name of your virtual directory, and replace <language name> with the name of
the preferred language as it is spelled, in English, in the MRM database.

Example: http://webserver1/MRM7/default.aspx?language=Romanian

Automated Email Reminders

Email reminders can be set up to remind various people in your organization about
upcoming meetings. You may wish to have the receptionist and group coordinator
receive daily emails listing the day’s meetings, or maybe you wish to remind each host of
his meeting an hour before it starts. 

Who you choose to put in the recipients list and what frequency you select are all up to
you. Email reminders are controlled by triggers held in the MRM Window Service Admin.
Administrators who are familiar with SQL statements can customize existing reminders or
create their own. 

Default Email Reminders

The following is the list of email reminders provided with the software:

• Remind 1 Hour in Advance

• Remind 2 Hours in Advance

• Remind 4 Hours in Advance

• Remind 24 Hours in Advance

• Remind 48 Hours in Advance

• Remind 1 Week in Advance
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• Notice of Meetings for Today

Create a New Email Reminder

Email reminders are triggers comprised of SQL statements. Therefore, knowledge of SQL
statements is required in order to create email reminders. You may with to contact your
system administrator if you would like additional email reminders created.

To create a new email reminder trigger:

1. Select Start>All Programs>Meeting Room Manager 7>MRM Window Service 

Admin>Triggers tab.
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2. Click Add New Trigger.

The frmTriggerDetail screen appears.

3. In the Trigger Name field, type a name for the trigger.

Do not use special characters such as apostrophes or quotation marks in the 
trigger name.

4. Choose the schedule for the trigger to run from one of the following:

• Once at <time>: This schedule forces the trigger to run every day at the specified 
time.
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• Occurs every <#> minute(s): This schedule forces the trigger to run at a specified 
minute interval such as every one minute.

5. In the Trigger Statement field, enter the SQL statements that control the trigger.

6. Test your trigger statement by clicking Test Trigger.

• If the SQL statement is valid, a prompt indicates this.

• If the SQL statement is invalid, a prompt indicates this and lists the problems.

7. Click OK.

8. In the Email Information section, if you wish to send HTML formatted email, check the 
HTML Format check box. If you wish to send text only emails, leave this box 
unchecked.

9. The Insert Field pull-down menu contains the field references which can be used to 
compose the subject and body of the email reminder. 

To use a field reference, place your cursor where you wish the field reference to be 
added, then select the field reference from the pull-down menu, and then click Insert.

The available field references are based upon the tables which are pulled in the 
trigger statement.

10.Compose the subject and body of the email reminder by clicking in the appropriate 
field and entering field references and your own customized text.

11.Enter each recipient’s email address into the To field. Separate each email address 
with a semicolon (;).

12.Once you have finished setting up the email information and trigger statement, send 
a test email by entering an email address you have access to in the Send Test Email To 
field, then clicking the Test Email button.

• If the test email is sent successfully, a prompt indicates this. You can visit the inbox 
of the email address you sent the test to in order to view the test email.

• If there is no data in the database which can be used to test this email reminder, the 
prompt indicates this.
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13.Once you are satisfied with the email reminder trigger you have created, make it 
active by selecting Active in the Status section of the form.

14.Click Save Trigger.

A prompt indicates that the email reminder trigger was saved successfully and the 
form closes.

Edit an Email Reminder

Because email reminders are triggers comprised of SQL statements, knowledge of SQL
statements is required in order to edit email reminders.

Editing the default email reminder triggers which come with MRM is not recommended.

To edit an email reminder trigger:

1. Select Start>All Programs>Meeting Room Manager 7>MRM Window Service 

Admin>Triggers tab.

2. Double-click the name of the email reminder trigger you wish to edit.

The trigger’s Trigger Detail form appears.

3. Make the changes as required.

4. Click Save Trigger.

A prompt indicates that the email reminder trigger was saved successfully and the 
form closes.

Deactivate an Email Reminder

Email reminder triggers cannot be deleted. Instead, simply deactivate any email reminder
triggers that you do not wish to use. 

1. Open the service by selecting Start>All Programs>Meeting Room Manager 

7>MRM Window Service Admin>Triggers tab.

2. Double-click the name of the email reminder trigger you wish to deactivate.

The trigger’s Trigger Detail form appears.
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3. Select Inactive in the Status section of the form.

4. Click Save Trigger.

A prompt indicates that the email reminder trigger was saved successfully and the form
closes.
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CHAPTER 5 Locations

Locations hierarchy

When you create your locations, you have the ability to structure them in a hierarchy
based on continent, country, region, state, city, office, floor, or whatever works best for
your organization. This is all done by creating the upper levels first, then adding lower
levels as children to these previously created parent locations. Up to five levels of
locations can be created in the hierarchy, but resources can only belong to the lowest
level of each hierarchical pyramid.

Time zones

Time zone overview

Each location managed by MRM is assigned to a time zone. These time zones consist of
the default time zones pulled from Microsoft Windows as well as any custom time zones
that the MRM administrator creates. 

Time zones must be based on Coordinated Universal Time (UTC). This means the
difference between Universal Time, also known as Greenwich Mean Time, or 0, and the
time zone’s time. For example, while London is 0, Boston is -5 and Tokyo is +9.

If one of your office’s locations is located in a time zone that is not included in the set
provided with Microsoft Windows, the time zone can be added by the MRM
administrator. 
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If daylight savings time affects any of your locations, this adjustment is set in the
location’s details.

Each current user’s time is based on her My Location setting. If her MyLocation setting is
Boston, she will see all reservations at the time they occur for her, at -5 UTC (Eastern). If
that same user changes her My Location setting to the Los Angeles office, set to -8, she
now sees all reservations in the grid according to Los Angeles (Pacific) time. Therefore, it is
extremely important that all users correctly set their MyLocation setting and that each
location’s time zone setting is correct.

Custom time zones

If a location’s time zone is not listed in the given time zones, a custom time zone can be
created. Unlike standard time zones which remain unchanged, custom time zones can be
edited and deleted.
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Creating a custom time zone

1. Select Admin>Locations>Manage Time Zones.

The Time Zones screen appears.
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2. Click New.

The Time Zone Details screen appears.

3. In the time zone field, enter the name for the new time zone.

4. In the UTC offset hours field, enter the number of hours and minutes that this time 
zone is offset from UTC.

5. Click OK.

UTC was previously known as GMT.

Daylight savings time settings for custom time zones are set by location in each
location’s respective detail form.

Editing a custom time zone

1. Select Admin>Locations>Manage Time Zones.

2. In the time zone summary, click on the custom time zone’s name. 

The Time Zone Detail screen appears.

3. Make the changes as needed. 

4. Click OK.

Deleting a custom time zone

1. Select Admin>Locations>Manage Time Zones.

2. In the time zone summary, click its checkbox. Click Delete.

3. Click OK.
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Adding a location

A location can represent a continent, country, region, state, city, office, floor, or whatever
works best for your organization. You can create locations at any time. 

1. Select Admin>Locations.

The Location Summary screen appears and existing locations are shown in their 
hierarchical positions.
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2. Click New.

The Location Details screen appears.

3. Enter the new location’s name in the way you want users to see it.

Each location must have its own unique name.

4. From the Child Of list, select the location that you want to be just above this new 
location in the hierarchy. If this new location is to be a top level location, select Root.

Because resources can only belong to the bottom level location, sublocations 
cannot be assigned to a location which contains resources.

5. In the Start Time and End Time fields, select when that the office opens and closes.

Reservations outside these hours are not shown in the grid.

This setting overrides the default setting for business hours for this location only. 
To set the business hours default information, see “Setting the default business hours” 
on page 17.



MRM 7  |  Admin Guide

                                                                                       113

6. If resources have already been added to your database, you may select those which 
are assigned to this location. Filter the resources based on their current location 
assignment by selecting a location from the value list.

Rooms which have not yet been added to the reservation database can be 
assigned to this location individually upon their creation.

7. In the Time Zone  list, select the applicable time zone.

8. If this location resides in an area which observes daylight savings time, check the 
Observe DST checkbox. Then adjust the daylight savings time (DST) details as 
follows:

• DST Bias: 

Enter the number of minutes that are affected during daylight savings time. 

For example, most areas in the US and Canada observe daylight savings time as -60 
minutes.

• DST Start:

Enter the start date and time of daylight savings time observation.

For example, in areas of the USA which observe daylight savings time, the start date 
is April 2nd at 2:00 am in 2006.

• DST End:

Enter the end date and time of daylight savings time observation.

For example, in areas of the USA which observe daylight savings time, the end date 
is October 29th at 2:00 am in 2006.

If the time zone you have selected is a default Windows time zone, there is no 
need to adjust the DST settings as they are automatically gathered from Windows. If 
you wish to use the DST settings, just check the DST checkbox.

9. Click Save and Close .

When a new location is created, it automatically has full permissions assigned to it for
users in the Administrators security group. All other security groups have no permissions
assigned for the new location, not even visibility. To add permissions to new locations for
security groups, see “Creating and editing security groups” on page 62.
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Editing a location

Location details can be edited at any time, including which resources are assigned to the
location.

To edit location information:

1. Select Admin>Locations.

Existing locations are shown in their hierarchical positions.

2. Click the name of the location you wish to edit.

3. The location’s detail form opens displaying its existing details. Make changes as 
necessary.

Moving a location with sublocations to a different level or parent location brings 
its sublocations and resources with it.

4. Click Save and Close.

Deleting a location

Locations which do not contain child locations can be deleted at any time. 

Be sure to reassign any resources assigned to the location unless you wish to delete
them and all of their reservations as well.

Deleting a location is a permanent change which cannot be undone.

Locations which contain child locations cannot be deleted. The last remaining
location also cannot be deleted.

To delete a location:

1. Select Admin>Locations.

2. Click the checkbox to the left of the location(s) that you wish to delete and click 
Delete.
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Adjusting location hierarchy order

By default, locations are displayed in the location hierarchy in the order which they and
their parent locations are created. This order can be adjusted in the locations list.

To adjust the order of locations:

1. Select Admin>Locations.

2. In the list of locations, click the up arrow next to the location you wish to move 
upward in the list. 

• Child locations can be moved to the top of the list of other child locations for the 
parent location.

• When parent locations are moved up, their child locations are moved with them.

3. Your changes are displayed when the main screen refreshes.

Setting reservation form tabs by location

When you open the Reservation form to create a reservation, you’ll notice that different
tabs are available depending upon the rooms and resources you have selected. This
happens because MRM allows the global administrator to choose which tabs on the
Reservation form apply to resources at each location.

By default, only the General tab is available to resources at every location. If you wish to
allow reservation information to be entered into fields on additional tabs, you must
enable these tabs by location.

The default tabs that exist when a reservation database is first created are the General,
Attendees, Setup, Equipment, and Invoice tabs. These can be modified and additional
tabs added using the form designer. 
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To enable and disable the tabs that are shown by location:

1. Select Admin>Advanced Administration>Visible Tabs by Location.

The Visible Tabs by Location screen appears.

2. On the form, locations are listed down the left and tabs are listed across the top.

• Check each box where you wish to enable the corresponding tab for the 
corresponding location

• Uncheck each box where you wish to make the corresponding tab unavailable for 
resources belonging to the corresponding location.

3. Click Save.

My location

The My Location setting allows you to set the location and therefore the time zone which
you are currently in. All time references for meeting start and end times are based on your
time zone. Make sure to set your My Location setting accurately so that reservations
display their times in your time zone.

Your My Location setting is overridden by the default location set in your user profile each
time your log in. If you wish to update your the location you regularly work in, update
your user profile information. See “Editing your user profile” on page 74 for details.

You may choose to change your My Location setting if you are travelling to a different
office location, for example. This allows you to see reservations at the time they will take
place where you will be.
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To change your current My Location setting:

1. On the main screen, select Set Current Location.

2. On the My Location menu, select the location you are now at.

3. Click OK.

Your MyLocation setting will be overridden by the default location in your user 
profile the next time you log into MRM. To change your default location, see “Editing 
your user profile” on page 74 for details.
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CHAPTER 6 Implementing Resources 
and Requirements

Introduction to resources and requirements

Both resources and requirements can be scheduled in MRM. But what is the difference
between them?

Resource: This is a display on the reservation grid. The most common example is a
meeting room.

Requirement: This is an item on a Reservation Form tab a user can request.
Examples include televisions, DVD players, and projector screens.

While resource bookings are controlled based on a user’s security settings, requirements
are based on availability. Requirements can be subject to confirmation from the head of
the department that the equipment belongs to, but only if the confirmation feature is
turned on in project options. For example, with the confirmation feature turned on, the
head of AV services must confirm requirements from the AV Services tab.

Preparing requirements’ availability

There are two methods to choose from when preparing the availability of requirements.
The method you choose depends upon whether your requirements are mobile or fixed
to a room.
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Option 1: Inventory Tracking

The inventory tracking method is best to choose if equipment can be moved from one
meeting room to another. It is the most commonly used method as it tracks how many of
each piece of equipment is available at every location. See “Implementing inventory
tracking” on page 121.

This method uses the form designer to prepare the how many of each type of
requirement is available at each location. First tabs are created by department, then
requirements are added, and finally the number available at each location is entered. 

For example, if there are two televisions in the Chicago office, then a user scheduling a
meeting there is limited to two televisions, as long as neither have already been booked
by other users for that time.

If both televisions have been reserved for the time she wishes to use them, MRM prompts
the booker upon saving her reservation there are no televisions available. After clicking
the prompt’s OK button, she is returned to the Reservation form in which she can change
the time or date of her reservation in order to have a television for her meeting.

Option 2: Room-Equipment Availability

Room-equipment availability uses the Match Tab Fields save rule to determine which
requirements are available in which resources.

It is set up primarily in the Resource Detail form which contains an Equipment tab by
default. Each piece of equipment in this tab has a checkbox that can either be checked or
unchecked. The checkboxes you select or leave blank depends upon the equipment
available at that the resource. 

For example, if the Pacific Boardroom does not have a Speakerphone in it, leave the
Speakerphone’s checkbox blank. If the Pacific Boardroom has a whiteboard affixed to the
wall, check the whiteboard checkbox.

When the Match Tab Fields save rule is active, a user is not able to select a requirement for
her reservation which is not selected on the room’s Resource Detail form. The save rule
checks the tabs of the same name on the Resource Detail form and the Reservation Detail
form. 

If form design changes are made and you wish to use this save rule, ensure the names on
both forms are identical. For example, if you add a piece of equipment called laser
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pointer, make sure you keep the space between the words on both forms. Next, list it on a
tab named the same way on both forms, like the Miscellaneous tab.

Implementing inventory tracking

Step 1: Preparing inventory tracking

Before you can apply inventory tracking to your database, in the Reservation Details
Form, set the Has Requirements property to True for each of the tabs which contain
requirements.

To set Has Requirements:

1. Select Admin>Reserve.

The Reservation Details form appears.

2. Click the Form Designer checkbox.

3. Click the Tab tab.

4. Click Add Tab.

5. In the New Tab field, enter the new tab’s name.

The new tab appears on the form. 

6. Click on the new tab

The tab’s properties are displayed in the Form Designer.

7. Set Has Req to True and click Apply Changes.

8. Add an email address to the <Location> email property. 

This email address receives the notification emails when a required item is selected on 
the current tab.

Emails can be sent automatically from the server. To implement this, see  
“Sending emails from the web server” on page 33.
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9. Adjust the remaining properties as required. 

See “Tab properties” on page 89.

10.  Click Apply Changes.

11.  Repeat steps 2 through 9 for each tab that you wish to add inventory tracking to.

Step 2: Applying inventory tracking

This step applies inventory tracking to your database. Carry it out for every piece of
equipment that can be booked within a tab of the Reservation form:

1. With form designer Fields tab open, highlight the field you wish to set quantities for.

2. Scroll to the bottom of the properties list in the toolbox and adjust the quantity 
setting for the <Location> quantity property.

3. Select Apply Changes.

4. Repeat steps 1 to 3 for all the remaining equipment in the various tabs.

Step 3: Activate the inventory tracking save rule

1. Close the form designer toolbox.

2. Select Admin>Save Rules. 

The list of save rules opens.
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3. Click Inventory Check. 

The Rule Details screen appears.

4. Check the Active checkbox and click OK. 

Inventory tracking is now in effect.

Applying prices to equipment

To calculate invoice charges, prices can be assigned to requirements on the Reservation
form.
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To assign a price to an equipment field:

1. Click Reserve.

 The Reservation form appears.

2. Click the Form Designer checkbox.

Form Designer appears.

3. Click on the Fields tab.

4. Highlight the field to which the price should be assigned.

5. Enter the price in the Price property.

6. Close Form Designer.

Prices have been assigned to the equipment.

Resource types

The Resource Type selected for a resource determines the tabs that are available to
contain detailed information about the resource. 

Because tabs can be added and deleted using the form designer, resource types are
typically created by the global administrator because she knows which tabs were
designed to correspond with which types of resources.
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Adding a resource type:

1. Select Admin>Resource Type.

The Resource Type screen appears.
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2. Click Add.

3. In the:

• Name field, enter the resource’s name.

• Description field, enter a description for the resource.

4. In the Visible Tabs column, check the box beside each tab that you wish to make 
available for resources in this group.

5. Click Save.
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Editing a resource type

1. Select Admin>Resource Type.

The Resource Type screen appears.

2. Click the name of the resource type to edit.

3. Change the name and description, select the tabs that you wish to make available and 
unselect the tabs you wish to make unavailable to resources in this group.

4. Click Save.

Deleting a resource type

A resource type can only be deleted if no resources are associated with it.

1. Select Admin>Resource Type.

The Resource Type screen appears.

2. Check the box beside the resource type(s) to delete.

3. Click Delete.

If the resource type you are attempting to delete is still assigned to resources, you are 
prompted with the name of the resources and informed that their reservation type 
needs to be changed before this reservation type can be deleted.

Adding a resource

An unlimited number of resources such as meeting rooms may be added to a reservation
database. There must be at least one resource in your reservation database before a
reservation can be created.

If you wish to customize the fields and tabs on the Resource Details Form, it is
recommended that you do this before adding resources. To use the form designer, see
“Customizations” on page 85.
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Resources themselves are usually created in the reservation database by a local
administrator who has an intimate knowledge of the resources in the facility that he
administrates. However, your global administrator may choose to add all resources
herself for consistency, especially if the Match Tab Fields save rule is in use.

To add a meeting room/resource:

1. Select Admin>Add Resource.

The resource details screen appears.

2. In the Resource Name field, enter the name of the resource.

Though it is recommended that each resource be given a unique name, two resources 
may have the same name as long as they do not belong to the same location.
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3. In the Resource Type drop-down list, select the resource type. 

This determines which tabs are available for you to insert information about the 
resource.

To add and remove resource types, see “Resource types” on page 124.

4. In the Location Name drop-down list, select the location the resource belongs to.

To add and remove locations, see “Locations” on page 107.

5. Specify the column width for the resource and its display order. If nothing is entered, 
the defaults will apply.

It is recommended that a different set of numbers is used for resources at each 
different location for the display order field.

6. Add information to the remaining fields in each available tab as appropriate.

7. You may add a picture to represent the resource. See “Adding a picture to a resource” 
on page 129.

8. Click Save and Close.

Adding a picture to a resource

You may add images to a resource’s Resource Detail form to let users see a photo of the
resource. Alternatively, you could add an image of the meeting room’s floorplan.

To add an image to the Picture field:

1. On the reservation grid, click the resource name. 

The Resource Details form appears
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2. Hover your mouse over the Picture field and then click the Plus icon.

The Upload File screen appears

3. Click Browse to locate the image to add to the form. 

4. Click Upload.

The Resource Details form displays the picture.
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Viewing and editing a resource

To:

• View a resource’s details, click the resource name.

The Resource Details form appears, allowing you to view all of the resource’s details. 

• Edit a resource’s details, open its Resource Details form and then make changes as 
needed. Click Save and Close.
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Removing a resource

Deleting a resource is permanent and also results in the deletion of all reservations
for the resource.

1. On the reservation grid, click the resource name. 

The Resource Details form appears.

2. Click Delete.

3. Click Yes.

Changing the grid order

MRM administrators can set the order in which resources are displayed in the grid. It is
recommended that a different number be assigned to each resource across all locations,
as oppose to re-starting at number one for resources in a new location. This controls the
display order when all resources are displayed in the grid.

To change the display order on the grid:

1. On the reservation grid, click the resource name.

The Resource Details form appears.

2. In the Grid Order field, adjust the setting numerically relative to the other resources.

Adding a virtual resource

In some cases you may need to add one or more resources that allow multiple
simultaneous bookings. These are called virtual resources since they usually are not actual
rooms but are holding spaces for bookings.

Their most common use is to provide a way to book services that are not explicitly tied to
a resource or not managed in MRM. For example:
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• Catering items can be ordered and delivered to locations not in MRM such as 
booking lunches to be picked up at reception. 

• If you have equipment that can be ordered and used without being tied to a specific 
resource such as LCD projectors or laptops.

Virtual resources do not have conflict checking applied to them to prevent double-
bookings.

Creating a virtual resource is a two step process:

• Add a virtual resource checkbox to the Resource Detail form. 

• Check that box for every resource you want to be virtual.

Step One: Add a virtual resource checkbox:

1. Select Admin>Add Resources.

The Resource Details form appears.

2. Check the Form Designer checkbox.

3. Add a checkbox to the General Tab and name it Virtual Resource.

4. Close Form Designer.

Step Two: Create the virtual resource:

Either: 

• Create a new resource and check the Virtual Resource checkbox.

• Edit an existing resource and check the Virtual Resource checkbox.

If editing an existing resource, make sure that allowing simultaneous bookings 
makes sense for its use.
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CHAPTER 7 Services Management 
Module

Services Management Overview

The Services Management module provides you with the tools you need to effectively
manage service requests for your meetings. When checkboxes and value lists on the
Reservation form aren’t enough, you can use this module to manage services that require
more; details like cost, description, and availability are all managed by this module.

Services are catalogued to make them easier to manage. Each service’s catalogue
contains categories and subcategories under which service items can be grouped.

Service items are anything your organization offers with room reservations. They can:

• Be available at select or all locations and/or rooms.

• Be limited in quantity by location for tracking inventory.

• Have a cost by location.

Services are the groupings in which service items are clustered. They may each be
separate departments within your organization. Each service has its own:

• Security setting that controls which users can order the service’s items.

• Security setting that controls which administrators can manage the service and its 
items.

• Administrative form in which administrators manage the service.

• Named tab on the Reservation form in which users view service items and place 
orders.
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• Customizable lead time requirement which restricts users from placing an order too 
close to delivery time. 

• Customizable future booking time limit which restricts users from placing an order 
too far in advance of the delivery time.

• Catalogue of service items which are grouped into categories and subcategories for 
convenience.

The Services Management module is enabled with the MRM Enterprise edition activation
key.

Service Examples

Nearly any services you provide to your guests and staff can be integrated with your
reservation process. Here are some examples of uses for the Services Management
module:

• A corporation provides Audio Visual equipment to its staff for their meetings. The 
corporation has made an Equipment tab available for staff to choose the equipment 
they require for each meeting.

The equipment shown on the tab is specific to the resource that the staff member has 
selected for his reservation. In one location, there are 15 teleconference units 
available. But since they can only be used in rooms which have an active phone jack, 
the administrator made the units unavailable in resources without phone jacks.

A staff member who chooses the Training Hall, which does not have a phone jack, 
does not see the units in the list of items, but a staff member who selects the Ebenezer 
Conference Room sees the teleconference unit as a piece of equipment he/she can 
schedule because the conference room has a phone jack.

• A university rents out their classrooms to local non-profit organizations and 
businesses for catered meetings. The University provides a Catering Services tab with 
menus unique to each campus building based on the catering available there. Some 
rooms have catering available while other rooms, such as computer labs, cannot be 
reserved with a catering request. 

The university also provides an Equipment tab with a list of the various Audio Visual 
equipment available with each room. Some classrooms can be rented with a projector 
and screen, others with just a TV and DVD player. Some rooms have white boards and 
others can accommodate flip charts. 
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When a guest reserves a room for his own use, he is presented with the list of items, 
both catering and equipment, that are available in the resource he has selected. The 
university requires that all service requests be approved by the administrator, so when 
reservations are created, service orders sit in the Pending status until confirmed.

• A community center rents out their soccer fields and tennis courts to local children’s 
and youth groups. Along with the field or court rental, guest groups can rent balls, 
nets, racquets, and even referees.

The community center provides an Equipment tab which contains all available 
equipment for rent, and a Referee tab which provides a brief description of each 
Referee’s qualifications. The reservation process takes care of equipment and Referee’s 
availability.

• A warehouse has 75 loading docks. When a loading dock is booked to receive a 
delivery, the receiving department also needs to book a forklift and driver.

The organization provides a Forklift tab which contains the various kinds of forklifts 
available for rent, and a Driver tab which lists each driver’s skill set.

• An equestrian center holds International horse shows, sometimes caring for 300 
horses at a time. Each horse stall can be booked by the owners of incoming horses, 
along with the various equestrian services required. 

In the Reservation form, the center has made the following tabs available: Feed, 
Farrier, Vet, and Paddocks. Each horse’s daily feed requirements can be ordered and 
feed times specified in the Feed tab. 

If a horse arrives needing new shoes, the owner can simply update the booking and 
request Farrier services. If the owner requires that his/her horse has daily exercise in a 
paddock, a suitable one can be booked along with the stall. 

The rates for each service are supplied to the owner as he/she picks the services in his 
request and totalled at the bottom of each service tab.

• The national head office of a corporation often hosts the International President of the 
company. When he visits, he requires the Executive Boardroom full-time for all of his 
meetings, and a company car for his use during his visit.

The company provides a Vehicles tab in their Reservation form to allow his Executive 
Assistant to order him an appropriate vehicle for his visit. Because the corporation’s 
service administrators consider users in his Executive Assistant’s user group to be pre-
approved for service orders, his vehicle service order is immediately saved as 
processing instead of as pending approval.
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These are just a few examples of the many ways in which the Services Management
module can be utilized to manage the services that your organization provides.

Now it’s time to examine your own organization and decide how you wish to apply the
Services Management module for your use. Once you have decided, you can set up your
services and then make them available to users.

Setting Up the Services Management Module

1. Create Services

The global administrator creates the services used in MRM.; e.g. Catering, Equipment, 
etc.

See “Managing Services” on page 140.

2. Grant Permissions to Service Administrators

The global administrator grants manage rights for each service to appropriate service 
administrators responsible for each location.

See “Security Settings for Services” on page 143.

3. Create Service Catalogues

Each location’s service administrator creates the list of items that is available with each 
service. This can involve:

• Creating a hierarchy of categories and subcategories in which service items will be 
grouped.

e.g. Beverages may be a category, while juice and tea may be subcategories.

See the “Service Item Categories” section of this chapter.

• Adding service items to the above categories

e.g. The Screens category may contain TVs and projector screens.

See “Service Items” on page 148.

• Specifying service item availability according to room

e.g. Projector screens may not fit in some rooms, while they can be used in others.
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See “Service Items” on page 148.

• Specifying pricing according to location

e.g. Imported food dishes may be more expensive than local items, so while a 
shrimp dinner is inexpensive in the southern states, it may be pricier in the central 
states.

See “Service Items” on page 148.

4. Modify Email Templates

Based on insight from local service administrators, the global administrator modifies 
the default email templates associated with Services Management.

See “Service Order Email Messages” on page 158.

5. Grant Permissions to Users

Once setup is complete, the global administrator grants management and ordering 
rights to appropriate users.

See “Security Settings for Services” on page 143.

Service Orders in the Reservation Form

Once the Services Management module has been set up by the global administrator and
the local service administrators, users create reservations which contain service requests.
Each service can be viewed as a tab in the reservation detail portion of the Reservation
form. Instructions for placing a service request can be found in “Request Services” on
page 176.

Service Orders in Microsoft Outlook

If you choose to use the MRM plug-in for Outlook, you can schedule service requests
along with your reservation, just as in Meeting Room Manager. Instructions can be found
in “The MRM Plug-In for Microsoft Outlook” chapter of this manual. 
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Ongoing Management of Service Orders

It is important that global administrators and local service administrators understand the
order process before granting users with rights to place orders. 

For an overview of the order process, see “Order Process” on page 152. The “Service Order
Use Cases Diagram” on page 155 shows service administrators their role in the order
process. 

Before service orders begin to roll in, service administrators can find instructions on how
to perform their tasks in “Pending Orders: View, Confirm, or Reject” on
page 156,“Processing Orders: View or Cancel” on page 157 and “Viewing Archived Orders”
on page 158.

Managing Services

Manage Services Overview

Within MRM, you can create any services you wish to provide to users who reserve your
resources. To see a range of examples, see “Services Management Overview” on page 135.

If at a later date a service is no longer available in any of your organization’s locations, you
can delete it. At any time in between, you can modify the services you offer.

Creating a New Service

Services can be created at any time. However, it is recommended that you read this entire
chapter before creating your services.

1. Select Admin>Services Management.

2. Click Add.

3. The Service Details form opens. Enter the following:

• Name: Enter service’s name.

• Tab Name: Enter a brief, intuitive name for the tab that will be displayed in the 
Reservation form. 
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This is the only name of the service that users will see when they are 
scheduling a reservation.

• Description: Enter a brief description of the service.

• Min. Lead Time: Enter the minimum amount of notice, in hours, required for users 
to schedule this service’s items. Up to three digits can be entered.

• Max. Future Booking Window: Enter the maximum number of months in advance 
that this service’s items can be scheduled. The number must be between one and 
twelve. For unlimited, leave the field blank.

4. If you do not want to track inventory for this service, check the Inventory Is Not 
Applicable checkbox. MRM will not check to see if quantities of an item belonging to 
this service are available when ordered. 

Catering likely does not require inventory tracking since food is consumable. 
However, equipment likely requires inventory tracking since only a certain number of 
each item have been purchased and are available for circulation.

5. Click Save to return to the list of services.

Permissions to the new service are automatically granted to the Administrators 
security group. Users in other user groups have no permissions to the new service. 
This gives the global administrator and local service administrators time to set up the 
service before making it available to users.

For more information, see “Security Settings for Services” on page 143.

Editing a Service

To edit an existing service:

1. Select Admin>Services Management.

2. Click the name of the service you wish to edit.

3. The Service Details form opens. Edit the service’s details as required:

• Name: Enter the name of the service.

• Description: Enter a brief description of the service.
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• Tab Name: Enter a brief, intuitive name of the tab which will be displayed in the 
Reservation form. 

This is the only name of the service that users will see when they are 
scheduling a reservation.

• Min. Lead Time: Enter the amount of notice, in hours, required for users to schedule 
this service’s items. Up to three digits can be entered.

• Max. Future Booking Window: Select the amount of months in advance that this 
service’s items can be scheduled. One, two, three, six, twelve, or unlimited can be 
selected.

4. If you prefer not to track inventory for this service, check the Inventory Is Not 
Applicable checkbox. MRM will not check to see if quantities of an item belonging to 
this service are available when ordered. 

Catering likely does not require inventory tracking since food is a consumable 
item. However, equipment likely requires inventory tracking since only a certain 
number of each item have been purchased and are available for circulation.

5. Click Save to return to the list of services.

Deleting a Service

If a service is no longer available in any of your organization’s locations, you may delete
the service from MRM.

All orders, service categories, service subcategories, and service items associated
with a service that is deleted are immediately deleted along with the service. 

To delete services:

1. Select Admin>Services Management.

2. Check the box(es) next to the name(s) of the service(s) that you wish to delete.

3. Click Delete.

4. Click OK. You are returned to the list of services.
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Security Settings for Services

Overview of Security Settings for Services

There are two security permissions associated with services for every location. The
Manage <ServiceName> permission controls the ability to manage services, and the
Order <ServiceName> permission controls the ability to order service items. Both of these
permissions are created automatically when the global administrator creates a service.

Granting Service Admin Security Rights

Before the service administrator, such as Juliette, can manage her location’s service orders,
she must have the appropriate permissions granted to her security group. The global
administrator can either create new security groups or edit existing ones.

Once you grant permissions to a security group, users who belong to that group now
become service administrators. You should only grant this permission to a security group
that has other permissions appropriate to a service administrator, such as Visible and View
Others Meetings, for the location they will be managing services for.

To grant permissions for a service at a specific location:

1. Select Admin>Security Groups.

The list of security groups displays.

2. Click on the name of the security group to which you wish to grant services 
management rights. The Security Settings form opens. 

3. Click the Advanced Service tab.

4. Grant the right to view and use a service’s ordering tab on the Reservation form by 
clicking the corresponding checkbox next to each appropriate location.

The name of the permission is Order <Service Name>. Replace <Service Name> with 
the name of the service.

e.g. If your service’s name is Equipment, the permission is named Order Equipment.
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5. Grant users with permission to manage a service by clicking the corresponding 
checkbox next to each appropriate location.

The name of the permission is Manage <Service Name>. Replace <Service Name> 
with the name of the service.

e.g. If your service’s name is Equipment, the permission is named Manage Equipment.

6. Set other permissions as needed.

7. Click Save. You are returned to the list of security groups.

To assign users to groups, see “Usernames” on page 67.

Enabling Users to Request Services

Before users like Charlie can request service orders in their reservations, they must have
the correct permissions granted to their security groups. The global administrator can
either create new security groups or edit existing ones.

Users should not have service permissions assigned until local service administrators have
set up the service items. For more information on the setup procedure, see  “Setting Up
the Services Management Module” on page 138.

To grant users with permission to order services:

1. Select Admin>Security Groups.

The list of security groups displays.

2. Either:

• Click on the security group you wish to grant service order permissions to. 

• To create a new security group click Add User Group.

3. The Security Settings Groups form opens. Click the Advanced Service tab.
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4. Grant the right to view and use a service’s ordering tab on the Reservation form by 
clicking the corresponding checkbox next to each appropriate location.

The name of the permission is Order <Service Name>. Replace <Service Name> with 
the name of the service.

e.g. If your service’s name is Equipment, the permission is named Order Equipment.

5. Set other permissions as required.

6. Click Save. You are returned to the list of security groups.

To assign users to groups, see  “Usernames” on page 67.

Services Catalogues

Service catalogues are made up of a hierarchical structure of categories within which
service items are organized. This allows users and administrators to find service items
quickly and easily.

How you choose to arrange categories and subcategories is completely up to you, based
on the services you are providing to users.

For simplicity, the instructions below only reference categories but apply to subcategories
as well. In areas where categories and subcategories operate differently, this information
is stated.

Only categories or subcategories which do not contain their own subcategories can
contain service items.

Catalogue Navigation

The catalogues you create will be accessed by your users in the Reservation form.

When a user first clicks on a service tab, the catalogue displays only the top level
categories, each with plus symbols next to them. When a user clicks on the plus symbol or
the category name, the items or subcategories that are one level beneath the clicked
category are displayed. The same applies to subcategories.
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If you have set up the catalogues with multiple levels of subcategories, this means that
your users will have to click several times before accessing the items they wish to order. If
you have the option to limit the levels of subcategories you include in your catalogues,
this may be beneficial to your users. However, if this is not practical, you can enable the
custom tree view which modifies MRM’s behavior.

When the custom tree view is enabled, users can click a category’s name to reveal all
subcategories and service items beneath it. The same behavior applies to subcategories. 

The custom tree view has been designed to allow users to use the default behavior by
clicking the plus symbol next to a category or subcategory.

To enable the custom tree view:

1. In Microsoft SQL Server Enterprise Manager, open your MRM database.

2. Open the Options table.

3. Add a blank row to the table.

4. In the new row, under the Setting column, enter the following text:

CUSTOM_TREE_VIEW

5. In the new row, under the Value column, enter the following text:

True

6. Exit Microsoft SQL Server Enterprise Manager.

Adding Service Item Categories

To add a service item category:

1. Select Admin.

2. Click the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Categories tab.
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4. Click New.

5. Enter the new category’s details:

• Category Name: Enter the category’s name.

• Child of: If the category you are creating is a subcategory, select the parent 
category from the pull-down list. To create a top level category, select Main 
Category (root).

6. Click Save.

Editing Service Item Categories

1. Click the Admin icon.

2. Click the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Categories tab.

4. Click the name of category you wish to edit.

Categories and subcategories are displayed in a hierarchy format. To expand or 
minimize your view of subcategories, click the parent Plus or Minus button.

5. Adjust the details as required.

• Category Name: Adjust the category’s name as required.

• Child of: If the category you are creating or editing is a subcategory, select the 
parent category from the pull-down list. To create a top level category, select Main 
Category (root).

6. Reassign Service items:

• Service items can be reassigned to this category. In the Reassign section, select the 
category (and subcategory if applicable) of the service item you wish to reassign. 
Check the box beside each service item you wish to reassign to this category.
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• Service items can be removed from this category. In the Reassign section, uncheck 
the box beside each service item you wish to remove from this category.

7. Click Save.

Deleting a Service Item Category

Subcategories with service items assigned to them and categories with subcategories
below them cannot be deleted. They must be reassigned or deleted before the parent
category or subcategory can be deleted.

To delete a service item category:

1. Click the Admin icon.

2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Categories tab.

4. Click the checkbox beside each category that you wish to delete. 

5. Click Delete. 

Only subcategories with no service items assigned to them and categories with 
no subcategories below them can be deleted.

6. Click OK.

Service Items

Service Items Overview

Service items can be anything that you allow users to reserve along with your resources.
They can be grouped into categories to make them easier to locate for booking and
administration. 
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MRM allows service administrators to determine which items are available for which
locations and rooms. For example, caterers may not wish to provide dinners for a meeting
held in an auditorium while they can easily cater dinners to a group in a conference room.
When a service item is created, it is unavailable in all locations and rooms by default.
While adding or editing an item, service administrators must make the item available in
the rooms to which it can be delivered.

Hierarchies can be used to make items available for some rooms and not for others. If the
quantity field in a lower level is left blank and there are items available for use in the level
above it, then the lower level can order it. If the lower level’s quality field is filled with a
zero (0), it cannot order that item and it will not appear in the user’s list of available
resources for that room.

Hierarchies can be used to share items between rooms. If the total number of a particular
item is placed into the quantity field of the highest level, and the quantity fields of the
lower levels are left blank, then that item can be ordered by the rooms on the lower levels.
Users cannot order more items than are available or they will get a warning message.

You can set the maximum number of items a room can order by putting that number into
the quantity field for that room. By doing that, and leaving the quantity field for other
rooms blank, the other rooms have no limits on the amount that they can order. Rooms
with the quantity fields filled out can only order up to that number of items.

Prices can be set for each service item. These prices are location-based to allow for price
variation across your organization’s locations. To use catering again as an example,
seafood, may cost less on the coast in Seattle than it does to prepare inland in Denver,
Colorado. 

The price of each item is $0.00 by default and must be set according to location by service
administrators when the item is added or edited.

Adding a Service Item

1. Click the Admin icon.

2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.
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3. Select the Items tab.

4. Click New.

5. The information form opens. Enter:

• Item Name: Enter the name for the item in the Item Name field.

• Description: Enter a description for the item in the Description field. Users can view 
this information before adding the item to an order.

• Category: Select a category or subcategory for the item to be classified under.

6. Assign availability by location. To make this item available to all rooms at a location, 
check the box beside the location.

You can make this item available for all locations or no locations by clicking the 
All and None buttons at the bottom of the form.

With hierarchies, you can specify the items that can be shared between locations, 
block items from being used by certain locations, or set the maximum number of 
items a location can use. See “Service Items Overview” on page 148 for details.

7. If you are tracking inventory for this service, enter the available quantity in the Qty 
column for each location you have selected.

8. Availability can be assigned by resource. To view the resources belonging to a 
location, select the location and click View Rooms. 

Set availability by checking and unchecking the boxes beside each resource.

Rooms for each selected location will be displayed until the Hide Rooms button is 
clicked.

9. An item’s price is set by location. Enter the item’s price next to the corresponding 
location. To copy this price to all other locations, click Set Price for All.

10.Click Save.

Editing a Service Item

1. Click the Admin icon.
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2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Items tab.

4. Click the name of the item you wish to edit.

If you prefer to narrow the list of items first, select the item’s category or 
subcategory from the Category pull-down list.

5. The information form that opens. Alter the item’s information:

• Adjust the name for the item in the Item Name field.

• Adjust a description for the item in the Description field. This displays when a user 
hovers his mouse over the item before selecting it for his reservation.

• Adjust the subcategory for the item to be classified under.

6. Availability can be assigned by location. To make this item available to all rooms at a 
location, check the box beside the location.

You can make this item available for all locations or no locations by clicking All 
and None.

7. Availability can also be assigned by resource. To view the resources belonging to a 
location, select the location and click View Rooms. 

Set availability by checking and unchecking the boxes beside each resource.

Rooms for each selected location will be displayed until the Hide Rooms button is 
clicked.

8. An item’s price is set by location. Enter the item’s price next to the corresponding 
location. To copy this price to all other locations, click the Set Price for All button.

9. Click Save.
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Deleting a Service Item

1. Click the Admin icon.

2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Items tab.

4. The full list of service items displays. To narrow the list of items, select the category or 
subcategory of the item you wish to edit.

5. Check the box beside each service item that you wish to delete.

6. Click Delete.

7. Click OK.

Order Process

The order workflow process is as follows:

Place Order

When a user with Order <Service Name> permissions for a specific location saves an
order, the Order Notification Email is sent, and the order’s status is set to pending.

See  “Request Services” on page 176 for details on placing an order.

Confirm or Reject a Pending Order

Once an order’s status is pending, a service administrator may confirm or reject the order.

When an order is confirmed, an Order Confirmation Email is sent, and the order’s status is
changed to processing.

When an order is rejected, an Order Rejection Email is sent, and the order is moved to the
archived list.
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Modify an Order

An order is modified when any change is made to the order or the reservation’s start and
end time.

When a pending order is changed, an Order Change Email is sent, and the order status
remains the same.

When a processing order is changed, the order is cancelled and a new order is created.
The Order Cancellation Email is sent, followed by the Order Notification Email, and the
new order’s status is now pending.

Cancel an Order

An order of pending or processing status can be cancelled three ways: the reservation
containing the order can be deleted, the order can be cancelled directly in the
Reservation form, or the selected resource can be changed. In all three circumstances, the
order is cancelled completely. It is therefore moved to the archived list.

Archived Orders

Orders which have been rejected by a service administrator, cancelled by a user, or have
passed their delivery date and time are displayed in the archived orders list. This list can
be viewed in the Manage Orders form.
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Service Order Workflow Matrix

The following is a graphical description of the service order workflow:
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Service Order Use Cases Diagram

The following are the use cases for service orders:
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Pending Orders: View, Confirm, or Reject

Service administrators are responsible to confirm or reject service orders in a timely
manner. 

To view all pending orders and confirm or reject an order:

1. Click the Admin icon.

2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Manage Orders tab.

4. From the List Orders menu, select Pending.

The list of orders whose status is pending displays. To narrow the search, enter the 
order number, room name, item name, and/or the delivery date range and then click 
the Search button.

5. Once you have located the order you wish to confirm or reject, do the following:

• To view the details of the order, click the View Detail button to the right. 

The order displays in a new window. You can print the details by clicking Print 
Order. When you are finished, click Close Window.

• To confirm the order, changing its status to processing, click Confirm.

The server sends the Order Confirmation Email to the user who created the order. 
The order is removed from the pending list and added to the processing list.

• To reject the order, changing its status to archived, click Cancel.

The server sends the Order Rejected Email to the user who created the order. The 
order is removed from the pending list and added to the archived list.

Only orders taking place in the future are displayed in the Pending list. Historical
orders are displayed in the Archived list showing their status as it was at the time the
order was due to be delivered.
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Processing Orders: View or Cancel

Orders which have been confirmed by a service administrator can be viewed in the
Processing list. In the processing stage order details can be viewed and orders can be
cancelled.

To view the list of processing orders:

1. Click the Admin icon.

2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Manage Orders tab.

4. From the List Orders menu, select Processing.

The list of orders whose status is processing displays. To narrow the search, enter the 
order number, room name, item name, and/or the delivery date range and click 
Search.

5. Once you have located the order you wish to view the details of or cancel, do the 
following:

• To view the details of the order, click View Detail.

The order displays in a new window. You can print the details by clicking Print 
Order. When you are finished, click Close Window.

• To cancel the order, changing its status to archived, click Cancel.

The server sends the Order Rejected Email to the user who created the order. The 
order is removed from the processing list and added to the archived list.

Only orders taking place in the future are displayed in the Processing list. Historical
orders are displayed in the Archived list showing their status as it was at the time the
order was due to be delivered.
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Viewing Archived Orders

Service administrators like Juliette can find orders which have been rejected, cancelled, or
have passed their delivery time in the Archived list. This list shows each historical order’s
status as it was at the time the order was due to be delivered.

To view the list of archived orders:

1. Click the Admin icon.

2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the 
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Manage Orders tab.

4. In the List Orders menu, select Archived.

The list of orders whose status is archived displays. You can narrow the search by 
entering the order number, room name, item name, and/or date range and then 
clicking Search.

Once you have located the order you wish to view the details of, click View Detail. The 
order displays in a new window. You can print the details by clicking Print Order. 
When you are finished, click Close Window.

Service Order Email Messages

Service Order Email Message Types

Five types of email notifications can be sent through MRM for reservations which contain
a service order booked with the Services Management module. These are in addition to
the email notifications that are sent by MRM for regular reservations. 
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Each service has its own set of templates for the five service order email messages. These
templates are accessed in each service’s Manage <Service Name> form, on the Email
Messages tab. 

The following is the list of service order emails:

• Order Notification Email

• Order Change Email

• Order Cancellation Email

• Order Confirmed Email

• Order Rejected Email

Each of the service order emails is listed below along with the scenario in which the email
is sent automatically and some tips on setup:

Service Order Notification Email

This email is sent when a user creates a new service order and saves the reservation. 

The intended recipient is the service administrator at the order’s location. To set up the
recipient as intended:

• In this email’s setup, select <Departments of Selected Items> as your value in the To 
field. 

• Use of the form designer to add email addresses by location to each service tab in 
the Reservation form. This directs MRM to the correct email address based on the 
location that the selected room is in. 

See “Adding a tab” on page 87 and “Tab properties” on page 89 for more 
information.

Service Order Cancellation Email

This email is sent when an order has been cancelled.

The intended recipient is the service administrator at the order’s location. To set up the
recipient as intended, follow the same instructions as given above for the Service Order
Notification Email.
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Service Order Change Email

This email is sent when a user makes a change to the items selected, the quantity of the
items selected, or a change in the time or date when an order’s status is pending.

The intended recipient is the service administrator at the order’s location. To set up the
recipient as intended, follow the same instructions as given above for the Service Order
Notification Email.

Service Order Confirmed Email

This email is sent when a service administrator confirms an order, and therefore the
order’s status changes to processing.

The intended recipient is the organizer of the meeting and catering request. To set up this
recipient as intended:

• Use the form designer to add a mandatory field to the Reservation form in which 
the user creating the order must enter his email address. 

• In this email’s setup, select the field that you just created as your value in the ‘To’ 
field.

See “Adding a tab” on page 87 and “Tab properties” on page 89 for more 
information.

Service Order Rejected Email

This email is sent when a service administrator rejects an order.

The intended recipient is the organizer of the meeting and service request. To set up the
recipient as intended, follow the same instructions as given above for the Service Order
Confirmed Email.

Services Management Email Messages Tab

The specifications for each email can be adjusted in the Email Messages tab of each
service’s Manage <Service Name> form.

Adjustments to other email messages not specific to the Services Management module
are made in the Options form. See “Email messages customizations” on page 21 for
details.
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The following descriptions are for the fields used on the Email Messages tab to edit details
of each of the five email message types.

Email Pull-Down Menu

The Email pull-down menu allows you to select which email notification or invitation that
you are editing such as Service Order Notification or Service Order Change. 

The Field Reference Field

The Field Reference field allows you to insert automatic data that is specific to each
meeting. For example, selecting <General/Meeting Title> displays the meeting title for
whichever meeting the email is about. These references can be used in any of the
customizable fields within the Email Messages tab by clicking Insert.

The To Field

The To field allows you enter the email address that will receive this email each time it is
sent by the server. To use multiple addresses, enter a semi-colon (;) between each address.

The CC Field

The CC field allows you enter a second or more email addresses that will receive this email
each time it is sent by the server. To use multiple addresses, enter a semi-colon (;) between
each address.

The Subject Field

The Subject field displays the notification’s subject. It is recommended to use the
<General/Meeting Title> reference field somewhere in the subject.

The Body Field

The Body field represents the body of the message that is sent out. It should be generic
for all types of meetings. Anything specific to a particular meeting should be represented
by a Field Reference such as <Location>. Keep in mind that the service order emails
cannot be adjusted by users at the time they are sent because they are sent automatically
by the server.

Sending Service Order Emails from the Server

All Services Management module notification emails are automatically sent by the server,
and are unseen by MRM users. In order for MRM to send these emails, you must first
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provide Meeting Room Manager with your SMTP server information. To do this, follow the
instructions in  “Configuring the SMTP email server” on page 32.

Once your mail server is configured correctly, the Services Management module
notification emails originate from the SMTP server and appear to come from whatever
reply-to address you have selected, regardless of the user who actually entered/edited
the reservation.

If the SMTP service is not correctly configured, automatically sent emails appear to
be sent by Meeting Room Manager but remain on the email queue of the SMTP server.

In order for emails to be sent correctly, attendee and user email addresses must be
SMTP addresses, not X.400 addresses.
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CHAPTER 8 Reservations

Reservation Grid

The reservation grid displays your organization’s business hours vertically with resources
listed across the top. The purpose of the reservation grid is to display previous and
upcoming meetings. There are four viewing options: Day, Timeline, Week, and Month.

Time and date formats in the reservation grid are based on your browser settings.

Reservation Grid Views

Day View

The day view displays the reservations of resources for a single day with resources across
the top and time blocks down the left side. A heading over the resources indicates which
sublocation each clump of resources belongs to. This heading is based on the
sublocations below the currently selected location in the Location Hierarchy filter. 

Only business hours are displayed in this view, though reservations can be made outside
business hours. Reservations can be created, copied, cut, pasted, and opened in this view.

Timeline View

The timeline view displays the reservations of resources for a single day with time blocks
across the top and resources down the left side, opposite of the day view. Only business
hours are displayed, though reservations can be made outside business hours.
Reservations can be created, copied, cut, pasted, and opened in this view. This view is not
visible by default. To make it visible, see “” on page 28. 
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Week View

The week view displays reservations for an entire seven day week including reservations
scheduled outside of business hours. Because the width size is preset, some reservation
titles may be only partially shown. Hover your mouse over a reservation to view its full
meeting title. 

Month View

The month view displays reservations for an entire month including reservations
scheduled outside of business hours. Because the width size is preset, some reservation
titles may be only partially shown. Hover your mouse over a reservation to view its full
meeting title.

Private meeting support

MRM supports Microsoft Outlook’s Private feature. A private meeting is labeled on the
MRM grid labeled as private along with a key icon. 

The booking can only be opened by the person who created the meeting and those with
permission. All others are blocked from seeing the meeting’s details. The MRM
administrator sets who has permission to view private meetings.

This feature is normally disabled. To enable it, create a new SQL Server setting. 

To create a private meeting, check the Private checkbox on the MRM reservation form.

Enabling or disabling the private meeting feature

1. Open your reservation database with Microsoft SQL Server Enterprise Manager. 

2. Open the Options table.

3. Add the following records:

• In the Setting field, enter: AllowPrivateBooking.

• In the Value field, enter:

• Zero (0) to disable the feature.

• One (1) to enable the feature.
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Setting viewing permission for private meetings

Private meetings can only be viewed by users who have the Confirm Meetings or
Change Others Meetings permissions enabled. See “Assigning location permissions” on
page 60 for more details

1. 1. Select Admin>Security Groups.

The Security Settings-Groups screen appears.

2. Click on the user group you want to give permission to view private meetings.

3. Click the Location Permission tab.

4. In either the Confirm Meetings or Change Others Meetings column, check each 
security group you want to give permission to and click Save.

Creating a private meeting

Private meetings are not supported when working with shared calendars.

1. Open the MRM reservation form.

2. In the Private checkbox, either:

• Check it to make a meeting private. 

• Uncheck it to make it public.

3. Fill out the rest of the form as needed and click Save.

In the grid view, other users will see the word “Private” and when the resource is 
booked. They cannot open it.

When searching, private meetings you do not have rights to see are not displayed.
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Creating a Reservation

Reservations in MRM range from the simplest single resource booking to reservations that
involve multiple resources spanning various locations and recurring at regular or random
intervals.

While this section gives you an overview of creating reservations in Meeting Room
Manager, it is recommended that you also read the following sections in this chapter
which pertain to the kind of reservation you wish to create. 

Reservations can also be created in Microsoft Outlook. For more details, refer to the “The
MRM Plug-In for Microsoft Outlook” chapter.

Simple Reservation Instructions

To create a reservation:

1. Click the Reserve icon.

2. Select the resource you wish to book.

3. Enter details for the reservation.

4. Click Save and Close.

Detailed Reservation Instructions

To create a reservation:

1. Click:

• The Reserve icon.

• An empty space in the Day or Timeline views.

• Add in the Week or Month views.

2. Enter the basic reservation information, such as start and end time, and prep and 
cleanup time.
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3. Check the box(es) beside the resource(s) that you wish to select for this reservation.

Tabs in which reservation details can be entered are displayed.

See “Multiple Resource Reservations” on page 171 for helpful information about 
multiple resource reservations.

4. Enter the details into the available fields. Click on a tab to reveal the fields on it.

By default, only the Meeting Title field must be filled in. Other fields may be 
required as well, depending upon the customizations made using the form designer.

Different tabs may be available depending upon the resource you select. 
Because tab availability is based on the resource’s location. Administrators can change 
which tabs are available for each location by following the instructions in “Setting 
reservation form tabs by location” on page 115.

5. Click Save and Close.

If your reservation conflicts with an existing reservation, it can either be saved as 
a wait list entry or adjusted and saved. See “Meeting Conflict Resolution” on page 178 
for details.

6. Click Yes to send a notification email.

You may adjust the email and click Send unless emails are sent from the server. For 
details, see  “Sending emails from the web server” on page 33.

To adjust email templates, see “Email messages customizations” on page 21.
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Adding a logo to a reservation display

You can add your organization or visitor logo to the reservation details field on an LCD
touch-screen panel. Your MRM administrator should tell you what logos are available and
where they are stored on the network.

To add a logo:

1. Open the Reservations Details form and schedule the reservation.

Your MRM administrator must have added a “Meeting Logo” link on the form. 
The exact name is chosen by the administrator.

2. Click on the link.

3. Browse to where the logo is located and double-click on it.
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4. On the Reservation Details form, click Save and Close.

The logo is added to the LCD panel’s Reservation Details field.

Setting Recurrences

You may set reservations to recur at any interval. Check the recurrence box in the
meeting’s Reservation form to do this. In the Set Recurrence form that opens, make your
selection:

You cannot add new bookings into an already existing series without loosing any
exceptions in the series. For example if all meetings are 2pm but one is at 3pm, adding a
new booking causes the 3pm meeting to be lost.

You can modify individual bookings in a series at any time, but you cannot make
changes to the series on a global basis. For example you can move a meeting from 2pm to
3pm, but you cannot move all of the meetings at once. Each booking must be changed
one at a time.

Daily

Every [1] Day(s)

Change the number to specify the frequency of the occurrence. Select or unselect the
Include Weekends checkbox.

Weekly

Every [1] Week(s) on [Sunday]

Change the number to specify the frequency. Select the day(s) of the week for the
recurrence.

Monthly

Day [1] of every [1] Month(s) OR The [first] [Sunday] of every [1] Month(s) 

Two examples are the seventeenth day of every one month or the first Monday of every
two months. Change the fields as appropriate.
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Yearly

Every [October 17]

To select a new date, either enter it in manually or select one from the pop-up calendar by
selecting the pull-down menu.

Daily / Weekly / Monthly / Yearly Details

At the bottom of the Meeting Recurrence form are two fields. Either enter the number of
occurrences or the date at which the occurrences are to end.

Next button

On the Daily, Weekly, Monthly, and Yearly tabs, there is a Next button. Clicking this button
selects the choices you have set in the tab are in and opens the Random tab where your
chosen dates are displayed. You are then able to specify further exactly which dates you
would like the course to occur on.

Random

Select any dates from the calendar on the left. Selected dates are displayed in the box to
the right. Clicking a displayed date removes it from the list.

Resolving booking conflicts

If someone else has already booked a resource you requested for your series, a screen
appears showing the conflict(s). 

Conflict resolution does not support the wait list or priority reservations.

To resolve a conflict:

• To book a different resource at the same time, click on the original resource name or 
the X icon. A list of resources available at that date and time appears. Click on an 
item to book it and click OK.

If you click OK without resolving the conflict(s), the conflicted meetings are 
skipped, are not saved in the database and will not appear in the calendar. 

• To book the same resource at a different time, first save the booking to a different 
resource. After saving, re-open it and re-book the meeting into the original 
resource, but at a different time and any other changes as needed.
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Finding Available Resources

It is often helpful to be able to search for meetings rooms that are not only available for
your meeting and its recurrences, but that also match your requirements.

To find available resources:

1. Ensure that the date and time fields for your reservation have been filled in. If you 
intend to create recurrences for the meeting, enter recurrence information as well.

2. Click the Find Available Resources icon in the Reservation form.

3. The Find Resources form opens. Enter your requirements and click Find.

The default location displayed in the Find Resources form is the location selected 
in the Locations Hierarchy on left side of the main screen.

4. If unsatisfied with the results, adjust your criteria and click Find to perform a new 
search. If you are creating a single reservation with no recurrences, you may also 
adjust the meeting start and meeting end information.

Adjusting the meeting start and meeting end information should not be done in 
the search form for recurring meetings.

5. Check the checkbox to the left of the resource(s) that you wish to reserve and click 
Select.

6. The resource(s) you selected in the search form are now selected in the Reservation 
form.

Multiple Resource Reservations

A multiple resource reservation is a reservation for which more than one resource or room
is booked. Any grouping of resources can be selected for a single reservation, regardless
of the resource’s location or resource type. To make your reservation a multiple resource
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reservation, simply check the box next to the various resources you wish to book in the
Reservation form.

While each resource’s occurrence is part of the original reservation, each resources’
occurrence can be opened and modified separately from the others or the original
reservation as a whole can be opened and modified at one time.

Each resource’s occurrence of the reservation always displays separately in the
Meeting Confirmation form. 

Each time a reservation is saved, even when resources spanning multiple time zones are
selected, the time of the meeting is based on the time that the meeting will occur for the
user booking the reservation. This information is taken from the user’s current
MyLocation setting. Therefore, it is extremely important that each user always has a
location in his time zone selected for his MyLocation setting.

Tabs by Resource

When you choose to reserve multiple resources in one booking, MRM allows you to keep
reservations the same or unique for each resource. To allow for this, the Reservation form
has been designed with two rows of tabs across the middle of the form, above the
reservation details. 

The upper row of tabs contains each resource selected in the current booking. The lower
row contains the reservation details and requirements tabs. When a resource name on
one of the upper tabs is clicked, the lower portion of the form refreshes to show the
reservation details tabs that are available for this resource.

This design allows you to make reservation details unique for each selected resource. If
you prefer that the details be the same for all resources, you can use the Update One and
Update All buttons:

• Update One: click this button to copy the selected tab's details from the current 
resource to all other selected resources.

• Update All: click this button to copy the current resource's details from all tabs onto 
the corresponding tabs of the other selected resources.

The list of attendees is the exception. Its information is always the same for all
resources involved in a multiple resource reservation. 
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Because the services and service items available may vary by location, service tabs’
details cannot be copied. If you require a service order for each resource involved in your
reservation, a separate order must be placed for each resource.

The reservation’s basic details located above the tabs on the form, such as date and
time of the meeting, remain the same. 

Editing a Multiple Resource Reservation

1. Click on the title of the reservation you wish to edit.

This can be done either from the reservation grid or the meeting search form.

2. When prompted, select which option you wish to perform:

• Open Single Reservation: Selecting this option limits the changes you make to 
affect this resource only.

• Open Multiple Resource: Selecting this option allows you to make changes to the 
details belonging to any of the resources involved in this booking

3. In the Reservation form, make changes as required.

4. If the Open Multiple Resource option was selected, the Update One and Update All 
buttons are available.

• Update One: Click this button to copy the details on this tab onto the 
corresponding tabs for all other selected resources.

• Update All: Click this button to make all reservation details on all tabs the same, 
matching the currently selected resource.

5. Once you are satisfied with the changes, click Save and Close to save the reservation 
and return to the reservation grid.

Preparation and Cleanup Time

Time may be scheduled outside of the reservation to allow for preparation of the meeting
room as well as cleanup after the meeting is finished. This time is shown on the grid as a
dark green bar above and/or below your meeting.
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You may wish to use prep and cleanup time if you need fifteen minutes to set up a
presentation or ten minutes to allow catering staff time to clean up after a lunch.

The default time is set in the reservation database options. To change these settings, see
“Setting the default business hours” on page 17.

Locked Tabs

There are two different types of locking tabs: Locked, and Lock After Save. These settings
affect everyone who does not have the Modify Locked Tabs permissions enabled.

Locked

A locked tab can be viewed but not modified. Some organizations lock the Invoice tab, for
example.

Lock After Save

A lock after save tab locks once the reservation has been created and Save and Close has
been selected in the Reservation form. At that time, users can no longer edit the details on
the tab.

The only tab that is locked by default is the Invoice tab.

Administrators with the Modify Locked Tabs permission enabled can modify any tab,
even if it is locked.

Invoice Tab

Invoice Tab Overview

The invoice tab allows organizations to keep track of billings for meetings based on the
cost of selected requirements. It is auto-populated with selected requirements and their
quantities. Only items selected from a tab whose Has Req property is True are pulled as
invoiced items on the Invoice tab. 
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In order for the invoice tab to become available to any users, it must be enabled by a
global administrator like Kate. To do this, follow the instructions in the “Setting
reservation form tabs by location” on page 115.

The invoice tab is a locked tab by default, which means that only users who have the
Modify Locked Tabs permission enabled may modify the dollar value for any items listed.
This allows administrators to assign set dollar amounts for the rental of equipment and
the provision of services. When dollar amounts are adjusted, the invoice tab does not
display adjusted totals until it is refreshed. To refresh the tab, move to another tab, then
back to the invoice tab.

The Bill To and Ship To fields can also be modified by users with Modify Locked Tabs
permissions.

No user can modify item quantities in the invoice tab, because they are controlled by the
quantity specified in the corresponding number field. In the case where a checkbox
indicates selection of an item, only the quantity 1 can be used.

Auto-Populate Invoice Number

The invoice tab can be set up in such a way that the Invoice # field is auto-populated in
numeric sequence. 

1. Open the Reservation form.

2. Click the Form Designer checkbox.

3. Click OK.

4. In the Form Designer Toolbox, select the Field tab.

You are now working in Form Design Mode. 

5. Select the Invoice tab.

6. In the Form Designer Toolbox, select the Invoice # field. 

7. In the Default property, enter the value <Next invoice #>.

8. Click Apply Changes.
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Assigning Cell & Font Colors

In addition to the standard confirmed and unconfirmed colors, additional cell and font
colors can be assigned. Color codes can be created for different types of meetings. For
example, management meetings could be green and new hire orientation could be
orange. These colors are defined in options. For more details about customization, see
“Color-coding reservations” on page 18.

If color customization has been implemented, a color is automatically assigned to a
meeting based on the meeting’s reservation type. When a meeting has a reservation type
assigned to it, the reservation type’s corresponding color overrides any changes made to
the Assign Color setting within the meeting’s Reservation form.

To change the cell and font colors of a meeting without a reservation type assigned:

1. Click on the meeting’s title to open the corresponding Reservation form.

2. The Reservation form opens. Select Assign Color.

3. The Assign Color form opens. Click on the desired cell or font color and click OK.

Request Services

The Services Management module in MRM enables administrators to integrate services
into the reservation process. These services can be anything that your organization offers
in conjunction with reservations, such as catering and presentation equipment.

For an in-depth summary of the capabilities of the Services Management module, set-up
instructions, and a description of the order process, see “Services Management Module”
on page 135. It is recommended that administrators read the chapter and fully
understand the module before enabling users with the permissions to create service
requests.

Once your organization’s services have been set up in MRM, service items can be
requested within the resource reservation.
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To request services:

1. Create your reservation and enter basic information, such as meeting title, start and 
end time, and prep and cleanup time.

2. Select the Services tab of your choice.

For example, you may choose the Catering tab if it is available.

3. Click the name of the category and then the subcategory that the service item you 
wish to request is located in. 

The list of service items in the selected subcategory displays.

4. Hover your mouse over the service item you are considering ordering. A brief 
description and dollar amount display.

To select this item, click on it. The tab refreshes and adds the item to your order on the 
right side of the tab and displays your order’s new total cost.

5. To adjust the quantity of the item you have selected, highlight the current quantity, 
type in the number you wish to order, and then click Refresh Grid.

6. The delivery time for each item defaults to the meeting’s start time but can be 
adjusted. Click the Time field and alter the delivery time for each item as necessary.

7. Repeat steps 3 through 6 for each item you wish to select.

8. Click Save and Close to save your reservation and place your service order.

If your reservation is recurring, the order is duplicated for each recurrence. If the 
entire reservation series is altered, each catering order is altered accordingly. If one 
occurrence in the series is altered, only its catering order is altered accordingly.

Priority Reservations

If a reservation is created by a user with priority rights, that reservation is considered a
priority reservation. It cannot be overridden, or bumped to the wait list, by anyone.

Users with priority rights can create reservations in spaces already reserved by regular
users. When a priority user sees an existing reservation on the Day view in a space he
would like, he can hover over the reservation and select the Override button.
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This opens a blank Reservation form in which his reservation’s details can be entered.
When he clicks save, the option to override the conflicting reservation is given.

Once a regular reservation has been overridden by a priority reservation it is moved to the
front of the wait list. 

Before users with priority rights can override existing regular reservations, the
priority rights feature set must be enabled in project options. The wait list feature set is
automatically enabled along with it.

Meeting Conflict Resolution

If the reservation you are trying to save conflicts with an existing reservation, you receive
a conflict message to indicate that your reservation cannot be saved. This conflict
message is different for single reservations and recurring reservations.

Single Reservations

If you are trying to schedule a single reservation and you encounter a conflict, Meeting
Room Manager will prompt you with a message that reads similarly to this one:

“Cannot Save. This meeting overlaps with meeting:

Executive Meeting 12/5/2005 9:00:00 AM ~ 12/5/2005 10:00:00 AM”

Three options become available:

Override. Click this button to create a priority reservation and bump the conflicting 
reservation to the wait list. This option is only available to users with priority rights if 
the conflicting reservation was created by a user without priority rights.

Wait List Request. Click this button to create a wait list entry. All of the details you 
have entered in the Reservation form are held in the wait list. If the space becomes 
available, your wait list entry is automatically moved to fill the reservation space you 
desire.

Cancel. Click this button to cancel the saving process and return to the Reservation 
form. From there you can make the appropriate changes to avoid the conflict. You 
may wish to change the resource, time, or date of your meeting. The Find Available 
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Resource icon can be used to find an available room if the date and time of your 
meeting must remain the same.

Recurring Reservations

If you are trying to schedule a recurring reservation and you encounter one or more
conflicts, MRM prompts you with a report of exactly which recurrences conflict with
existing meetings. The message reads similarly to this one:

“Conflicts Found.

The following meetings are conflicting with occurrences of the recurring meeting you are
attempting to create:

Resource                          Meeting Title          Start Time                     End Time

Executive Boardroom    Executive Meeting  12/5/2005 9:00:00 AM~12/5/2005 9:30:00 AM

Pacific Room                    Client Meeting        12/5/2005 9:00:00 AM~12/5/2005 9:30:00 AM

Do you wish to skip the occurrences that are conflicting?”

You can now make note of the conflicting reservations and click the Skip button to skip
the occurrences that conflict with the listed meetings or click the Cancel button to return
to the Reservation form and make the appropriate changes. The following are some
recommendations as to which scenarios work best for each of these two options:

Skip

• If you wish to keep the reservation at the same time and date but wish to change the 
room in which the meeting is held. Ensure that you take note of the conflicting 
occurrences, skip them, and then create new meetings for these times in an available 
room.

• If you do not wish to hold the meetings at all if they conflict with another meeting.

Cancel

• If you wish to change the time of all recurrences in order to avoid the conflicts.

• If you wish to change the dates of some recurrences in order to avoid conflicts.
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Creating a Wait List Entry

Wait list entries can be created two ways:

• When a user tries to save a reservation that conflicts with one or more reservations, 
a prompt provides the option to save the reservation as a wait list request.

• If a user sees an existing reservation on the Day view in a space he would like, he can 
hover over the reservation and select the Wait List Entry button.

Before users can create wait list entries, the Wait List feature set must be enabled in
project options.

Time Period Blocking

In order to block off days for which your resources are not available, such as holidays,
simply create a recurring all day meeting for all of your resources.

To block off time periods:

1. Click the Reservation icon.

2. Click the All Day Event checkbox.

3. Click the Recurrence checkbox.

Select recurrences as indicated in “Recurring Reservations” on page 179.

4. Click Find Available Resources. 

5. Perform a search according to the required criterion. Click Find, then select the 
checkbox beside each resource you wish to block off, and click Select.

To ensure that no resources are booked for the holidays you are blocking off, do 
your search based on ‘%’ in one field while all other fields, including auto-filled fields 
such as Meeting Start and Meeting End, are blank. This allows you to select all 
resources, and upon saving, see which resources are already scheduled for the 
holiday.
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6. Give your reservation a meeting title, such as Closed for Holiday.

7. Click Save and Close.

If conflicts are present, you are prompted with details of the existing reservations 
which conflict with the reservation you are currently scheduling.

Opening a Reservation Form

To open a reservation’s detail form, click on the reservation either from the grid or from a
search results list.

If the reservation you wish to open is part of a recurring series or a multiple-resource
reservation, select the appropriate option from the list when prompted:

• Open Single Reservations

• Open Series

• Open Multiple Resource

• Open Multiple Resource and Series

Editing Reservation Details

Reservations can be edited at any time.

1. Click on the reservation you wish to edit either from the grid or the results of a 
reservation search.

2. If the reservation you wish to edit is part of a recurring series or a multiple-resource 
reservation, select the appropriate option from the list when prompted:

• Open Single Reservation

This opens the single instance that you have clicked on. Even if this reservation 
belongs to a series or a multiple resource reservation, only the selected instance is 
opened.

• Open Series

This opens all instances of this recurring reservation. Even if the reservation is also a 
multiple resource reservation, only the recurrences that apply to the selected 
instance’s resource are opened.
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• Open Multiple Resource

This opens the selected instance for all resources involved in the multiple resource 
reservation. Even if the reservation is also a recurring reservation, only the selected 
instance is opened for the multiple resources involved.

• Open Multiple Resource and Series

This opens all instances for all resources involved in this reservation.

3. Edit the details on the form as required.

4. When you are satisfied with your specifications, click Save and Close to save your 
changes and schedule the reservation.

5. Depending upon your database’s options settings and the details you have added or 
edited, you may be prompted to send a notification email to attendees or the head of 
a requirements department.

Click Yes when prompted, and send the email to the address that MRM automatically 
entered.

If emails are sent from the server, your email client will not open and allow you to 
customize the notification. For information on sending emails from the server, see 
“Sending emails from the web server” on page 33.

Editing Scenarios Which Affect Service Orders

While reservations which contain service orders can be edited in the same ways as
reservations without service orders, some edits affect service orders. The following is a list
of the editing scenarios which affect service orders and their results:

Edit a Service Order: If the service order has already been confirmed by a service
administrator like Juliette, its status is Processing. When it is modified, its status is
changed to Pending and it requires a service administrator's confirmation once again. If
the service order is still Pending when it is modified, the order is simply updated in the
system.

Add a Resource: When you add a resource to a reservation which contains one other
resource with service order(s), you are prompted to copy the service order(s) or cancel. If
you cancel, the service order(s) are not copied. 
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When you add a resource to a reservation which contains multiple other resources, you
are prompted to copy the current resource's service order(s) or cancel. The current
resource is the one who's tab is currently selected.

Copy / Cut / Paste to a New Resource: When you cut / copy / paste a reservation from
one resource to another in the reservation grid, you are prompted to copy the original
resource's order(s) or cancel.

All Scenarios: When an order is copied to a new resource, not all items may be available
or priced the same. Items which fall into either category are not included in the copied
order. If these cases occur, a prompt displays recommending that you check the copied
order.

Copying a Reservation

1. Hold the mouse over the reservation you wish to copy. Select Copy.

2. Move your mouse to the time, date, and room title on the grid where the copied 
reservation should be placed. Click on this space.

Recurring reservations are copied / pasted as a single non-recurring reservation. 

Multiple resource reservations are copy / pasted as single, not multiple-resource 
reservations. For more information about multiple resource reservations, see “Multiple 
Resource Reservations” on page 171.

If the pasted reservation contains service orders, you are prompted to click OK to 
copy them to the new resource or click Cancel to ignore them. If items in the order(s) 
are not available in the new resource or their price is different, you are prompted that 
the order(s) were not entirely copied. You are given the choice to review the order 
(open the Reservation form) by clicking OK or to ignore the difference by clicking 
Cancel.

3. To make changes to the pasted reservation and send notifications, simply click on the 
newly pasted meeting to open the corresponding Reservation form.

4. When you are satisfied with your specifications, click Save and Close to save your 
changes and schedule the reservation.
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5. Depending upon your database’s options settings and the details you have added or 
edited, you may be prompted to send a notification email to attendees or the head of 
a requirements department.

Click Yes and send the email to the address that MRM automatically enters for you.

Your email client will not open to allow you to customize the notification if emails 
are sent from the server. For information on sending emails from the server, see 
“Sending emails from the web server” on page 33.

Cutting and Pasting a Reservation

1. Hold the mouse over the reservation you wish to cut and paste. 

2. A menu appears. Select Cut.

3. Move your mouse to the time, date, and room title on the grid where the cut 
reservation should be placed. Click on the space to paste the reservation.

Recurring reservations are cut / pasted as a single non-recurring reservation; only 
the occurrence selected is changed.

Multiple resource reservations are cut / pasted as single reservations. Only the 
selected reservation is updated. If you wish to update all reservations involved in a 
multi-resource reservation, do not use the cut / paste feature. Instead, follow the 
instructions provided in “Multiple Resource Reservations” on page 171.

If the pasted reservation contains service orders, you are prompted to click OK to 
copy them to the new resource or click Cancel to ignore them. If items in the order(s) 
are not available in the new resource or their price is different, you are prompted that 
the order(s) were not entirely copied. You are given the choice to review the order 
(open the Reservation form) by clicking OK or to ignore the difference by clicking 
Cancel.

4. To make changes to the pasted reservation and send notifications, simply click on the 
newly pasted meeting to open the corresponding Reservation form.
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5. When you are satisfied with your specifications, click Save and Close to save your 
changes and schedule the reservation.

6. Depending upon your database’s options settings and the details you have added or 
edited, you may be prompted to send a notification email to attendees or the head of 
a requirements department.

Click Yes when prompted, and send the email to the address that MRM automatically 
enters for you.

If emails are sent from the server, your email client will not open and allow you to 
customize the notification. For information on sending emails from the server, see 
“Sending emails from the web server” on page 33.

Delegating a Reservation

In MRM, reservations can be delegated to a user who may act on the behalf of the
reservation’s organizer. When acting as a delegate, this user is granted the permissions of
the meeting’s organizer.

In the Reservation form, you can assign a delegate for the specific reservation. If many
reservations are involved, delegates can be assigned directly to a username. This
automatically makes the user a delegate for the organizer’s reservations during the
designated time period. Because delegate settings in the Reservation form supersede all
other settings, it is possible to remove the delegate from a specific reservation as
required.

To add a delegate to your username, see “Editing your user profile” on page 74. 

Administrators like Kate may add a delegate to a username. See “Usernames” on page 67.

To delegate a specific reservation to another user:

1. Open the reservation.

2. Select the Delegates tab and click Add New Delegate.
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3. The Delegate User List opens. Navigate to the user you are selecting as your 
delegate.

By default, the Delegate User List displays entries whose first names begin with 
the letter A. To display entries beginning with other letters of the alphabet, use the 
letters across the top of the form. To display all entries, click the All Users tab.

4. Click the box next to the user you wish to delegate this meeting to. and click Add 
User. The selected user is added to the reservation’s list of delegates.

If you wish to remove the delegate, click Remove next to the delegate’s username.

5. Click Save and Close to save your changes.

Deleting a Reservation

Deleting a reservation is permanent.

1. Click on the reservation you wish to delete either from the grid or the results of a 
reservation search.

2. If the reservation you wish to delete is part of a recurring series or a multiple-resource 
reservation, select the appropriate option from the list when prompted:

• Open Single Reservation

This opens the single instance that you have clicked on. Even if this reservation 
belongs to a series or a multiple resource reservation, only the selected instance is 
opened.

• Open Series

This opens all instances of this recurring reservation. Even if the reservation is also a 
multiple resource reservation, only the recurrences that apply to the selected 
instance’s resource are opened.

• Open Multiple Resource

This opens the selected instance for all resources involved in the multiple resource 
reservation. Even if the reservation is also a recurring reservation, only the selected 
instance is opened for the multiple resources involved.

• Open Multiple Resource and Series
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This opens all instances for all resources involved in this reservation.

3. The Reservation form opens. Click Delete.

4. If the reservation you wish to delete is part of a recurring series or a multiple-resource 
reservation, select the appropriate option from the list again when prompted:

• Delete Reservation (same as ‘Single Reservation’)

This applies to the single instance that you have open at the moment. It applies to 
this instance of the recurrences if there are any, and this resource only, even if the 
reservation is for multiple resources.

• Delete Series

This applies to all instances of the recurring reservation. If the reservation is a 
multiple resource recurring reservation, it does not apply to instances of this 
recurring reservation which belong to another resource.

• Delete All (related reservations)

This applies to all instances of this recurring multiple resource reservation. It applies 
to all recurrences that belong to all resources for this reservation.

5. Click OK.

6. Depending upon your database’s options settings and the details that were included 
in the reservation you deleted, you may be prompted to send a notification email to 
attendees or the head of a requirements department.

Click Yes and send the email to the address that MRM automatically enters for you.

If emails are sent from the server, your email client will not open and allow you to 
customize the notification.
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CHAPTER 9 Attendees

Attendees Overview

The Attendees tab of the Reservation form in MRM allows users to add attendees to their
meetings. Attendees can be added manually or from the MRM Address Book, Outlook
Address Book, or Lotus Notes Address Book. In addition to adding attendees to your
reservations, you can also send emails containing reservation details and Outlook
Invitations from this tab.

Integration with Outlook

MRM lets users to utilize some of the features in Microsoft Outlook  to communicate with
attendees. 

• The Outlook Address Book can be utilized to select attendees for meetings.

See “Outlook Address Book” on page 191.

• Outlook Invitations can be sent to notify attendees of a meeting.

See “Outlook Invitations” on page 192.

• Attendee Availability can be checked for those attendees sharing your exchange 
server.

See the “Outlook Invitations” on page 192.

• The Meeting Change Email and Cancellation Email each contain a link which, when 
clicked by the recipient, automatically updates the recipient’s Outlook calendar.
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When users modify or cancel a reservation, they are automatically prompted to 
send these notification emails. The links which update the recipient’s Outlook 
calendar can be removed by modifying the email templates. See “Email messages 
customizations” on page 21 for details.

Reservations can be created, edited, and deleted using Microsoft Outlook. See“The
MRM Plug-In for Microsoft Outlook” on page 197 for details.

MRM Address Book

The MRM Address Book is the address book feature that can be used if a MAPI compliant
email program other than Outlook or Lotus Notes is installed, or if no address book
currently exists. It is hosted by the MRM server, so this book can be accessed by any user
even if they do not have an email system installed on the workstation they are using.

Modifying the MRM Address Book

It is recommended that when you are editing the MRM Address Book that you do so
from a blank Reservation form.

To add or edit entries manually in the MRM Address book:

1. In the Reservation form on the Attendees tab, click the MRM Addr icon.

The MRM Address Book opens.

By default, the MRM Address Book displays entries whose first names begin with 
the letter A. Use the letters across the top of the form to display entries beginning with 
other letters of the alphabet.

2. To:

• Add a new contact, click New Entry.

• To edit an existing contact, click Edit.

3. The Address Detail form opens. Enter or change contact details on the General, 
Personal, and Notes tabs as required.

4. Click Save and Close.
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Deleting an MRM Address Book Contact

1. In the Reservation form on the Attendees tab, click the MRM Addr icon.

The MRM Address Book opens.

By default, the MRM Address Book displays entries whose first names begin with 
the letter A. Use the letters across the top of the form to display entries beginning with 
other letters of the alphabet.

2. Click Delete beside the information of the contact you wish to delete.

3. Click OK.

Selecting Attendees from the MRM Address Book

1. In the Reservation form on the Attendees tab, click the MRM Addr icon.

The MRM Address Book form opens.

By default, the MRM Address Book displays entries whose first names begin with the 
letter A. Use the letters across the top of the form to display entries beginning with 
other letters of the alphabet.

2. Enter a name or partial name into the search field and click Search to find all 
matching entries.

3. Click on a contact's name to add the individual to the attendee list.

4. Click Close in the MRM Address Book when complete.

Outlook Address Book

MRM enables you to add attendees to your reservation directly from your local and global
Outlook address book lists. 

The instructions in this section are based on Microsoft Outlook 2003. If you are using
other versions of Outlook, your steps may vary. 

To select attendees from your Outlook Address Book:

1. In the Reservation form on the Attendees tab, click the Addr Book icon.
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2. When prompted to allow an ActiveX control to run, select Yes. If a Microsoft Outlook 
security prompt appears, ensure 'Allow access for…' is checked, and click Yes.

If you receive the prompt that states “ActiveX component can't create object,” you 
must adjust your ActiveX settings before proceeding. See “ActiveX Control Setup for 
Outlook” on page 194 for details.

3. In the Outlook Distribution List, click Select Members.

4. Select the contact list you wish to invite from, highlight the individual you wish to 
invite, and then click Members. 

5. Repeat for each individual you wish to invite, then click OK.

6. Click Save and Close. 

Back in MRM, the individuals you selected are displayed in the list of attendees.

Outlook Invitations

MRM can send an Outlook Invitation to attendees. This invitation, when accepted by the
recipient, is automatically booked into the recipient's Outlook calendar. In addition, if the
computer you are using is connected to a network running Microsoft Exchange Server,
you can view attendee availability in the Scheduling tab of the Outlook Invitation.

Preparing MRM to Send Outlook Invitations

The save rule which controls Outlook Invitations must be turned on in MRM before users
can send invitations through MRM.

To turn on the invitations save rule:

1. Log into your MRM database as a user with administrative permissions

2. Click the Admin icon.

3. Select the Save Rules icon.

4. The save rules summary opens. Click the Invitation Check save rule.

5. The Invitation Check save rule’s detail form opens, displaying the rule’s properties. 
Check the Active checkbox.
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6. Click OK. 

7. Close the list of save rules. The rule is now active.

Now that you have completed this setup process, whenever a user saves a meeting with
attendees, he will be prompted to send an Outlook Invitation.

Check Attendee Availability and Send an Outlook Invitation

1. Once you have selected attendees and saved your reservation, you are prompted to 
send an Outlook Invitation. Click Yes.

2. When prompted to allow an ActiveX control to run, select Yes. If a Microsoft Outlook 
security prompt appears, ensure 'Allow access for…' is checked, and click Yes.

If you receive the prompt that states “ActiveX component can't create object,” you 
must adjust your ActiveX settings before proceeding. See “ActiveX Control Setup for 
Outlook” on page 194 for details.

3. The Outlook Invitation opens. 

Information for the meeting is included where appropriate, along with a summary of 
the meeting details in the body of the invitation. 

The specifications for the Outlook Invitation including the subject and content 
are all set in the Options Email Messages tab.

Additional attendees can be added to the meeting by adding their email 
addresses to the Outlook Invitation. MRM automatically adds any added email 
addresses to the list of attendees on the Attendees Tab of your reservation.

4. Attendee availability can be viewed by selecting the Scheduling tab.

This information is only available through Microsoft Exchange Server, and is not a 
function of MRM.
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5. Turn the Outlook iCalendar feature off by clicking Tools > Options, and then 
unchecking the Send as iCalendar checkbox. 

Turning off the iCalendar default is necessary specifically for Outlook versions 
2002 (XP) and 2003 where use of the iCalendar is set to On by default.

To turn off the default setting which sends invitations as iCalendars, select Tools 
> Options in Outlook. On the Preferences tab, click Calendar Options. A dialog box 
opens. In the Advanced Options section, uncheck the When sending meeting 
requests over the Internet, use iCalendar format option.

6. The Outlook Invitation is sent by clicking Send.

If a Microsoft Outlook security prompt appears, ensure ‘Allow access for…’ is checked, 
and click Yes.

ActiveX Control Setup for Outlook

While attempting to access your Outlook Address Book from MRM, if your workstation's
ActiveX security control setting called “Initialize and Script ActiveX controls not marked as
safe” is set to Disable, you receive the VB Script error as follows:

“ActiveX component can't create object.”

To open your Outlook Address Book from intranet sites that you deem safe on a per-

use base:

1. Select Tools > Internet Options.

2. On the Security tab, with Local Intranet selected, click Custom Level. 

3. Scroll down to the ActiveX controls and plug-ins heading, and underneath the 
security control setting called Initialize Script ActiveX controls not marked as safe, 
select Prompt. 

Notes Address Book

The Lotus Notes Address book can be used to enter attendees into a reservation.
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To select attendees from the Lotus Notes Address Book:

1. In the Reservation form on the Attendee tab, select the Lotus Notes icon.

The Lotus Notes Address Book opens.

2. Click on a contact's name to add the individual to the attendee list.

3. Click Close in the Lotus Notes Address Book when complete.



Chapter 9  |  Attendees

196



                                  197

CHAPTER 10 The MRM Plug-In for 
Microsoft Outlook

Overview of the MRM plug-in for Microsoft Outlook

MRM Enterprise Edition comes with a plug-in that enables you to schedule the resources
and services managed by MRM inside of Microsoft Outlook. This combines the strengths
of MRM and Outlook:

• MRM provides location and resource information, service item catalogues, and the 
ability to check room availability and enforce inventory checking and security.

• Outlook provides the ability to create and send Outlook Invitations and examine 
attendee availability for those who share an Exchange server.
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The MRM plug-in adds the MRM Reservation form to Outlook. It contains the standard
Outlook Appointment and Scheduling tabs along with a new tab called Meeting Room
Manager. This tab schedules in Outlook resources and services managed in MRM.

If you wish to create an appointment that does not need resources and services managed
by MRM, the MRM Reservation form works exactly like the standard Outlook
Appointment form.

Working with MRM reservations in the plug-in is different than working with them in
MRM web. 
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• In MRM Web, you can see all of the bookings created by users in MRM at that 
location in addition to editing and deleting them if you have been granted that 
permission.

• In the MRM plug-in for Microsoft Outlook, you can only see, edit and delete 
bookings made in your own calendar. To edit other user’s meetings in the plug-in, 
you must open their calendar as shared calendars in your Outlook. The plug-in must 
be set up to share calendars between users as described in “Delegating meetings 
with the MRM plug-in” on page 220.

When working in MRM web, and you try to open a reservation created in the plug-
in, you see a pop up saying this meeting was created in the plug-in and you cannot 
edit it. You can only view the meeting details.

Installing the MRM plug-in

Choose the distribution method

Install the MRM plug-in on each workstation where Outlook will be used to schedule MRM
resources and services.

There are two ways to distribute the MRM plug-in to users:

• Automated Distribution: Administrators distribute the plug-in using Group Policy. 
See “Automated distribution of the plug-in using group policy” on page 200.

• Manual Distribution: Administrators or users with administrative rights on their 
workstations run the MRM plug-in setup file manually on each client machine. See 
“Manual distribution of the plug-in” on page 203.

You can use the automated method for machines on the domain and manually install it
on machines that aren’t.

Install it on all machines if the users share calendars between themselves (such as a
delegate situation). If someone without the plug-in edits the bookings of someone who
has it, data can become unsynchronized between the users and the database.
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The first time Outlook is started, the user is prompted to enter the MRM URL and their user
name and choose if they want the plug-in to be their default Outlook appointment form.
See “First Outlook start up after plug-in installation” on page 205. 

Once installed and set up it can be used by any user logged in to the machine.

Automated distribution of the plug-in using group policy

Group policy automatically distributes the MRM plug-in to all computers on your domain,
saving you the task of manual installations. Once group policy is set up, the MRM plug-in
installs silently on client machines when users restart them.

Group Policy distribution can only be used with servers running Windows 2003
Server with Active Directory in place.

The workflow for setting up group policy is:

• Step 1: Create the distribution point.

• Step 2: Create the group policy object.

• Step 3: Assign the package to the computers on your domain.

Once group policy is set up, the next time a selected user logs in to a computer, the MRM
plug-in is installed. The installation is finalized the next time a user runs Microsoft
Outlook.

Step 1: Creating the MRM plug-in’s distribution point

1. Log in to the server with a user name which has administrative rights.

2. Create a folder to hold the MRM plug-in installation file in.

This folder must be on your shared network.

3. Set permissions on your shared network to allow all users to access this folder.

4. Log into MRM.
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5. Click Edit User Profile.

The User Details form appears. 

6. Click Download MRM Plug-In for Outlook.

7. Click Save.

The Save As dialog box opens. 

8. Save the MRMOutlook.msi file to the folder created in step 2.

This file path is the distribution point. An example is: \\my server name\share folder 
name\MRMOutlook.msi.

Step 2: Create the group policy object

Assign the distribution to users in specific user groups. This is done by creating a group
policy object.

To create a group policy object:

1. Log in to the server with a user name which has administrative rights.

2. Select Start>All Programs>Administrative Tools>Active Directory Users and 

Computers. 

The Active Directory Users and Computers window appears.
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3. In the hierarchy on the left side of the screen, navigate to your domain. 

4. Right-click on the domain and select Properties.

The Properties form appears. 

5. Click the Group Policy tab.

6. Highlight Microsoft Outlook and click New.

7. Enter MRMOutlook as the name for this new policy and click Enter.

8. Select Microsoft Outlook.

9. Click Properties and then click the Security tab.

By default, the group policy applies to all authenticated users. You can exclude a 
group or user from group policy by adding it to the list on this tab and specifying 
Apply Group Policy Deny permissions for it.

10. Click OK.

Step 3: Assigning the Package

You now assign the distribution to computers on your domain.

To select the assigned distribution for the plug-in:

1. Log in to the server with a user name which has administrative rights.

2. Select Start>All Programs>Administrative Tools>Active Directory Users and 

Computers. 

The Active Directory Users and Computers window appears.

3. In the hierarchy on the left side of the screen, navigate to your domain

4. Right-click on it and select Properties.

The domain’s Properties form appears. 

5. Click the Group Policy tab.

6. Highlight Microsoft Outlook, and click Edit.

7. Under Computer Configuration, expand Software settings.
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8. Right-click on Software Installation, and select New>Package.

9. Enter the full path and file name of the distribution point. 

The Universal Naming Convention (UNC) path must be used. For example:

\\my server name\share folder name\MRMOutlook.msi

Do not browse to the file path. The full UNC file path must be used.

10. Click Open.

11. Select the Assigned deployment method and click OK. 

The package is now listed on the right side of the group policy form.

This finishes the group policy setup process. The MRM plug-in will be automatically
distributed to users and workstations as specified. 

Before your users can use the MRM plug-in, they must configure it to communicate
with the MRM server. See “First Outlook start up after plug-in installation” on page 205.

For workstations running Microsoft Windows XP with the Fast Logon Optimization
feature turned on, two restarts are needed to install the MRM plug-in. This feature is
turned on by default.

Manual distribution of the plug-in

If you do not use group policy to distribute the MRM plug-in, or if some users or
computers were not in the group policy distribution, you can install the MRM plug-in
manually.

To manually install the MRM plug-in:

1. Close Microsoft Outlook

2. Log in to MRM.
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3. Click the Edit User Profile icon at the top right of the main screen.

The User Details form appears. 

4. Click Download MRM plug-in for Outlook.

5. Select Run.

As a security warning, you may be prompted a second time to run the software. 
Select Run a second time.

The Welcome and Confirm Installation screen appears.

6. Select where to install the plug-in, and click Next.

The default location is C:\Program Files\NetSimplicity\MRMOutlook.

7. Click Next.

A status bar indicates the progress of the installation.

8. Click Next.

9. Click Close.

Before users can use the MRM plug-in, they must configure it to communicate with the
MRM server. See “First Outlook start up after plug-in installation” on page 205.
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First Outlook start up after plug-in installation 

On opening Outlook for the first time after installing the plug-in, the MRM Login
Information window appears:

1. In the:

• MRM Site Url field, enter where MRM is located on your company network. 

Ask your IT department if you don’t know where it is.

2. If you use forms (MRM) authorization instead of Windows Authorization, in the:

• User Name field, enter your MRM user name.

• Password field, enter your MRM password.

3. Click the Test button. 

If the Url and User Name are valid, a pop up confirming this appears.

4. To make the MRM plug-in your default appointment form for your Outlook calendar, 
check the Set MRM Reservation form as a default appointment form in your 

Outlook Calendar checkbox 

5. Click OK.
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Setting the default location

A user’s default location setting indicates his time zone. In order to accurately schedule
reservations and view room availability, each user’s time zone must be accurate. The
default location setting should be the location where the user works from.

For users who:

• Only use Outlook, administrators should set it on their behalf or give them access to 
the MRM web client to let them do it themselves.

• Use MRM web client can do it for themselves. 

This setting also determines which resources are first displayed on the reservation
grid in the MRM Reservation form in Outlook.

The instructions below describe how the administrator adjusts the default location
setting for a user. Information about other user settings is found in “Usernames” on
page 67.

Setting a user’s default location

1. Log into the MRM web client with a username which has administrative rights.
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2. Click Admin>Users.

The Security Settings-Users screen appears.
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3. Click the name of the user whose default setting you wish to adjust.

The User Details screen appears.

4. Uncheck the User Must Edit Profile At Next Logon Instance checkbox.

5. In the Set User Default Location drop-down list, select the user’s default location.

6. Check the User Must Edit Profile At Next Logon Instance checkbox.

7. Click OK.
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Changing the default location

1. Log into the MRM web client.

2. Click the Edit User Profile icon in the top right-hand corner of the screen.

The User Details screen appears.

3. In the Set user default location drop-down list, select your new default location.

4. Click OK.
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Configuring the MRM plug-in

Configuring the MRM plug-in for a secure HTTP connection

If you use a secure HTTP connection (https) with MRM, the MRM plug-in must be
configured to use the secure connection as well. Each user who uses Microsoft Outlook to
schedule MRM reservations must configure the MRM plug-in on his desktop so that the
secure HTTP connection can be used.

To configure for a secure HTTP connection:

1. In your web browser, run the MRM web client. The URL is comprised of your web 
server name and virtual directory name.

For example: https://webserver1/MRM7/

The Security Alert screen appears. 

2. Click View Certificate.

The certificate information form appears. 

3. Click Install Certificate.

The welcome screen appears.

4. Click Next.

The Certificate Store screen appears. 

5. Choose the Automatically select the certificate store based on the type of 

certificate radio button and click Next.

The settings you have chosen are displayed.

6. Click Finish.

If the security certificate was successfully imported, a prompt indicates that the 
import was successful.

The original certificate information form displays. 
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7. Click OK.

The original Security Alert form appear. 

8. Click Yes.

9. Follow the instructions in the “Connecting the MRM plug-in to the MRM database” 
on page 211.

Connecting the MRM plug-in to the MRM database

After installation, each user must configure the MRM plug-in to connect to the MRM
server. Each connection is unique. If another user works on the same workstation, she
must set up her own connection to the MRM server.

If your MRM server is configured to use the https protocol, follow the instructions in
the “Configuring the MRM plug-in for a secure HTTP connection” on page 210 before
proceeding with the instructions provided in this section.

To configure the MRM plug-in to connect to your MRM server:

1. Open Microsoft Outlook.

A prompt opens and indicates that a new customized appointment form is now 
available in your Outlook calendar. It asks if you wish to make this the default 
appointment form. 
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2. Click Yes.

The new MRM toolbar displays at the top of the screen with the standard Outlook 
toolbars. 

3. Click on the MRM tab and click Settings.

The MRM Login Information screen appears, 

4. Enter the URL for your MRM server in the following format:

http://<server name>/<virtual directory name>

For example: http://acmeserver/mrm7/

If you are uncertain what the name of the server hosting MRM is, ask your MRM 
administrator.

If you have configured your MRM plug-in for a secure HTTP connection, replace 
http with https.

5. Click Test.

• If the MRM server information is valid, a prompt confirms this.
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• If you are prompted that it is invalid, correct the URL and test it again until 
successful.

The validation test you just performed connected to your MRM server and 
checked authentication settings.

• If your MRM server is using Windows authentication, the username and password 
fields are now greyed out. Your username and permissions are determined by your 
Windows username. Your full name and email address are gathered from the first 
listed email account in your installation of Microsoft Outlook.

• If your MRM server is using MRM authentication, the username and password fields 
remain editable. Enter the username and password that you use to log into the 
MRM database.

6. Check the Remember Username and Password checkbox.

If you leave the box unchecked, you will be prompted to enter this information 
again each time the MRM plug-in attempts to connect to the MRM server.

7. Click OK.

If you wish to edit your user profile, which includes your email address, log in to MRM
and click the Edit User Profile icon. See “Running MRM in a web browser” on page 8 and
“Editing your user profile” on page 74 for details.
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Refreshing mapped field data

Everytime Outlook starts, it checks mapped fields and their data, updates them and adds
any new fields created since the last time it was started. To make sure the fields are up to
date, in Outlook’s Meeting Room Manager tab, click Refresh Fields.

Refreshing can take up to 20 seconds depending on the network connection and the
number of mapped fields and the size of their associated data.

Preventing automatic refreshing of mapped field data

By default, when the client’s Outlook plug-in starts, it automatically connects to the
server. If the mapped field data has changed since it was last started, the plug-in’s
mapped fields are refreshed. If there are many fields and they are associated with large
databases, this refreshing can take a long time and tie up the network.

To turn off this automatic refreshing, add a new setting field to the MRM project options.
After this is done, clients who need refreshed fields can refresh them as shown in
“Refreshing mapped field data” on page 214. 
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While the refreshing is taking place, this status bar appears:

To turn Outlook’s automatic field refreshing on or off:

1. Open your reservation database with either Microsoft SQL Server Enterprise 
Manager or Management Studio.

2. In the Options table, add a new record:

• In the Setting field, enter: OutlookPreventRefreshOnStartUp.

• In the Value field:

• To turn off automatic refreshing, enter 1=True.

• To turn on automatic refreshing, enter 0=False (default value).
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Creating an MRM reservation in Outlook

To use Outlook to book resources and services managed by MRM, the MRM plug-in must
be installed and configured as described in the previous sections of this chapter.

MRM security is maintained in Outlook. If you do not have permission to schedule
resources in a specific location in MRM, those resources are not available in Outlook. If you
have permission to book specific services, such as catering or equipment, these can be
booked along with your MRM reservation in Outlook.

To create an MRM reservation in Microsoft Outlook:

1. In the Microsoft Outlook calendar view, click on the MRM toolbar and then click 
Appointment. 

The MRM Reservation form opens.

If you chose to use the MRM Reservation form as the default form when you 

first ran the MRM plug-in, you can open the MRM Reservation form by:

• In Outlook, select New>Appointment.

• In your Outlook calendar, click on a time slot.

2. Click the Appointment tab

3. In the Subject field, enter the reservation’s title.

4. Enter the reservation’s start and end time.

Leave the Location field blank as MRM will auto-fill it once you have selected 
the resource(s) you wish to schedule.
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5. Click the Meeting Room Manager tab.

The status box briefly displays while connecting to your MRM server, and then the 
list of resources displays.

All of the locations you have permissions to view are available in the location tree 
located in the Select Room Location field. Your default location is selected and the 
resources at your location display in the reservation grid below. 

6. To add preparation and cleanup time to your reservation, enter the time in minutes 
into the Preparation Time and Cleanup Time fields.
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7. Check the reservation grid for the availability of the resource(s) you wish to book.

The time range of your reservation is highlighted in the reservation grid for easy 
visibility into each resource’s availability.

The checkboxes next to available resources are blank, while the checkboxes next to 
unavailable resources are marked with an X.

• To add or remove resources from view in the reservation grid:

• Check and uncheck the boxes next to locations in the location tree. Only 
resources belonging to checked locations are shown in the reservation grid.

• Narrow the list by showing only resources with specific attributes. To do this, 
select a filter from the Select Room Attributes field and click Find Rooms. You 
can remove the filter by clearing the field and clicking the Find Rooms again.

Filters can be added, modified, and deleted by MRM administrators. For 
details, see “Adding a filter” on page 288.

• To view a resource’s details before selecting it for your reservation, right-click on the 
resource’s name in the grid.

The resource’s details open in a new window. Exit from the resource’s details and 
return to the reservation by clicking Close.

• To adjust the time of your reservation to accommodate resource availability, do so 
in the Start Time and End Time fields above the list of resources.

8. Check the box next to the resource(s) you wish to book.

Selected resources are shown as a tab in the lower frame.

9. To add service requests, see “Requesting services in Outlook” on page 223.

10. To invite attendees, click the Scheduling tab and enter attendees’ email addresses 
to the list. 

If the attendees are connected to your Microsoft Exchange server, their availability is 
visible.

11. To make comments about this meeting or add details about the service required, 
enter it into the Notes field.

12. Click:
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• Save and Close to save the reservation.

• Send if attendees were selected. This saves the reservation and sends an Outlook 
Invitation to attendees.

If you see a striped box around your meeting when viewed in outlook, it shows your

meeting is on the wait list (see “Wait List” on page 247 for details). You can either move
the meeting to a new location or time or wait to see if the room or resource you want
becomes available.

Creating a private meeting

The MRM plug-in supports Outlook’s private meeting feature. A private meeting on the
MRM grid is labeled as private. It can only be opened by the person making the booking
or those with permission to see them.

The delegate function is not supported for private meetings.

1. Open the MRM reservation form and create the meeting.

2. Click Outlook’s Private button and click Save.

In the search results, private meetings you do not have permission to see are not
displayed.
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Delegating meetings with the MRM plug-in

You can schedule meetings in other people’s calendar with the MRM plug-in. Its delegate
function supports Outlook 2003 or 2007 shared calendars function.

Installation

Before creating, modifying or deleting meetings in shared calendars:

1. We recommend everyone using shared calendars and their delegates have the plug-
in installed on their machine.

 If this is not done, data can become unsynchronized between the Outlook 
calendars and the database.

Delegates without the plug-in should have their permission level set to Author or 
lower. They can see meetings and the attendees but they cannot create, edit or 
delete bookings. The MRM tab will not appear in their Outlook window.

2. All shared calendars which use the same exchange server must use the same 
database.

Adding delegates

Before someone can book meetings in your calendar, you have to make them a delegate.

1. Open your calendar.
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2. Select Tools>Options.

The Options dialog box appears.

3. Click the Delegates tab and click Add.

The Add Users dialog box appears.

4. Select the user(s) you want to be delegates for your bookings, set their permission 
levels, and click OK.

Booking as a delegate

To book a meeting in someone else’s calendar, open and book it as you would with your
own calendar. All the MRM functions are the same.
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You can only book the MRM resources and services you have permissions for. These

permissions are not delegated.

If:

• You cannot open an appointment in your own or someone else’s calendar.

• You cannot book a meeting in your own or someone else’s calendar.

• The prompt: The reservation is being opened on another computer. The form 

will be closed. appears.

That calendar is being used by someone else. Wait and try again. 

If you have invited yourself to a meeting you booked as a delegate, and want the meeting
details in your calendar, when the Would you like to update your calendar now?

prompt appears, click No.

Working offline

The plug-in stops you from creating a new booking or changing an existing booking if
you are offline or not connected to the MRM server.

Bookings made or changed when you are offline can result in database mis-
synchronization. This appears as bookings visible on the screen not being stored in the
database, the opposite, or other problems.

To learn if you are working offline:

• In the browser’s status bar, Offline is displayed.

• Click on the plug-in’s MRM tab. If Outlook   is   offline, Outlook is Offline   appears.                                                                                                                     

You can use Outlook to book new appointments or change existing ones, but if you try to
use MRM to make, change or see bookings, the MRM meetings cannot be modified

while Outlook is offline prompt appears.                                                                                                               
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Requesting services in Outlook

The services management module in MRM enables administrators to integrate services
into the reservation process. These services can be anything that your organization offers
in conjunction with reservations, such as catering and presentation equipment.

For an in-depth summary of the capabilities of the Services Management module, setup
instructions, and a description of the order process, see “Services Management Module”
on page 135. It is recommended that administrators read the chapter and fully
understand the module before granting users with rights to create service requests.

Once your organization’s services have been set up in MRM, orders for service items can
be placed within MRM reservations in Outlook. 

To request service items in an MRM reservation in Outlook:

1. Prepare your MRM reservation in Outlook as shown in steps 1 through 7 of “Creating 
an MRM reservation in Outlook” on page 216.
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2. In the Meeting Room Manager tab, click Add Requirements for Selected Rooms.

The Add Room frame minimizes to the top of the form and the Add Requirements 
for Selected Rooms frame below opens to display available services.

Each resource has its own set of buttons for services that are available to be ordered 
with the resource.
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3. Select the tab of the resource you wish to add a service order to, then click Services 
of your choice.

The catalogue of service items displays on the left and the order details area displays 
on the right.

4. Browse the catalogue to locate an item to add to your order.

• Click the categories and subcategories to display their service items.

• Right-click on the service item you are considering ordering. A brief description and 
dollar amount display.

• To select the item, left-click on it. The item is added to the order details on the right 
side of the tab. Your order’s total cost refreshes.

5. To adjust the quantity of the item you selected, click in the Qty column beside the 
item and edit the value.

The order total refreshes automatically.

6. To adjust the delivery time of the item you selected, click in the Time column next to 
the item and adjust the time. 

If you wish to have several items arrive at the same time, adjust the Time field 
above the order details before selecting the items. The delivery time of each 
successive item defaults to this value.

7. Repeat steps 4 through 6 for each item you wish to order.

8. Repeat steps 3 through 7 for each additional service and resource you wish to order 
for this meeting. 

9. Click Save and Close to save your reservation and place your service order.

If you are using Internet Explorer and you want to print MRM’s background colors
and images:

1. In IE select Tools>Options>Advanced.
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2. Check Print background colors and images.

Editing an MRM Reservation in Outlook

MRM reservations created in Outlook can be fully edited in Outlook.

Quick Changes in the Outlook Calendar

The date, time, and title of a reservation can be adjusted quickly in the Outlook calendar,
while further details can be adjusted once the reservation is opened. 
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• To adjust the date and time of a reservation in the Outlook calendar, drag and drop 
the reservation to its new date and time.

• To adjust a reservation’s title in the Outlook calendar, single-click on the reservation, 
update the title, and then hit Enter on your keyboard or click outside the reservation 
to save the new title.

If you are making these quick changes to a single occurrence of a recurring reservation,
the quick changes only apply to the single occurrence.

These quick changes do not generate a prompt to send an email update to attendees.
Instead, the update can be sent manually if necessary, by opening the reservation and
clicking Send Update.

Detailed changes in the MRM reservation form

To edit reservation details using the MRM Reservation form in Outlook:

1. In the Outlook calendar, double-click on the reservation you wish to edit.

2. If the reservation you wish to edit is part of a recurring reservation, select the 
appropriate option from the list when prompted:

• Open this occurrence: This opens the single occurrence you have clicked on.

• Open the series: This opens the recurring reservation series. The reservation details 
saved will apply to all occurrences, overwriting any prior changes to single 
occurrences belonging to this series.



Chapter 10  |  The MRM Plug-In for Microsoft Outlook

228

3. The MRM Reservation form opens. Edit the reservation as needed.

4. Click:

• Save and Close to save your changes. 

• Send Updates to save your changes and send an email update to attendees.

The changes you have made are updated both in Outlook and in the MRM database.

If the changes present a conflict with existing reservations for the selected resource(s),
you are notified and given the opportunity to resolve the conflict before the reservation is
saved and attendees are notified of your changes.

Deleting an MRM Reservation in Outlook

MRM reservations which you created in Outlook can be deleted in either Outlook or MRM.
Reservations can be deleted at any time.
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If you wish to delete a reservation that you created using Microsoft Outlook, you should
delete it in Outlook in order for each attendee’s schedule to be updated.

If you do not have Delete Meetings permission, deleting bookings with the plug-in

removes meetings from your Outlook calendar but not from the MRM database. See
“Assigning location permissions” on page 60.

Recurring MRM reservations in Outlook

The MRM plug-in fully supports Outlook’s recurrence feature. Recurrences can be
scheduled in Outlook and resources can be booked for them as you would for a non-
recurring meeting and they will be booked for every event in the series. Any changes to
the series will be applied to all events. If there are exceptions in the series, changes may
not be applied to them.

In Outlook calendar you can only view and open those bookings created in your
calendar or in calendars shared with other users. See “Overview of the MRM plug-in for
Microsoft Outlook” on page 197 for full details. 

MRM does not allow recurring reservations without an end date, so the no end date

option is unavailable.

Changing the recurrence pattern automatically deletes any existing exceptions. For
example if all meetings are at 2pm, but one is at 3pm, adding a new booking or changing
the time deletes the 3pm meeting.

Editing events in a recurring series

Events in a recurring MRM series with bookings can be edited in Outlook without
affecting the other events just like any other kind of recurring Outlook appointments. To
edit an event, open it, change it, then save and close. This creates an exception in the
series. See“Example of editing events in Outlook with the MRM plug-in” on page 231.

Do not change the location for or delete the first event in a series.
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Changing an event’s:

• Start/end time

• Location

• Subject

• Attendees

• Booking details (prep/cleanup time, service orders or anything in custom fields)

does not affect the other events or reservations in the series.

Changing an event’s:

• Preparation/Cleanup time

• Service order

• Custom fields 

creates an exception by location, just as if you changed the room. Changing the room for
the series does not change the exception’s room.

Changing a series:

• Start/end time

• Recurrence pattern 

automatically deletes all exceptions and puts them back into the recurrence pattern. The
prompt below shows this happened. MRM bookings will be adjusted accordingly.

To reset the exception(s) back to the original condition, open each event and manually
change it.
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Example of editing events in Outlook with the MRM plug-in

Step 1: Create a recurring series in Outlook with a room, service order, and 

Host 1 (specified in the custom field). All events are identical except for the 

day.

Staff Meeting
Room 1

Monday, 10am
Service: Tea
Host: 1

Preparation time=0

Staff Meeting
Room 1

Tuesday, 10am
Service: Tea
Host: 1

Preparation time=0

Staff Meeting
Room 1

Wednesday, 10am
Service: Tea
Host: 1

Preparation time=0

Step 2: Create exceptions to the series by changing the room, service order, 

host, and preparation time. The host only changes for the Monday meeting 

because it is a custom field.

Staff Meeting
Room 1

Monday, 10am
Service: Tea
Host: 2

Preparation time=0

Staff Meeting
Room 2

Tuesday, 10am
Service: Tea
Host: 1

Preparation time=0

Staff Meeting
Room 1

Wednesday, 10am
Service: Hot Chocolate

Host: 1
Preparation time=30 min.

Step 3: Edit the series. Change the room for the series (from room 1 to room 

3), the service order (from tea to coffee), the host (from host 1 to host 3) and 

the preparation time to 15 minutes. The final result looks like this: 
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Notice that the room change was not applied to the Tuesday meeting because an
exception by location was created for it in step 2. The same thing happens if you change
the subject or attendees. The service order was not changed for the Wednesday meeting
because this exception was created in step 2.

Deleting events in a recurring series

You can delete exceptions in a recurring series without affecting the other meetings. If at
any time after deleting an exception, you change the rest of the series, you see this
prompt:

The gap in the series caused by the exception’s deletion will be automatically filled in. You
will have to manually delete it if you still do not need it.

Deleted meetings cannot be manually added back into the series without loosing all 
existing exceptions. You must first change the entire series to automatically fill in the gap 

and then manually change the exception.

Resolving booking conflicts

If a resource you requested for your series has already been booked by someone else, a
screen appears showing the conflict(s).

Staff Meeting
Room 3

Monday, 10am
Service: Coffee

Host: 2

Preparation time=15 

min.

Staff Meeting
Room 2

Tuesday, 10am
Service: Coffee

Host: 3

Preparation time=15 

min.

Staff Meeting
Room 3

Wednesday, 10am
Service: Hot Chocolate

Host: 3

Preparation time=30 min.



MRM 7  |  Admin Guide

                                  233

Conflict resolution does not support the wait list or priority reservations.

To resolve a conflict:

• To book a different resource at the same time, click on the original resource name or 
the X icon. A list of resources available at that date and time appears. Click on an 
item to book it and click OK.

If you click OK without resolving the conflict(s), the conflicted meetings are skipped,

are not saved in the database and will not appear in the calendar.

• To book the same resource at a different time, first save the booking to a different 
resource. After saving, re-open it and re-book the meeting into the original 
resource, but at a different time and any other changes as needed.

Adding fields to the MRM form

As many as ten mapped fields can be added to the MRM form to customize it to suit your
needs. These can include items such as “client name,” “table type,” or “invoice bill to.” Only
the system administrator can add them and after they are added, they will appear on
everyone’s form. You can also select fields with value lists and default values which then
can be changed to meet your requirements.

To add fields to the MRM form:

1. On the MRM screen, click Admin.

2. Click Advanced Administration.

3. Click Customize Outlook.

4. From the list, select a field to add. 

To leave a field blank, click Not Mapped.

5. Click Save.

The changes are automatically applied to all user’s forms. Check to see that this 
happened.
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CHAPTER 11 Meeting Requests

Meeting request overview

Some organizations prefer to have staff or guests request a meeting room instead of
select their own for their meeting. MRM allows your organization to do this using the
Request Meeting form. Staff or guests simply go to this HTML page and enter information
which is sent to the Meeting Confirmation form. At this time, an MRM administrator may
assign an appropriate room to the meeting and notify the person who sent the request of
where their meeting will be held.

Customize the request meeting form

Before the global administrator customizes the Meeting Request form, two factors should
be taken into consideration. 

• ONE: Only fields that exist in the Reservation form are available to be placed on the 
Meeting Request form. The properties that the fields on the Reservation form have 
also apply to the Meeting Request form. Therefore, if there are fields that you wish 
to set as mandatory, this property must be set in the Reservation form using the 
Form Designer. See “Customizations” on page 85 for details. 

• TWO: Remember that individuals using the Meeting Request form are strictly 
limited to the fields that you give them. If you do not include a mandatory email or 
booked by field, you cannot know who requested the meeting at all.
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To customize the Meeting Request form: 

1. Click Admin>Advanced Administration>Request Meeting.

The Request Meeting form opens.
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2. Check the Form Designer checkbox.

The list of available fields opens. 

3. Those fields already on the form have a check in the box to their left of their name.

4. Check the box next to each of the fields you wish to have available for users to enter 
information into.

When users click the TAB button on their keyboard, the cursor will move to the next 
field in the order in which they were initially selected to be displayed on the form by 
the person performing form design.

5. Click Apply Changes.

All fields that you selected now display on the form, while those that were unselected 
have been removed.
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6. Use your mouse to drag the fields and their titles to the position you wish them to be 
in on the form.

Field labels are moved separately from the field they belong to.

Post the request meeting form

The Request Meeting form can be posted on your company intranet or your web site. You
simply need to place a link on an HTML page to the Request Meeting form. You may
choose give the URL to your staff members, who may add it as a shortcut to their desktop,
or as a favorite in Microsoft Internet Explorer.

The Request Meeting form URL is based on the following format:

http://<webserver>/<vdir>/MeetingRequest.aspx 

Where:

• <WebServer> is the Web server name / IP address

• <vdir> is the Virtual Directory name, e.g. MRM7

Request a meeting

1. Click the link your MRM administrated provided for the Request Meeting form.

The Meeting Request form appears

Depending upon the settings your system administrator has arranged, you may 
be required to log in to continue. For username and password information, consult 
your system administrator.

2. In the Request Meeting form, enter the information for the meeting you wish to hold.

Some fields may be mandatory. If you do not fill in mandatory fields and click Send, 
you receive a prompt telling you which field you have left blank that is required. Fill in 
the field, and select Send.
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Confirm a meeting request

As the meeting confirmation administrator, it is recommended that you check for
meeting requests fairly frequently and assign them to corresponding available resources. 

Meeting requests can also be opened by an administrator and altered without being
assigned to a resource. This allows for service orders such as catering and equipment to
be added by an administrator before a resource is assigned.

To locate a meeting request, add meeting details, and assign it to a resource:

1. Click Confirm.

The Confirmation form opens.

2. In the Location drop-down list, select the location for which you wish to view 
requests.
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3. Select the List requested meetings option.

The list of meeting requests displays. In the Status column, there are indicators that 
mark each meeting request based on its status. See the icons and their corresponding 
meanings below:

Assigned: The corresponding meeting request has been assigned to a room by 
an administrator. The assigned room is visible in the Resource Assigned column.

Not Assigned: The corresponding meeting request has not yet been assigned to 
a room.

Processing: The corresponding meeting request is currently being assigned to a 
room by an administrator.

4. Click on the name of the requested meeting to begin processing the meeting request.

If the requested meeting is being processed by another administrator, you are 
prompted with a message which reads similarly to the following:

“This reservation request is already being processed by Luke since 7/7/2006 11:03 AM. 
Do you wish to continue?”

It is recommended that you click Cancel and allow the other administrator to continue 
processing the meeting request. However, a user’s session can time out while he has a 
meeting request in process if his session remains idle for the allotted IIS time out 
period which is 20 minutes by default. If by looking at the date and time that 
processing began you believe that the user’s session timed out, you may wish to click 
Open and process the meeting request yourself.

5. The corresponding Reservation form opens. Information that was supplied by the 
person who requested the meeting is already in the Reservation form.

6. Enter any further details for the reservation such as a catering or equipment order.

If you do not wish to assign this meeting request to a resource yet, click Save and 
Close. The meeting request remains in the list of requests awaiting resource 
assignment.



MRM 7 |  Admin Guide

                                  241

7. If you wish to assign this meeting request to a resource, check the box next to the 
resource you wish to select. Only rooms at the location the requester selected are 
listed in the Resources box.

Alternatively, click the Find Available Resources icon to list all rooms that are available 
for this reservation, then select the room you wish to assign this meeting to.

8. Click Save and Close.

9. In the Confirmation form, click the Email icon to email the requester. You may need to 
reference a contact email field on the corresponding Reservation form for this 
person’s email address. Edit the email as necessary, and then click Send.
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CHAPTER 12 Confirmations

Confirmation overview

By default, confirmations are required for any reservation with requirements, such as food
or equipment requirements. Each requirements tab is treated as a different department.

When a reservation with requirements is saved, the user is prompted to send out a
notification email to each department from which requirements have been requested.
The email is prepared by MRM according to the database’s options settings. In addition to
sending the email, MRM lists the meeting on the Confirmation form. Each reservation’s
status can be quickly determined since reservation color settings are based on
confirmation status.

Confirming reservations

Standard setup includes a contact for each department who is responsible for confirming
reservations with requirements. This involves checking to see that the requirements can
be delivered, and then confirming the reservation. To change the designated contact
responsible for confirmations, see “Tab properties” on page 89.
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To confirm meetings:

1. Click Confirm.

The Meeting Confirmation form opens. 

2. Select your filter settings according to your needs:

• Location: Specify the location whose reservations you wish to view. To view all 
locations, leave this field blank.

• Department: From the pull-down menu, select the requirements department you 
wish to view reservations for. To view all, select All Departments.

• Meeting Title: To view reservations based on meeting title or a portion of it, enter 
the title here. To view all, leave this field blank.

• In the Confirm Type drop down list, choose one of the following:

List All Meetings With Requirements: This shows all meetings with requirements, 
whether confirmed or not yet confirmed. This option cannot be selected at the 
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same time as the List Unconfirmed Meetings nor the List Requested Meetings 
options.

List Unconfirmed Meetings: This shows all meetings with requirements that have 
not yet been confirmed. This option cannot be selected at the same time as the List 
All Meetings With Requirements nor the List Requested Meetings options.

List Requested Meetings: This shows all requested meetings which have not yet 
been assigned to a resource. This option cannot be selected at the same time as the 
List All Meetings With Requirements nor the List Unconfirmed Meetings options.

Group Recurring Meetings: This displays the series as a whole instead of one item 
for each occurrence. This means that when the one item is confirmed, all 
occurrences of this meeting are considered confirmed.

Confirm by Department: This displays one item for each department for which 
requirements have been selected for a single reservation. This means that until all of 
a reservation’s requirements have been confirmed by their respective department, 
the reservation as a whole is not considered confirmed.

Show Past Meeting: This shows all unconfirmed reservations including those that 
were scheduled to take place in the past and therefore have already taken place.

3. In the Email column for that reservation row, click on the Email icon to send an email 
confimation to the person who scheduled the reservation.

The email opens in your workstation’s mail client unless emails are sent from the 
server. For details on sending emails from the server, see  “Sending emails from the 
web server” on page 33.

4. Edit the email as needed.

5. Click Send.

6. In the Confirmed column for that reservation row, check the Confirmed check box 
beside the reservation you just sent the email confirmation for. 

7. Click Confirm Selected.

The reservation is confirmed, the meeting’s color has changed in the grid to represent 
the reservation type’s confirmed color, and the user who booked it has been notified 
by email.
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CHAPTER 13 Wait List

Wait list overview

A wait list entry is essentially a place in line for a resource and time that is already booked.
The wait list displays all entries from the current time forward. Entries for a time in the
past are not shown.

Local administrators are responsible to manage wait list entries on an as-needed basis.
Because MRM automatically handles the regular workflow, the only time a local
administrator must manage the wait list is if he receives a special request from a user.
Users cannot view or edit wait list entries once they are first saved, so they require the
local administrator to make changes for them. Typically it is when a user gets an email
notification of their wait list entry’s status change that they contact their local
administrator for changes. 

Enabling the wait list

In order to use the wait list features in MRM, you must enable it with the following steps:

• Step 1: Turn on the wait list option

• Step 2: Activate the wait list trigger

• Step 3: Customize wait list email templates

Once completed, the wait list features are ready for use.
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Turning on the wait list option

Follow the instructions below to turn on the wait list option:

1. Log into Meeting Room Manager with a username which has administrative rights.

2. Select Admin>Options.

3. Click the Others tab.

4. Check the box beside Wait List.

Because the priority rights feature set requires the wait list to be used, the wait 
list option is automatically enabled along with the priority rights option. To learn more 
about priority rights, see“Implementing priority rights” on page 77.

5. Click OK.

To learn about the other options that are available in the Options form, see “Customizing
MRM’s settings” on page 15.

Activating the wait list trigger

The wait list trigger checks resource availability and promotes wait list entries to
appropriate spaces that have become available.

It goes through each wait list entry in order based on the created date and time. This
ensures that wait list entries are pushed into an available space on a first come, first served
basis.

A reservation which was pushed to the wait list by a priority user maintains its
original created date.

Each time the trigger promotes a wait list entry, it sends the wait list assigned notification
email, based on the email’s template. Instructions on adjusting this template to suit your
needs are provided in “Customizing the wait list email templates” on page 249.

Follow the instructions below to activate the wait list trigger:

1. Open the MRM Window Service Admin by selecting Start>All Programs>Meeting 
Room Manager7>MRM Window Service Admin>Triggers tab.

2. Double-click the trigger called WaitList_Service.
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3. In the Trigger Detail form that opens, set the schedule for the trigger to run. Choose 
from either of the following:

• Once at <time>: This schedule forces the trigger to run every day at the specified 
time.

• Occurs every <#> minute(s): This schedule forces the trigger to run at a specified 
minute interval such as every one minute.

The typical rate is once every 10 minutes, but you may wish to make it more or 
less frequent depending upon your organization’s requirements.

4. Select Active in the Status section of the form.

5. Click Save Trigger  to save your changes and activate the trigger. It will now run at 
the interval you have specified and send notification emails as you have specified.

Leave the Email Information section blank. It is a standard input frame which is not
used by the code of this trigger. The email notification template will be changed in the
next step, “Customizing the Wait List Email Templates”.

The stored procedure which is referenced by the trigger, MRM_70_WaitListService,
can be opened in SQL Enterprise Manager and modified as required, allowing the trigger
to pull information into the email notification template from additional tables. However,
modifications of this nature should only be performed by qualified individuals and cannot
be supported by NetSimplicity.

Customizing the wait list email templates

When a requested space becomes available and a wait list entry is promoted to the
reservation grid by the trigger you just activated, an email is sent to notify the wait list
entry’s creator of the change in status. This email is based upon the Wait List Assigned
Notification template.

Additionally, administrators can send a wait list status email at any time from the wait list
view of the Confirmation form. This email informs a wait list entry’s creator of its current
status and is based upon the Wait List Status template.

Both email templates are adjusted in the Options form. To adjust a template:

1. Log into MRM with a username which has administrative rights.
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2. Select Admin icon. The Admin console opens.

3. Click Options.

4. In the Options form that opens, click the Email Messages tab.

5. From the email pull-down menu, select the template you wish to modify. The two that 
are used by the wait list feature set are the Wait List Assigned Notification and the 
Wait List Status.

The form refreshes to display the selected email template.

6. Modify the selected email template with the following fields:

• Field Reference: This reference field allows you to insert data that is specific to each 
meeting or wait list entry. These references can be used in any of the customizable 
fields within the Email Messages tab by clicking Insert.

For example, selecting <General/Meeting Title> displays the meeting title for 
whichever meeting the email is about.

• To: This field allows you to select whom the notification is sent to. 

It is recommended that you use the default, <User Email Address>, as this sends the 
email to the user who created the wait list entry.

• CC: This field allows you to type in an email address that all notifications of this kind 
are to be sent to. For example, if one person is in charge of administrating wait list 
entries, his or her email address can be entered in this area.

• Subject: This field displays the email’s subject. It is recommended that you use the 
<General/Meeting Title> reference field in the subject.

• Body: This field represents the body of the message that is sent out. It should be 
generic for all types of meetings. Anything specific to a particular meeting should 
be represented by a field reference. Keep in mind that all notifications can be 
customized at the time they are sent.

7. Click OK.

8. You are returned to the Admin console. To change the second wait list email 
template, return to step three and repeat each step for the second template.
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Viewing the wait list

You must belong to a user group whose Confirm Meetings permission is enabled in order
to view the wait list. This permission is set by location, so you can only see the wait list
entries for the location you have permissions to.

To view the wait list:

1. Click the Confirm icon.

2. From the Confirm Type pull-down menu, select Wait List.

The wait list entries are displayed in priority sequence according to the meeting start 
time. All wait list entries from the current time forward are displayed. Entries for a time 
that has passed are not listed.

Manage an overridden reservation

When a reservation is overridden, or bumped to the wait list, by a priority reservation, it is
up to the user to decide what she would like to do. If she wants action taken, and she is
using MRM Web, she must send a request to the local administrator who has permissions
to adjust her wait list entry.  If she is using the MRM plug-in for Microsoft Outlook, then
she can make the changes herself.

The user has four choices:

• No Action: Leave the wait list entry in line as it is. 

This is typically done if the resource selected for the reservation is more important 
than the time chosen.

• Reassign: Contact the local administrator and ask him to reassign her wait list entry 
to an available resource. The wait list entry then becomes a reservation.

This is typically done if the time selected for the reservation is more important than 
the resource that was selected.

Though this allows the local administrator to choose the resource for the 
reservation, all of the reservation’s details are kept.

• Reserve & Delete: Create a new reservation for an available resource and ask the 
local administrator to delete her wait list entry.
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This is another way to handle the situation where the time selected for the 
reservation is more important than the resource that was selected. 

Though the user must enter all of the reservation’s details over again, this option 
allows her to choose her own resource instead passing the choice to the local 
administrator.

• Reserve & Keep: Create a new reservation for an available resource but leave her 
wait list entry in line for the original resource.

This is typically done if the resource and time selected are equally important.

Then if the original resource becomes available, the user can choose to keep either 
the original or the secondary choice and delete the other.

Reassigning an entry

Wait list entries can be reassigned to a resource and therefore taken off the wait list. This
can only be done by users with the Confirm Meetings permission.

Once a wait list entry is reassigned to an available resource, it becomes a regular
reservation and is no longer in line for the original resource if it becomes available.

To reassign an entry:

1. Click the Confirm icon.

2. From the Confirm Type pull-down menu, select Wait List.

The list of wait list entries displays.

3. Click the meeting title of the wait list entry you wish to reassign.

The corresponding Reservation form opens.

4. Uncheck the box next to the wait list entry’s currently selected resource.

5. Select an available resource for the reservation.

You may wish to use the Find Available Resources button to search for an 
available resource which matches your required criterion.

6. Click Save and Close.
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Deleting an entry

The only time a local administrator should reassign a wait list entry is if a user sends a
request for her wait list entry to be deleted.

Deletions are permanent. If the user changes her mind and wishes to be placed on the
wait list again, she loses her place in line for the time and resource.

Wait list entries can be deleted in two ways: from the wait list itself, or from the
corresponding Reservation form.

Delete Entry from Wait List

To delete a wait list entry directly from the wait list:

1. Click the Confirm icon.

2. From the Confirm Type pull-down menu, select Wait List.

The list of wait list entries displays.

3. Select the checkbox to the left of the wait list entry you wish to delete.

4. Click Delete Wait List Entry.

5. Click OK.

Delete Entry from Reservation Form

To delete a wait list entry from its corresponding Reservation form:

1. Click the Confirm icon.

2. From the Confirm Type pull-down menu, select Wait List.

The list of wait list entries displays.

3. Click the meeting title of the wait list entry you wish to reassign.

The corresponding Reservation form opens.

4. Click Delete.

5. Click OK.
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Sending status notice

Current status of a wait list entry can be emailed to the entry’s owner by an administrator. 

To send a status notice:

1. Click the Confirm icon.

2. From the Confirm Type pull-down menu, select Wait List.

The list of wait list entries displays.

3. Select the Email icon to the right of the wait list entry you wish to send the status 
notice for.

The email opens with the To address and body populated based on the email’s 
template.

Email templates can be modified in project options. See “Modifying email 
message templates” on page 23.

4. Modify the email if you wish, then click Send.
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CHAPTER 14 Interactive LCD Panel 
Installation and 
Configuration

Introduction

Touch-screen LCD panels can be used to view and book MRM meetings. They can be 
located outside meeting rooms or in reception areas, foyers or lobbies where anyone can 
see what meetings are booked where and when along with their details. It can create new 
meetings or change existing ones. You can even add your organization logo or a visiting 
party’s logo to a meeting’s display.

The panel consists of the LCD screen running Microsoft Windows along with the MRM 
LCD panel software.

To learn how to use the panel, see the Interactive LCD Panel User Quick Start Guide 
available for downloading at www.netsimplicity.com/support.

Panel installation procedure

There are three steps in configuring panels to run MRM:

• Step One: Installing the panel hardware, connecting it to your network and line 
power as given in “Step One: Hardware installation” on page 256.

• Step Two: Logging into your organization’s network, running the installer, 
configuring the client to work with the MRM server and downloading the MRM LCD 
panel client components as given in “Step Two: Run the installer and configure the 
client” on page 256. 

• Step Three: Configuring the panel’s settings inside MRM Web as given in “Step 
Three: Customizing the panel’s interface” on page 259.
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Step One: Hardware installation

If you are mounting the panel on a wall next to a meeting room, you may need to 
have your facilities team install an AC power outlet for it before proceeding.

Hardware required:

• LCD panel unit.

• LCD panel stand or wall mount kit.

• Network cable.

Procedure:

1. Install the panel.

2. Connect the network cable.

3. Connect AC power.

4. Turn on the panel.

Step Two: Run the installer and configure the client

After panel installation, you must run the installation program and download the MRM 
LCD panel client software.

You can connect a keyboard and a mouse to the panel to assist you with the installation if 
you don’t like using the panel’s on-screen keyboard.

To connect the panel to the MRM server and install the panel client:

1. On the panel, log into Microsoft Windows with a username and password with 
administrative permissions.

2. Select Start>All Programs>Accessories>Accessibility>On-screen Keyboard. 

The on-screen keyboard appears.

3. Run Internet Explorer on the panel.
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4. Use the keyboard to connect to your MRM server with the following URL:

http://<server>/<virdir>/LCD/LCD Install Files.exe

Where:

• <server> is the name of the MRM web server.

• <virdir> is the name of the MRM virtual directory.

5. When prompted, run the MRM LCD panel client installer.

The Meeting Room Setup screen appears.

6. Click Next.
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7. In the Installation path field enter a path for the MRM LCD panel client components. 

By default, this location is: C:\Program Files\LCD.

8. In the MRM Application Name field, enter the server URL in the following format:

http://<server>/<virdir>

Do not change the LCD Display field.

Write down the MAC Address. You may need this later.

9. Click Finished. 

The Error Page appears; this is normal. 
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10.Click the link to close the MRM LCD client.

11.Repeat one to ten for each panel you are installing.

Go to Step Three: Customizing the panel’s interface.

To ensure the panel is used only to display room availability and book or change 
meetings, not for surfing the web or checking email, after the MRM LCD panel client 
components are installed, if used disconnect the keyboard and mouse from the panel. 

Step Three: Customizing the panel’s interface

After installing the MRM LCD panel client components, you must configure the server and 
the panel to communicate with each other. Also you can customize the information 
displayed on a particular panel such as what meeting rooms are shown along with room 
and meeting details and set if users need a password to see/book/change meetings.

To configure a new panel:

1. In MRM Web, sign in as an MRM administrator.
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2. Select Admin>Advanced Administration>LCD Panel Displays.

The Configuration screen appears opened to the Summary tab screen.

3. Click Add New Panel.

The Setup tab screen appears. 

4. On the Setup tab screen, set the panel’s network connection details by following the 
instructions in “Setting the panel’s network connection details” on page 264.

Start by entering the panel name and working down the list.

5. Click on the Rooms tab and specify which rooms to display on the panel by following 
the instructions in “Displaying room details on the panel” on page 268.
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6. Click on the Reservation tab and set up what meeting details to display on the panel 
by following the instructions in “Displaying room details on the panel” on page 268.

7. Click on the Room Details tab and set up what room details to display on the panel by 
following the instructions in“Displaying room details on the panel” on page 268.

8. Click on the Schedule tab and configure the authentication, display and logo settings 
by following the instructions in “Setting heading text, authentication type, meeting 
background color and displaying room options” on page 269.

9. Either:

• Reboot the panel.

• On the panel run C:\\Program Files\LCD\Meeting Room Shell.

The Schedule View screen appears on the panel and it is ready for your users.

Displaying the panel’s configuration details

The Summary tab shows all of the configured panels on the left-hand side of the screen. 
Clicking a name shows details of the existing panels. It allows new panels to be added or 
the deletion of existing ones. It displays IP address, room and other details. 

To add a new panel:

The name given to the panel is the one that appears at the top of the screen. In this 
example it is Floor 7.

1. Make sure the LCD client components are installed as described in“Step Two: Run the 
installer and configure the client” on page 256. 
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2. Select Admin>Advanced Administration>LCD Panel Displays.

The Summary screen appears by default.

3. Click Add New Panel link on the left-hand side of the screen.

4. Perform the panel configuration as described in “Step Three: Customizing the panel’s 
interface” on page 259.

To edit an existing panel:

1. Click on the panel’s name to display its summary. 

2. Click Edit. 

3. Perform the panel configuration as described in “Step Three: Customizing the panel’s 
interface” on page 259 and click Apply.
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To delete a panel from the network:

1. Click on the panel’s name to display its summary. 

2. Click Disconnect. 

The panel’s listing is removed from the summary screen and all information about it is 
deleted. 

There is no warning or undo for disconnection. To restore the panel, you must click 
on Add New Panel and re-install it.
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Setting the panel’s network connection details

The Setup tab sets the panel’s network connection information.

1. Select Admin>Advanced Administration>LCD Panel Displays.

2. Click the Setup tab.

3. Starting with Panel Name and working down, enter the information for every panel 
and click Apply.

If you don’t know what to enter for any field, contact your IT manager.

For the following fields:

• The MAC Address is entered in the format XX-XX-XX-XX-XX-XX.
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This value is unique for every panel. MRM automatically tries to fill in this 
information based on the information shown in the setup screen shown in “Step 
Two: Run the installer and configure the client” on page 256. If this address doesn’t 
work, either enter it manually or enter a new address. 

• The Panel Name is the name as it appears on the Summary tab and at the top of the 
screen.

• For details on the Reservation List Option drop-down list, see “Reservation List 
Option” on page 271.

Choosing the rooms displayed on the panel

The Rooms tab controls which rooms are displayed on the panel. Only rooms at the same 
location can be displayed and they listed in alphabetical order.

It has two boxes:

• Available Rooms lists all of the rooms available for display.

• Displayed Rooms lists the rooms displayed on the panel.

To display or remove a room from view:

1. Select Admin>Advanced Administration>LCD Panel Displays.
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2. Click the Rooms tab

3. To:

• Add a room to the display, highlight it in the room in the Available Rooms box and 
click the right pointing arrow to move it to the Display Rooms box.

• Remove a room from display, highlight it in the Displayed Rooms box and click the 
left pointing arrow to move it back to the Available Rooms box.

4. Click Apply.

Customizing meeting information displayed on the panel

The Reservation tab controls what information users see when they click on a meeting’s 
reservation tab.

To add fields to be displayed:

1. Select Admin>Advanced Administration>LCD Panel Displays.
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2. Click the Reservation tab.

3. To

• Add a field, in the Available Fields box, choose a field to be displayed and click the 
right-hand arrow.

The field now appears in the Displayed Fields box.

The order in which you list items in the Displayed Fields box is the order in 
which they will appear on the panel

• Remove a field, in the Displayed Fields box, choose the field to be deleted and click 
the left-hand arrow

4. Repeat Step 3 until all the fields you want to display are in the Displayed Fields box.

5. Click Apply.
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Displaying room details on the panel

The Room Details tab controls what information users see when they select the room tab 
in a reservation. The Details box shows the information displayed on the panel.

To display or remove room detail information:

1. Select Admin>Advanced Administration>LCD Panel Displays.

2. Click the Room Details tab

3. To:

• Remove information from view, delete the text in the Details box.

• Display room information, click the room data elements drop-down list, select the 
appropriate field, then click the Insert button.
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You can add text to go along with a field. For example you can add Room 
Name: in front of the field <Meeting Room>. For the screen above, the result will 
appear on the panel as “Room Name: (Name of Room).”

4. Repeat Step 3 until all of the fields have been added.

5. To:

• Apply this page only to this panel, click Apply.

• Apply this page to all of the panels, click Apply All. 

This configures the set up panels. It does not apply to panels which have only 
received the MRM LCD panel client components and have not yet been set up.

• Cancel changes, click Cancel.

Setting heading text, authentication type, meeting 
background color and displaying room options

The Schedule tab controls what is displayed in the panel’s heading, sets the 
authentication permissions, sets the background color for a meeting underway and 
controls how many rooms are displayed on the Schedule View screen.

To fill out the Schedule screen:

1. Select Admin>Advanced Administration>LCD Panel Displays.
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2. Click the Schedule tab.

3. Fill out the fields or check the checkboxes as needed.

4. To:

• Apply this page only to this panel, click Apply.

• Apply this page to all of the panels, click Apply All. 

This configures the set up panels. It does not apply to panels which have only 
received the MRM LCD panel client components and have not yet been set up.

• Cancel changes, click Cancel.
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LCD Heading

In this field, enter what text will be shown in the panel’s top right corner. You can use the 
resource or department name that the panel is assigned to or a title that indicates the 
location of the LCD panel, such as Floor Number, First Floor Reception, or Blue Room or 
whatever works for your organization.

Booking Type

The Enable Anonymous Bookings checkbox sets the authentication method. All users can 
view room or meeting details. This controls who can add, edit or delete reservations.

Checked: Panel users are never asked for a username and password. They 
automatically have permission to add, edit and cancel reservations, even if Windows 
authentication is used.

Unchecked: Only users with the appropriate permissions are allowed to add, edit or 
cancel reservations.

Windows authentication: When logging into the LCD client, users provide 
their Windows username and password. When a user runs MRM for the first 
time, their Windows username is added to the Default user group in the MRM 
database. 

To enable this, in the MRM database:

• Add the term: 'LCDAuthentication' = 'Windows' to the database's options 
table.

• Run the SQL Query: INSERT INTO Options (Setting, Value) Values 
('LCDAuthentication', 'Windows') to add the above entry into the database.

Forms authentication: If this, also called MRM authentication, is used when 
logging into the LCD client users provide their MRM name and password.
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Reservation List Option

This drop-down list controls how many rooms are simultaneously displayed in the panel’s 
Schedule View screen. You can display one room to a maximum of four. However, you can 
add as many rooms as needed, the user scrolling through the list with the panel’s up or 
down buttons.

Busy Background Color

When this option is checked, and the room is occupied, the reservation’s listing changes 
its background color to show a meeting is in progress. This can only be used when a single 
room is displayed by selecting a 1 room option from the Reservation List Option section 
above it.

The default color is red. Change it by clicking on the color and selecting a new one.

Meeting Logo Field

This drop-down list points to where the logo images are stored on the network (See 
“Displaying logos on the panel” on page 263). It is mapped to the picture field created in 
the Reservation form.
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Displaying logos on the panel

You can display your logo or a visitor’s logo in a current meeting’s summary field as shown 
below. It can only be shown when the panel is configured to display one room.

Setting up the panel to display a logo is a two step process:

• Step One: Creating a picture field on the MRM Reservation form.

• Step Two: In the Schedule tab, set the panel to display a logo and choose the logo 
field which will be displayed as a logo. 
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Step One: Creating a picture field in the Reservation form

• Use form designer to create a picture field on the Reservation form. Name it 
whatever works for your organization, such as company logo, visitor 1 logo, etc. This 
becomes the link users select to add a logo to a meeting field

A logo can only be added in MRM Web.

Step Two: Setting the panel to display a logo

1. Select Admin>Advanced Administration>LCD Panel Displays.

2. Click the Schedule tab.

3. In the Reservation List Option drop-down list, select either:

• 1 room with Current Meeting Logo and Details.

• 1 room with Current Meeting Logo.
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4. In the Meeting Logo Field drop-down list, from the list of picture fields, select the 
logo field to display. See “Meeting Logo Field” on page 272.

The default setting is none.

5. Click Apply.

After setup, show users how they can add logos to information fields in the meeting 
display. Tell them that meetings displaying a logo have be created in MRM Web.

Configuring the automatic cancellation feature

MRM can automatically delete unused bookings if the organizer has not checked into the 
room at a preset time interval after the meeting’s start time. This prevents resources from 
being reserved and unavailable to other users if hosts have changed plans without 
cancelling the meeting. 

The panel’s Reservation Detail form can have a “Check-In” button added. When touched, 
the automatic cancellation function is stopped for that booking.

Hosts have a time window before the meeting that they can check in. If the meeting start 
time has passed, and they have not checked in, you can set how much time elapses 
before the reservation is automatically cancelled and anyone else can book that resource. 

The default setting is disabled. These settings must be configured for every room; it 
cannot be done globally.
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To configure the Check-In button’s settings:

1. In the Resource Details form, on the Check-In time field, enter zero or greater. 

If this field does not exist, use Form Designer to add it.

This sets the time in minutes before a meeting, including set up time, that the meeting 
host can check-in. They cannot check-in earlier than this.

To disable the cancellation feature, leave this field blank.

2. Select Start>All Programs>Meeting Room Manger 7.7>MRM Service Admin. 

The Service Admin screen appears.

3. Click the Triggers tab. 

The list of triggers appears.

4. Double-click on Delete Not Checked-In Meetings.

The frmTriggerDetail dialog box appears.



MRM 7  |  Admin Guide

                                  277

5. In the Status section, click Active.

In the Trigger Statement field, in the exec Delete Not Checked-In 
Meetings@minutepassed=10 trigger, the 10 sets how long in minutes after the 
meeting’s start time when the booking is automatically cancelled. Ten minutes is the 
default setting and it can be set to 0 or higher.

6. Change the automatic delete time as needed.

7. Fill in the other fields as needed.

8. Click Save Trigger.

Tell meeting organizers and hosts about this feature and how it works so they do not 
have their bookings accidentally cancelled.
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CHAPTER 15 SunGard Banner Data Import

SunGard Banner Data Import Overview

Meeting Room Manager is equipped with the ability to import data from SunGard Banner 
Unified Digital Campus, the world’s most widely used collegiate administrative software.

Course scheduling information can be imported from Sungard Banner directly into your 
Meeting Room Manager database as uneditable data. The SunGard Banner system 
remains the system of record for course schedules while the import into the MRM system 
allows faculty and staff to reserve classrooms around daily course schedules.

The import of course data from SunGard Banner is typically performed once per semester, 
but may be performed more frequently to reflect last-minute changes to the course 
schedule.

Workflow

1. In the Resource form, create a new text field the end user will use to map the MRM 
resource to the Banner classroom 

2. Run the utility which prepares the MRM database for the import. 

3. Map the MRM resources to the SunGard Banner resources, choose the import settings, 
and run the import.
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Conflict Handling

When the import is run, any existing MRM reservations which conflict with the courses 
imported from SunGard Banner are moved to the wait list and the meeting organizers are 
notified. This maintains the priority of courses over other events.

When an SunGard Banner event which is already in the MRM database from a previous 
import conflicts with a new SunGard Banner event, the old event is overwritten, 
maintaining Sungard data integrity in MRM.

A log is created during the import which lists the conflicts and the action taken to resolve 
them.

Display

Meeting Room Manager can be set to display data in the reservation grid at various time 
increments. SunGard Banner events are displayed on the reservation grid in blocks that 
most closely match the current MRM time increment, while the actual start and end times 
shown on the reservation block are displayed exactly as defined in SunGard Banner.

The MRM reservation grid displays reservations in the colors which correspond with their 
reservation types. Likewise, SunGard Banner events can be assigned a unique color to 
distinguish them from MRM reservations.

Data Integrity Protection

If any errors occur while importing the data from SunGard Banner, the import is aborted 
and the MRM database is returned to its previous state. Errors are recorded in the error log 
for reference.

Creating a New Field

1. On the Resource form, create a new text field for the General tab with Form 
Designer. 

2. Name this field Banner_MapID. 

3. Using the translation feature, give this field a name useful to the end users such as 
“Assign Course to Classroom” or “Book Room for Course.”
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4. Write instructions for the end users on how to correctly fill in this field so that the MRM 
resource listings are properly mapped to Banner Classroom.

Import Process

The individual who imports SunGard Banner data must be a database administrator with 
experience making database changes and running scripts.

 Before importing, we strongly recommend you create a backup copy of your MRM 

database. There is no undo operation for the importing process.

The two scripts you run during the import process are located in your MRM installation 
folder. By default, this file path is:

C:\Program Files\Meeting Room Manager\setup\MRMImportFromSCTBanner\Scripts

To import SunGard Banner data into your MRM database:

1. Open your importing environment. This is the application you wish to use to run the 
import scripts against your MRM database.

2. Run the script file “CreateTableAndView.sql” against your MRM database.

The script creates four tables in your MRM database. These tables act as a holding tank 
for SCT Banner data during the mapping process.

3. Import your SunGard Banner data into the four tables created by the script you ran in 
step two. These tables are:

RC_schedule_offering

RC_MEETING_TIME

RC_CourseImportParams

RC_classroom_xwalk
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4. Now that your SunGard Banner data is held in your MRM database, map your SCT 
Banner room IDs to your MRM room IDs.

Sungard Banner room IDs are now held in the RC_classroom_xwalk table. The 
MRM_Code column in this table is equivelant to the Room_ID column which already 
exists in the MRM database.

Use the following query to find an MRM resource’s room ID:

Select Room_id, [Meeting Room], Location_ID from rooms order by [Meeting Room]

5. Once the SunGard Banner and MRM rooms are mapped to one another, you may 
configure the parameters in the import script.

Open the ImportScripts.sql file and modify settings as required. Details are provided 
below:

Preview or Import:

Here you may choose to preview your import or perform the import when you run 
this script.

--Y: Preview all imported data but not import yet; 

--N: Not preview all imported data but import all data to Reservation table with log 
information

Set @IsPreviewImportData = 'N';

Error Log:

Here you may set the file path and name for the error log.

--@Error Log file path and name

Set @LogFilePath ='C:\"Program Files"\"Meeting Room Manager 
7"\setup\MRMImportFromSCTBanner\Log\';

--Log file name 

Set @ErrrorLogFileName ='BannerErrorFile';

Set @LogFileName ='BannerLogFile';
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Cell & Font Color:

Here you may set the chosen cell and font color to represent imported SCT Banner 
events. 

-- Cell color FontColor 

Set @CellColor_ID =0;

Set @FontColor_ID =0;

Created and Modified User:

Here you may choose which user will be listed as the user who created and modified 
SunGard Banner events. By default, this value is 1 for Administrator.

-- Created User and Modified User

Set @CreatedUser =1;

Set @ModifiedUser =1;

6. Once the import script parameters are adjusted as desired, run the script in preview 
mode against your MRM database.

7. Once you are satisfied with your import preview, run the script in import mode 
against your MRM database.

Your SunGard Banner events are now displayed in the reservation grid as you have 
specified. View the error log to see which, if any, reservations were moved to the wait 
list to give preference to SunGard Banner events.
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CHAPTER 16 Find

Find reservations

The Find Reservations Search form is designed to allow users to quickly and easily find a
specific reservation or set of recurring reservations based on specific criterion. The fields
displayed for users to search by can be customized using the Form Designer.

To perform a search for a reservation or a set of recurring reservations:

1. Click the Meetings icon.

2. The Find Reservation Search form opens.

3. Enter your criterion into each respective search field.

• Wildcards such as % and ? can be used on their own in the search fields. 

• In Date fields, you can search for values after or before a certain date by placing < or 
> before the date (i.e.: >DD/MM/YY).

• The pop-up calendar can also be used for date fields by clicking on the calendar 
icon to the right of the field.

• In Number fields, you can search for values greater than or less than a certain 
number by placing < or > before the number (i.e.: >4).

• Click on a pull-down menu to the right of a field to select from default values.

• The Meeting Start and Meeting End fields do not operate as a range naturally. To 
search based on a date range, use the greater than or less than signs along with 
dates in the Meeting Start and Meeting End fields.
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For example, to search for reservations starting December 1st, 2006 or later, enter 
>12/1/2006 into the Start Time field. 

Note that he manner by which the date is entered varies depending upon your 
browser settings. In the US, MM/DD/YYYY is commonly used, while in Canada, DD/
MM/YYYY is commonly used.

4. Click Find to list all matching reservations.

Find rooms and resources

The Find Resources Search form is designed to allow users to quickly and easily find a
particular room or group of rooms based on specific criterion. The fields displayed for
users to search by can be customized using the Form Designer.

To find a meeting room or resource based on your criterion:

1. Click the Resources icon.

2. The Find Resources Search form opens.

3. Enter your criterion into each respective search field.

• Wildcards such as % and ? can be used on their own in the search fields. 

• In Number fields, you can search for values greater than or less than a certain 
number by placing < or > before the number (i.e.: >4).

• Click on a pull-down menu to the right of a field to select from default values.

• The Meeting Start and Meeting End fields do not operate as a range.

4. Click Find to list all matching rooms and resources.
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CHAPTER 17 Filters

Filters overview

Filters allow users to view only the specific information they want to see in the reservation
grid. Users without permissions to manage filters can apply existing filters or create their
own temporary filter called a Custom Filter.

Apply a location filter

When you select a location from the Available Locations Hierarchy, only the resources
assigned to the selected location are displayed in the grid. By default, each user views all
locations. This filter does not affect your My Location or time zone settings.

Apply a resource or reservation filter

Resource and reservation filters can be created by administrators with the Manage filter
permissions. Any user can utilize the filters for narrowing the information displayed in the
reservation grid.

The resource filters can also be used with the MRM plug-in for Microsoft Outlook. See
“Creating an MRM reservation in Outlook” on page 216 for details.

To apply an existing filter to the reservation grid:

1. Select Filters to the left of the main screen.
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2. Access the appropriate Filter pull-down by clicking its maximize arrow. Choose from 
the Resource Filter list or the Reservation Filter list.

3. Select the predefined filter you wish to apply.

4. Only the resources or reservations that match the selected filter’s criterion display in 
the reservation grid.

Adding a filter

Resource and reservation filters allow users to view only the specific information they
want to see in the reservation grid. They can be used by all users. 

The resource filters can also be used with the MRM plug-in for Microsoft Outlook. See
“Creating an MRM reservation in Outlook” on page 216 for details.

To add a new filter for all users to utilize:

1. Click the Admin icon.

2. Click the Filters icon.

3. In the filter list that opens, from the Filter Type field pull-down menu select the filter 
type that you wish to create: Resource Filter or Reservation Filter.

Your selection determines which of the two lists of existing filters is displayed.

4. Click Add.

5. The filter creating version of the appropriate search form opens.

• Enter your filter’s criterion into the available fields, then click the Find button.

• Wildcards such as % and ? can be used on their own in the search fields. 

• In Date fields, you can search for values after or before a certain date by placing < or 
> before the date (i.e.: >DD/MM/YY).

• The pop-up calendar can also be used for date fields by clicking on the calendar 
icon to the right of the field.

• In Number fields, you can search for values greater than or less than a certain 
number by placing < or > before the number (i.e.: >4).

• Click on a pull-down menu to the right of a field to select from default values.



MRM 7  |  Admin Guide

                                  289

6. Click Apply Filter.

7. The filter’s detail form opens. In the Filter Name field, enter the name you wish to use 
for this filter.

8. Click OK. Your new filter now displays in the list of filters.

Deleting a filter

To permanently delete an existing filter:

1. Click the Admin icon.

2. Click the Filters icon.

3. In the filter list that opens, from the Filter Type field pull-down menu select the filter 
type that you wish to create: Resource Filter or Reservation Filter.

Your selection determines which of the two lists of existing filters is displayed.

4. Check the box beside the filter you wish to delete.

5. Click Delete.

6. A confirmation prompt asks you to confirm that you wish to delete the filter. When 
you are ready, click Yes.

Applying a custom filter

The Custom filter allows users to perform a customized search for resources or
reservations and then temporarily apply the results of the search to the reservation grid.
Only the matching resources or reservations are displayed.

The intent of this filter is to limit the vast number of filters that could accumulate if all
users could save their specific filters, and to allow those users without Manage Filters
permissions to see their own customized view of the reservation grid.

To apply a custom filter:

1. Select Filters to the left of the main screen.
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2. From the Resource Filters or Reservation Filters pull-down menu, whichever best 
applies to the custom filter you are creating, select Custom Filter.

3. In the Search form that opens, enter your filter’s criterion.

4. Click Find.

5. When you are satisfied with the results, click Apply Filter.

6. The grid refreshes, now displaying only the data that qualifies based on the custom 
filter you just created.

7. The custom filter will remain intact until you select another filter or log out.
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CHAPTER 18 Reports

Generating a grid view report

MRM allows users to create a semi-customized report for the day, week, and month views
of the grid.

To generate a grid view report:

1. Click the Printer icon at the right of the main screen.

2. In the Report Options form, enter the heading and subheading for your report.

3. Select which report you wish to create, either daily, weekly, or monthly.

4. The Report Options form refreshes and displays the criterion fields for the report you 
have chosen. Enter the criterion for your report. 

5. When you are ready to generate the report, click the Print button.

6. The report prints to screen. To print to your printer, choose File > Print.

Generating a report

Once you generate a report, you can preview it, print it, export it, or send it by email
through your workstation’s MAPI compliant email program.

Permissions apply to reports. Just as in the MRM user interface, users can only see
data for locations which they have permissions to view. Reservation details are also
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limited by the location-specific View Others Meetings permission. For more details about
permissions, see “Security” on page 49.

To generate a report:

1. Click the Reports icon.

2. Select the report you with to generate from the list. Then click the Print/Preview 
button.

3. The parameters for the report you selected load. Enter your criterion, then click 
Display Report.

4. The report is generated and displays.

• To preview through the various pages of the generated report, click the forward and 
back arrows. The zoom can be adjusted by selecting a zoom percentage from the 
zoom pull-down menu.

• To print the generated report, click the printer icon. 

• To export the generated report, click the export icon.
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CHAPTER 19 Product Feedback

Provide Product Feedback

At NetSimplicity we take pride in our customer-centric approach to product
enhancement and development. As such, we place tremendous importance on the
feedback from our customers. The ideas behind many of the powerful features in Meeting
Room Manager as well as our other products have come directly from customers like you. 

Let us know how we can improve our products. If at any time you have a suggestion to
make the software better, please give us your feedback so that it can be considered for
future service packs and versions of Meeting Room Manager.

To provide your feedback:

1. Click on the Online Help icon on the main screen of the Meeting Room Manager 
interface.

2. Select Product Feedback from the Contents list.

3. Click the link provided.

The online feedback form opens allowing you to express your product enhancement 
suggestions. You have the option of filling in your information on the feedback form if 
you don’t mind having us potentially contact you for more information.

Thank you in advance for your input!
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